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Patron Services Administration Overview

This section contains the following topics:

o Setting Circulation Permissions

o Qverride Patron Services Permissions Blocks

» Setting Patron Services Parameters and Profiles

» Setting Circulation Policy and Database Tables

Setting Circulation Permissions

Before your staff can do patron registration, patron accounting, and circulation tasks in
the Polaris staff client or Leap, you must set specific permissions to do the tasks.
Circulation permissions define who can create, access, and work with patron records
and circulation functions. Each organization can specify which groups, workstations,
and staff members are allowed to work with records and control processes. For detailed
information about managing Polaris permissions, see the Polaris Administration PDF

Guide, Granting Permissions.

Note:

Certain System Administration permissions are required to assign
permissions. See the Polaris Administration PDF Guide, Permissions to

Set Permissions.

See also:

» Set circulation security

» QOverride patron services permissions blocks

e Circulation Permissions Reference

Set Circulation Security

To review and set circulation security:

© 2023 Innovative (Part of Clarivate)
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1. Inthe Administration Explorer tree view, select the Securityfolder for the organ-
ization for which you want to set circulation permissions. Certain permissions
related to holds, interlibrary loans, patron registration, and patron status (account-
ing) must be set for each branch that does these functions. Other permissions are
set at the system level.

The Security view is displayed in the details pane.

Tip:
To display all the circulation permissions, select (highlight) Circulationin
the Control Record list, and press ALT+*(on the numeric key pad).

2. Double-click Circulationin the Control Record list.

3. Double-click the record or function for which you want to assign permissions. The
permissions list for the selected object appears.

4. Select the permission you want to assign. The staff members, workstations, and
groups that have the permission for the organization are listed under Individuals
With Permission.

Note:
For a list of the permissions that are required to do specific circulation
and patron services tasks, see

5. Add the resources (groups, workstations, staff members) that need the selected
permission by doing the following steps:

a. Click Assign, and select the resource type. The Polaris Find Tool appears.

b. Use the Find Tool to search for and select one or more resources. The Admin-
istration Explorer is displayed. The selected resources are displayed in the
Individuals With Permission list.

6. Repeat steps 3-5 as needed.

7. Select File > Save to save your changes.
Note:
To apply your permission changes to the staff client, exit the staff client
and log back in.
See also:

+ Setting Up Course Reserves

e Circulation Permissions Reference
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Override Patron Services Permissions Blocks

When a staff member does not have the appropriate permission to do a patron
services/circulation task, a permission block message appears. You can allow certain
staff members or supervisors to override the permission block so that the staff member
without permission can continue the blocked task.

Set the Patron Services profile Override patron services blocks to Yesat the staff
member level for the staff member who should be able to override permission blocks.
For more information about how to set profiles, see Setting Patron Services Parameters

and Profiles.

Setting Patron Services Parameters and Profiles

Patron Services parameters and profiles control both patron services and circulation
functions. The sets of available parameters and profiles are different for each
administration level (system, library, and branch). Separate sets of parameters control
requests, notification, self-check operations, and credit card transaction processing.

You can view and set the Patron Services parameters and profiles from the
Administration Explorer or an administration workform.

Note:

These System Administration permissions are required to modify
parameters and profiles: Access Administration: Allow; Libraries:
Access; Branches: Access; Modify parameters: Allow; Modify profiles:
Allow.

See also: Review and Set Patron Services Parameters and Profiles

Review and Set Patron Services Parameters and Profiles
To review and set Patron Services parameters and profiles:

1. In the Administration Explorer tree view, expand the organization for which you
want to set parameters.

2. Select Parameters or Profiles in the list under the expanded folder. The Para-
meters or Profiles tabs are displayed in the details view.

3. Select the Patron Services tab. The list of Patron Services parameters appears.

© 2023 Innovative (Part of Clarivate)
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File Edit Help
D~ - 2
Admlmstratlon Explorer - System Eparameters
Administration Explorgr - System Acquisitions / Serials Patron Services cataloging PAC  Notification SelfCheck Unit Request Credit Card Payment NCIP
= % System: QA-Polaris
T4 Profiles
¥ Permissions
Security Parameter Value
+ [£7] Policy Tables [ Account transaction deletion Setup ...
G4 Database Tables [ Accrued fine options Setup...
i :; .;;r:::t'ﬁca“on Tables ™ Address verification Setup ...
+1' Library [ Associated patron options Setup...
+ Branch Check—in: auto-charge fine from item work form and... Yes
E.E Collection [ Check-in: Listview options Setup ...
38 Workstation &4 Check-in: Prompt for in-transit in bulk mode No
%g i;a:;:lember & Check-in: Prompt for in-transit in normal mode No
[ Check-in: Receipt options Setup ...
[ Check-out: Charge options Setup ...
[ Check-out: Listview options Setup ...
™ Check-out: Optional patron data Setup ...
[™Check-out: Receipt options Setup ...
Check—ou‘[: Require format selection when checking .. No
@%Check—out warn if item is from another branch No
Check—ou‘[: warn to send item in-transit Yes
ﬁ(laims: MNumber patron can have at one time 5
ﬁ[laims: Total number allowed 999
[™collection agency options Setup ...
[ Consortium circulation Setup ...
[ Course reserve options Setup ...
< N Credit for overpayment No

4. Use the scroll bar to review all the parameters or profiles in the list.

5. Double-click the parameter or profile you want to set. The parameter or profile
value is highlighted, ready for editing, or a dialog box appears.

Tip:

To get a setting from the next higher organizational level, right-click the
parameter or profile and select Inherit higher level values. To give a
setting to multiple lower organizations, right-click the parameter or profile
and select Transmit values to lower levels. Not all settings can be
inherited or transmitted.

6. Set the parameter or profile as follows:
e Type text.
» Use arrows to select an option.
 In adialog box, enter the information and click OK.
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7. Select File > Save to save any changes.

Note:
To see the effects of your parameter and profile changes in the staff
client, exit the staff client and log back in.

Setting Public Access Profiles and Parameters

Public access parameters and profiles control general aspects of public access, and
specific functions related to Polaris PowerPAC, Polaris PowerPAC Children’s Edition,
and Polaris Mobile PAC. You can make most settings at the system, library, or branch
level. You can view and set public access profiles and parameters from the
Administration Explorer or an administration workform.

Note:

These System Administration permissions are required to modify profiles
and parameters: Access Administration: Allow, Libraries: Access,
Branches: Access, Modify parameters: Allow, Modify profiles: Allow,
System: Access, System: Modify.

Your library may use multiple Polaris public access applications:

» Polaris® PowerPAC™ provides responsive Web-based access to library searches
and services from remote computers, tablets, and smartphones, and from devices
in the library.

» Polaris® PowerPAC™ Children’s Edition is the Web-based application designed
specifically for children’s use.

» Polaris Mobile PAC is the Web-based PAC application designed for mobile
devices.

Note:

The Statistical Summary report provides detailed information about
system activity, including PAC activity such as patron logins, patron self-
registration, holds placed from PAC, and holds cancelled from PAC. To
access this report, select Utilities, Reports and Notices from the Polaris
Shortcut bar, and select System in the Polaris Reports dialog box.

See also:

© 2023 Innovative (Part of Clarivate)
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» The PAC Customization PDF Guide, PAC Administration Profiles Reference topic.

Setting Circulation Policy and Database Tables

Many circulation workflows are affected by policy and database table settings. Some
tables define the options available for specific fields in item and patron records, while
others identify values used in circulation transactions, such as due date calculation and
overdue fine calculation. The tables are typically set up during implementation, data
conversion, or Polaris site installation. Many can be edited as your needs change. You
can edit some tables at the branch level. Other settings must be shared by all
organizations.

Note:

Specific System Administration permissions are required to work with
circulation policy, database, and notification tables. For more information,
see the Polaris Administration PDF Guide, Grant Administration
Permissions.

For general information about tables in Polaris, see the Polaris Administration PDF
Guide, Working with Tables.

© 2023 Innovative (Part of Clarivate)
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Defining Patron Account Features

Patron records store patron registration and account information. In Polaris
Administration, you set up default values for patron records in the Polaris staff client,
Leap and the PAC; criteria for detecting duplicate records; and criteria for deleting them.
Additional settings affect patron accounting operations such as paying and waiving
charges.

Note:

For information about setting up e-commerce (credit card processing) in
the staff client, PAC, and Polaris ExpressCheck, see Setting Up E-
Commerce.

See also:

» Defining Patron Codes

o Setting Up User-Defined Fields

o Setting Up Patron Custom Data Fields

e Setting Patron Registration Required Fields and Defaults
o Setting Express Registration Defaults and Requirements

e Charging for Patron Registration

o Setting Patron Duplicate Detection

e Setting Reading History Options

o Setting Up Patron Messages
» Setting Up Patron Photos
e Setting Options for Deleting Patron Records

» Setting Patron Accounting Options
o Setting Payment Method Options

e Date Sources in Patron Records

e Removing Patron ID Information from Transaction Files
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Defining Patron Codes

Patron codes define available services, loan periods, fines, and limits for specific
classes of patrons. They are also used for reports. An appropriate patron code is
typically assigned to the patron when the patron registers.

You define patron codes in the Patron Codes policy table, which can be opened from an
organization workform or with the Administration Explorer. All organizations have
access to the same set of patron code names because the codes can be entered and
changed from the system, library, and branch levels. Changes are immediately applied
to all Polaris records that use the code, regardless of which organization owns the
records.

Patron codes are available as selections in the Fines policy table, Loan Periods policy
table, and the Patron code box on the Patron Registration workform. Each organization
can filter the list of codes so that only selected codes are available for use in the Patron
code box on the Patron Registration workform for that organization’s patron records.
The illustration shows the Patron Registration workform.

Note:

These System Administration permissions are required to modify the
Patron Codes policy table: Access administration: Allow; Access tables:
Allow; Modify patron codes table: Allow.

See also:

« Filter Patron Codes for Specific Organizations

Managing Hold Requests

Use the Request parameter, Hold options, to specify how your library organization
manages holds. In the Administration Explorer tree view, open the Parameters folder for
the System, and click the Request tab in the details view. Then, double-click Holds
options to open the Hold Options dialog box.

See also:

Set Holds options: Charge for hold requests

Set Holds options: Expiration and Unclaim limits, Deletion options

Set Holds options: Enabling, Item Status Restrictions, First Available Copy

Set Holds options: Exclude pickup branches

© 2023 Innovative (Part of Clarivate)
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Set Holds options: Enable patrons to change the holds pickup branch from the
PAC

Set Holds options: Preferred borrowers branches
Set Holds options: Alerts and blocks
Set Holds options: Trapping preferences, queue settings

To allow renewals when an item is out to a patron but there are hold requests with
certain statuses, the renewal is blocked by default. You can change the setting to allow
renewals of these items as long as the item is not the only one available to fill the
request. See Allow renewals for items with hold requests.

To prevent holds from being placed on a specific item, see Restrict holds on specific
items.

To allow patrons to place multiple holds at once from Polaris PowerPAC working or
saved title lists, see the Public Access Administration PDF Guide, Bulk Hold Requests
from Polaris PowerPAC Title Lists.

Filter Patron Codes for Specific Organizations

The patron codes available for use in a patron record are based on the settings for the
patron’s registered branch.

To filter patron codes for use by specific organizations:
1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.
2. Double-click Patron registration: Filter patron codes.
The Patron registration: Filter patron codes dialog box opens. The list of patron
codes are those defined in the Patron Codes policy table. For more information,

see Add a Patron Code. When a new code is added to that table, it is added to the
Filter dialog box and is selected for use by default.

© 2023 Innovative (Part of Clarivate)
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Patron registration: Filter patron codes

Current organization: Community Library (br)
Seftings defined at: g, QA-POLARIS 6.0 (sys)

Select patron codes to display on the patron registration form:

CPH Outreach

CPH Resident

CPH Retired

CPH Staff / Board
Delinguent Borrawer
ILL Agency

Juvenile

Mew Borrower
[ Qutreach

Juvenile with Restrictions

~

Select All

Unselect All

'

Save

Cancel

Note:

The organization icons at the top of the dialog box indicate
whether the settings have been inherited. Initially they are
inherited from the system-level settings. Once you change
settings at the branch level, they are no longer inherited from
the system, even if the system settings are changed.

3. Check or uncheck the codes until the checked items reflect those you want to
offer as patron code choices for this organization.

4. Click Save. If you have unchecked patron codes, they are removed from the list of
patron codes available on workforms for this organization. If an unchecked code
is in use, a message informs you of the number of patron records that use the
code at this organization and any descendant organizations. You can continue to
save or cancel the operation.

Setting Up User-Defined Fields

Your patron records can include up to five user-defined fields (UDFs). All five are
searchable with the Polaris Find Tool. UDFs can be used for additional identification
purposes and as criteria for detecting duplicate patron records.

Note:

Your library may allow users to log on to PAC using network credentials

© 2023 Innovative (Part of Clarivate)
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instead of the Polaris patron barcode or username and password. If so, a
UDF should be defined for the patron’s network username. For details, see
the Public Access Administration PDF Guide, Set Up PAC Active Directory
Log On.

The UDFs are set up when Polaris is implemented. At the system level, you can define
UDFs as free-text fields where staff members type text, or as drop-menu options. If you
define UDFs as drop-menu options, they appear in drop-menu list boxes everywhere
UDFs can be selected.

H Patron Registration - 357715 - General - Polaris - | o[

File Edit View Links Tools Help

= Barcode: | A12291954 | Registered at: |C0mmunity' Library {COB) v |
s Last name: | [zquierda | Patron code: |Reh’red v|
E First name: | Laura | Instructor
't'r)" Middle name: | | Expiration:
e Term: |0 -3 v| Date: [11/15/2022 El~
> e — o = | |
L
Q: General
e Cendar |Female hd | User defined fields
=t Statistical dass: |C0bleskiII-T0wn v | ID Number
l:l Password: | sene | | P |
E Language: |English v| Privileges [ Restrictions
Former barcode: [ 131335456456 |
gl 4 v]
Birth date: | 12/ 1/1955 E~ |
y Voter Registration
Date of original registration: | 11/15/2018 E~- | | Yes |
Last activity date: [ 6262019 4:04:24PM |
CybraryN Use Only (000(YYY)
Exdude from notices and reminders:
[]Exdude from collection agency |CPH W |
[Joverdue [ ] Almost overduefautorenew
Maintain reading history Not Currently in Use
[]Hold ["]Patron record expiration
["] E-mail notices in plain text | 4 |
[siling [ tnactive patron [] Do not delete patron record

For Help, press F1

Drop-menu option text can be edited, and the options can be deleted provided they are
not used in any patron records. Individual branches can specify which drop-menu UDF
options to display: determine the order of display; and designate default values to be
used during patron registration, express registration, and online registration from the
PAC.

© 2023 Innovative (Part of Clarivate)
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Note:
If you plan to use collection agency services, you may need a UDF to
identify the guardian of a minor patron.

See also:

e Scanning a Driver's License for Patron Registration

¢ View and Convert User-Defined Fields for Patron Records

o Set Drop-Menu User-Defined Fields for Organizations

» Setting Up Free Text User-Defined Fields for Use as Alternate IDs

Scanning a Driver’s License for Patron Registration

California libraries can enter information for a new patron in the patron record by
scanning the 2D (two dimensional) barcode on a California driver’s license or ID.

Normal barcode scanners will not read data from a driver’s license. The license data is
stored in a 2D format using PDF417 barcode symbology. Polaris has tested and
recommends the Datalogic Gryphon GD4430 USB scanner. However, most 2D PDF417
USB wedge-type scanners should work.

Note:
This “Driver’s License Scan Facility” feature is separately licensed in
Polaris.

A free-text Polaris user-defined field must be designated for the driver’s license number.
By default, Polaris uses UDF 1. If your library uses a different UDF for the driver’s license,
contact your Polaris Site Manager to change the UDF.

Note:

The designated user-defined field must be a free text field. If it is changed
to a drop-menu field in Polaris Administration, the registration data is
entered appropriately when the driver’s license barcode is scanned, but
the ID number is not entered in the user-defined field on the patron record.

When the driver’s license is scanned during patron registration, the following driver’'s
license information is entered in the appropriate patron record fields:

« Name (Last, First Middle)
« Street address (up to two lines)
o City

© 2023 Innovative (Part of Clarivate)
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State
Postal code

Note:
The address information is entered in the Home address fields in the
Patron Registration workform.

Birth date
License number (entered in the designated user-defined field)

For registration instructions using this method, see the Patron Services PDF Guide, Scan
driver’s license to enter patron information.

Technical Notes

» Before the Gryphon scanner is first used, it must be programmed to add a suffix of
$ to the driver’s license barcode.

» To avoid problems with patron name and address formatting, you must configure
the scanner to run in a mode that returns the line feed character, which indicates
the end of each field in the driver's license. For the Gryphon 44XX scanner, the cor-
rect mode is USB Alternate Keyboard. The image for reconfiguring the Gryphon
44XX scanner is included in the scanner user guide.

» The code requires the file DriversLicenseParser.js. When the Polaris staff client is
installed, the folder ProgramData\Polaris\[version]\Scripts is created. The file
DriversLicenseParser.js must be placed in the Scripts folder.

Contact your Polaris Site Manager for technical assistance.

View and Convert User-Defined Fields for Patron Records

To view the user-defined fields (UDFs) that have been set up for your Polaris system, set
up the options for drop-menu UDFs, and convert UDFs from one type to the other:

Note:

Initial values in drop-menu UDFs are derived from your existing data. You
can edit them and add more values if necessary. See the following
procedure. When existing text UDFs are converted to drop lists, the
options will be available only at branches that have used the
corresponding text value.

© 2023 Innovative (Part of Clarivate)
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1. Inthe Administration Explorer tree view, expand the System folder.
2. Select Profiles, and select the Patron Services tab.

3. Double-click Patron registration user defined fields. The User Defined Field
Options dialog box opens.

55 Ly Defined Field (ptions =)
Jner Diefwed Field | D burriar
Findd Typa
B Fress teat
Dirogrmen
<+
A
Y
QK ricad Appdy Hap

The User Defined Fielddrop-down list contains the UDFs that were set up at
implementation. You can select a UDF to determine if it is defined as free-text or
drop-menu on the Patron Registration workform and other appropriate system
workforms. Drop-menu UDFs display the possible options defined for them.
(Individual branches can select options for use and set the display order. See Set
drop-menu user-defined fields for organizations.)
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&2 Liver Defined Field Option: =W|ECI i
we Clefined Fisldh | Cobrmephd Lnm Sy (00001

Frald Trpa:
Fres et

& [Crogrmers

+ &

A

0K Caneed ALy Hedp:

. To convert a free-text UDF to a drop-menu UDF, follow these steps:

. Select the free-text UDF in the User Defined Field list.

. Select Drop-menu. All the free-text values currently entered in patron records for
this UDF are listed as drop-menu options; by default, all are selected as eligible for
use by individual organizations.

Note:

If you are converting a free-text UDF with more than 500 unique entries, a
message offers you the opportunity to continue or cancel the conversion.
Large numbers of values may take some time to convert.

. Click OK. (You must click OKbefore you modify any of the drop-menu options.)

Note:

You can also convert a drop-menu UDF to free text. In this case, all patron
records using the options for the drop-menu UDF retain the option text as
free-text in the appropriate UDF field.

. To add an option for a drop-menu UDF, follow these steps:

. Select the drop-menu UDF in the User Defined Field list.
. Scroll the list of options to the bottom (blank) entry in the list.
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Double-click the blank field and type the new option in the space. You can type up
to 64 alpha-numeric characters (letters and numbers).

Note:

A drop-menu option cannot be blank except in new records where an
option has not yet been chosen or when it is cleared in bulk change. To
indicate that no value is selected, set up an option with the text None.

Click Apply.
To edit a drop-menu UDF option, follow these steps:

Select the drop-menu UDF in the User Defined Field list.
Double-click the option and type the new text over the old.

Click Apply. All patron records and defaults using the old option will be updated
with the option’s new text.

Note:

You can also delete a drop-menu option as long as it is not currently being
used in a patron record or as an organizational default setting for the UDF.
Simply uncheck the option’s Selected checkbox.

Click OK to save your changes and close the dialog box.

Important:

If you make any UDF changes, you must log out and log back in to the
Polaris staff client to see the effects of your changes in Polaris
workforms.
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Related Information

» Organizational drop-menu UDF options - See Set drop-menu user-defined fields for

organizations.

» Organizational default values for UDFs - See Set patron record required fields and

default values .

» Minor patrons and collection agency services - Collection agency processing may

require a UDF that identifies the guardian of a minor patron. See Reporting Minors.

Set Drop-Menu User-Defined Fields for Organizations

After the drop-menu user-defined fields have been set up at the system level, you can
set which options will appear in each organization’s UDF drop menus and the order in

which they should appear.

1. To select drop-menu options for an organization:

2. Inthe Administration Explorer tree view, expand the organization’s folder.

3. Select Profiles for the organization, and select the Patron Services tab.

4. Double-click Patron registration user defined fields. The User Defined Field
Options dialog box opens.

5. Select the drop-menu UDF in the User Defined Field list. The drop-menu’s options
are listed.

6. Select or de-select the checkboxes to choose the options you want to appear in

7.

the organization'’s version of the UDF drop menu.

Note:

For new UDFs, if an option is selected and saved at the system level, it is
selected at all branches. If it is saved as unselected at the system level, it
is unselected for all branches.

Tip:
First move the de-selected options to the bottom of the list. This may
make it easier to move the selected options to the order you want.

To change the order in which the options will appear in the organization’s UDF

drop menu, highlight an option and select the up arrow 4 || or down arrow || ¥

to move the option up or down in the list. To move an option to the top, click A,
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1€

To move an option to the bottom, click
8. Click OK.

Important:

When you make UDF changes, you must log out and log back in to the
Polaris staff client to see the effects of your changes in Polaris
workforms.

Related Information

» System-level drop-menu UDF options - See View and convert user-defined fields
for patron records.

» Organizational default values for UDFs - See Setting Patron Registration Required
Fields and Defaults.

Setting Up Free Text User-Defined Fields for Use as Alternate IDs

Use these steps to configure free text UDF fields in the patron record to be used as an
alternate ID to check out items.

To configure a free text user-defined field for use as an alternate ID:

1. In the Administration Explorer tree view, expand the System folder, select
Profiles, and then select the Patron Services tab.

© 2023 Innovative (Part of Clarivate)
Page 18



Patron Services Administration Guide

2. Select Setup next to Patron registration user defined fields.

Administration Explorer - System - QA-POLARIS 6.2 - Polaris — O X
File Edit Help

D-2-Hx &

Admimstrat\on Explorer - Sy i‘ProﬁIes

Administration Explorer - 5 Children's PAC Staff Client Mobile PAC Community
E% 'S‘ystemr QA-Polaris Acquisitions / Serials Patron Services Cataloging PAC PowerPAC
& Parameters
J Profiles
romssens | ot Value
G DM Contribute to L books most borrowed [ Ves - Via Web Senvice |
Database Tables Default directory C:\ProgramData\Polaris\6.2\
4 Notification Tables % Display photo ID Yes
g[f[g Eirr:}r, % Due date modification: Reason requi No
EEI---Q Branch % Patron can enable/disable reading history Yes
g Collection [%3 Patron custom data: Definition Setup . ...
@ Workstation [=3 Patron custom data: Filter Setup ...
78 Staff Member [=3 Patron initiated circulation: Blocking conditio... Setup ...
g Patron % Patron initiated circulation: Transaction branch Patron’s branch
[=3 Patron registration user defined fields

3. In the User Defined Field Options dialog box, select the checkbox Use as alternate
ID for checkout to indicate that the free text field can be used as an alternate ID to
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check out patron items.

I} User Defined Field Options — O X
User Defined Field: |ID Number v |
Field Type:

(®) Free text Use as alternate ID for checkout

[ ] Only when no barcode match found %

() Drop-menu
Option Selected
.t
+
A
v
OK | ‘ Cancel ‘ ‘ Apply ‘ ‘ Help
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4. Select Apply to save the changes.

& User Defined Field Options — O X
User Defined Field: 1D Number v
Field Type:

(®) Free text Use as altemate ID for checkout

[ ] Only when no barcode match found b

() Drop-menu
Option Selected
.t
+
A
Y

| o | cancel ‘ Help

5. (Optional) Select the Only when no barcode match found checkbox if you want the
patron search to happen only if no matching barcode is found. This checkbox is
only enabled when the Use as alternate ID for checkout checkbox is checked.

Note:

If the Drop-menu option is selected: the field's content will not be
affected; the checkboxes will be disabled; and the free text field will be
converted to a drop-menu field and cannot be used as an alternate ID.
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Setting Up Patron Custom Data Fields

You can define up to 10 patron custom data fields in addition to the 5 user defined fields
(UDFs). In Polaris Administration, Patron Custom Data Fields (PCDFs) are defined at the
System organization level; filtered at the library or branch level; and configured at the
branch level to specify required fields or default values for the Patron Registration
workform in the staff client and the PAC self-registration and Update Info pages.

To define the PCDFs for the library system, enter a unique label and define fields. See
Define Patron Custom Data Fields (PCDFs). Once these PCDFs have been defined at the
System level, you can filter the PCDFs at the branch level so that only the PCDFs your
branch wants to use are listed. When a PCDF is selected for the branch organization, it
will be available to configure for the Patron Registration workform in the staff client and
for the Self Registration page in the PAC (PowerPAC and Mobile PAC). See Filter patron
codes for specific organizations.

When configuring the display of PCDFs for the staff client Patron Registration workform,
you can set default values for custom fields or specify that custom fields are required.
See Setting Patron Registration Required Fields and Defaults.

A patron custom data field may be modified or deleted at the System level in Polaris
Administration, provided the field is not used in any patron record. See Modify or delete
a PCDF.

Note:

For information on configuring PCDFs for PAC registration and
contact/preferences update forms, see the Public Access Administration
Guide, Setting Patron Access Options.

Define Patron Custom Data Fields (PCDFs)

Your library system can define up to 10 PCDFs at the System level in Polaris
Administration. After the PCDFs are defined at the system level, the library or branch
organization can select which custom fields display in the Patron Registration workform
in the staff client and the Self Registration page in PowerPAC and Mobile PAC.

Important:

When you add and save a new PCDF, the PCDF is not available for Find
Tool searches until the ERMS daemon is recycled. See your system
administrator.
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To define PCDFs for the library system:
1. Inthe Administration Explorer tree view, open the Profiles folder at the system
level, and select the Patron Services tabbed page in the details view.
2. Double-click Patron custom data: Definition. The Patron custom data: Definition
dialog box opens.

Patron Custom Data: Definition n
Laiba Typa
Licerse iz Tiiteger
FarantiGuardian String
FaranyGuardian tirth date Oate Time
Ragtricted paino B lean

Tast Custom Cata 1 Strirg (KW
Tast Custom Caka Data Tima
Tast Cusiom Oata 345 Lritiripar
Tast Custom Caka 4 Strirey (KW
Tast Cusham Caka 5° Strirg

Dats Feld Detinition

Labed: | Wow Patron Custorn Data Field

Type:  (8)Siring Intager Boolaan (| Dta Tima
[ keymned Index
A Mess Field
Cancel Hedp

3. Enter a unique alpha-numeric label in the Label field. Each custom data field must
have a label that cannot be the same as a label already in use for a custom field or
a user-defined field.

Important:
If the custom data field is used in any record, the type cannot be changed,

but the label text can be modified.

4. Select one of the following field types:

« String - A string type consisting of alpha-numeric and special characters, with a
255-character limit. If String is selected, you can select the Keyword
Index checkbox if you want to include the custom data field in keyword indexing.
This checkbox is enabled only when the String field type is enabled.

Note:
Selecting the keyword option could adversely affect searching and
especially the search suggestion feature. For example, if the library uses
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this field for numeric or alphanumeric data, this data can populate a
search suggestion with unhelpful data.

Integer - Consists of numbers only, with a 255 character limit.
Boolean - Consists of options to select Yes or No.
Date/ Time - Consists of the date and time.

. Click Add New Field to create a new patron custom data field.

Note:

The Add New Field button is enabled when a unique label is entered in the
Label field.

. Click OK. The system displays a message informing you that the ERMS daemon
must be recycled. See your system administrator for this step.

Modify or Delete a PCDF

To modify or delete an existing PCDF:

Note:
If a PCDF is currently in use in any patron record, it cannot be modified or
deleted.

Note:

When you modify a PCDF, the modification is not available for Find Tool
searches until the ERMS daemon is recycled. See your system
administrator.

. Inthe Administration Explorer tree view, open the Profiles folder at the system
level, and select the Patron Services tabbed page in the details view.

. Double-click Patron custom data: Definition. The Patron custom data: Definition

dialog box opens.
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Select a field that is not currently used in any patron records.
Modify or delete the PCDF as follows:

To modify the PCDF, click Modify Field and make changes.
To delete the PCDF, click Delete Field.
The PCDF is modified or deleted. The system displays a message informing you

that the ERMS daemon must be recycled. See your system administrator for this
step.

Filter Patron Custom Data Fields

To filter patron custom data fields:

1.

In the Administration Explorer tree view, open the Profiles folder at the system, lib-
rary, or branch level and select the Patron Services tab.

Double-click Patron custom data: Filter. The Patron custom data filter dialog box
opens.
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3. Select the checkbox next to the PCDFs that you want to make available for your lib-
rary or branch organization, and clear the checkbox next to the PCDFs that you do
not want to be available for your branch or library organization.

4. To change the order in which the fields will be displayed, select the up or down

arrow button. ﬂ

Note:

If you are filtering the custom data fields at the library or branch level, you
can select Revert to allow the current settings to be replaced by the
settings from the organization above (System if at the Library level;
System or Library if at the Branch level).

If changes are made after Revert is selected, then saving the changes
overwrites the settings for the current organization.

5. Click OK. The list of PCDFs is updated for your organization.

To require PCDFs or set defaults, see Setting Patron Registration Required Fields
and Defaults.

Setting Patron Registration Required Fields and Defaults

When you register a new patron, required fields appear in bold text on the Patron
Registration workform. If your library has configured default values for patron record

fields, they appear automatically.
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Two Patron Services parameters let you configure required fields and default values for
patron records:

» Patron registration options - Sets default values for patron records and defines

most required fields.

» Patron registration: First name required - Determines whether the first name is

required to save a patron record.

Both parameters are available at the System, Library, and Branch levels in Polaris
Administration (staff client).

To configure the Patron registration options parameter

1.

In the Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tab.

Double-click Patron registration options. The Patron Registration Options dialog
box - General Defaults tabbed page appears.

. Inthe Registered at box, select a library branch.

If you do not select a branch, the patron registration workform defaults to the
workstation branch.

Select a code in the Patron Code box.

Note:

Patron codes are used to define available services, loan periods,
fines, and limits for specific classes of patrons. The available patron
codes are set in the Patron Codes policy table. See Defining Patron
Codes.

Select a class in the Statistical Class box. The Statistical Class box lists the
defined classes for the selected branch.

Note:

Statistical class codes are used for reporting purposes. The
available codes are set in the Patron Statistical Class Codes policy
table. See Defining Patron Statistical Codes.

. Select a language in the Language box.

This setting controls the default selection in a new patron record. If you have
purchased Polaris licenses for additional languages, you can enable multi-lingual
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notices and have the notice sent in the language specified in the patron record.
Search the Polaris help for "Delivering Notices by Phone (Outbound Telephony)."

Note:
If you need additional language selections for patron records,
contact your Polaris Site Manager.

Select a default method for notifying patrons in the Notification box.

This setting controls the default selection in a new patron record. When you set up
notification, you can specify the notification method for each specific notice type,
including patron preference. In this case, the notice is sent by the method
specified in the patron record unless your library chooses to override the
preference for certain types of notices. Search the Polaris help for "Delivering
Notices by Phone (Outbound Telephony)."

If you plan to send email notices of any kind to patrons, and want to send these as
plain text by default, select E-mail notices in plain text.

This setting controls the default selection in a new patron record. Individual patron
records can set that patron’s preference for plain text or HTML email notices.

. If you plan to offer eReceipts as an option to patrons who prefer these to printed

receipts, and you want to set one or both of these options by default in new patron
records, select E-mail receipts, TXT receipts, or both.

If you select both options, the default patron record setting for eReceipts is ALL,;
that is, the patron would receive both email and TXT receipts. For more
information about eReceipts, see Setting Up eReceipts.

Type an area code (three digits) in the Phone 1 Area Code box.

Use one of the following methods to set an expiration term. This is the time that
the patron’s registration expires:

» To set a precise date, select exact date in the second Expiration term box,
and type a date in the first box using the format mm/dd/yyyy.

« To set a date relative to the current date (such as two years from today),
select months or years in the second Expiration term box, and type a
number in the first box.
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Note:

Your library may choose to block the patron record when the
expiration date is in the past. See Add, select, and order patron
block descriptions. When the term is updated, the block is
removed. See the Patron Services Guide, "Updating Patron
Registration Check Dates."

Use one of the following methods to set an address term. This is the time that the
patron’s address should be checked:

» To set a precise date, select exact date in the second Address check term
box, and type a date in the first box using the format mm/dd/yyyy.

» To set a date relative to the current date (such as two years from today),
select months or years in the second Address check term box, and type a
number in the first box.

Note:

Your library may choose to block the patron record when the
address check date is in the past. See Add, select, and order
patron block descriptions. When the term is updated, the block
is removed. See the Patron Services Guide, "Updating Patron
Registration Check Dates."

Select a country in the second Postal Code box, if necessary.
Type a postal code in the first Postal Code box.

This setting controls the default values in the Postal Code, City, State/province,
and County boxes on the Add/Edit Address dialog box for patron records. If the
state is not required as part of the address, you can leave the state empty.

Select the Required Fields tab and do the following to specify additional fields that
are required when registering patrons:

Note:

These fields are always required in new patron records: Barcode;
Last name; First name; Registered at; Patron code; Expiration
term/date; Address check term/date; Notification option and
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corresponding notification field (for example, Phone 1 and the
telephone number).

a. Select the checkbox next to each additional field (Address, Birth date,
Gender, Password, Statistical class) that you want to require for creating pat-
ron records. When the Gender option is selected for the patron'’s registration
branch, the staff member must select the patron's gender from a drop down
menu during patron registration. If None is selected, a message is displayed
when the staff member attempts to save the record. The field label appears
in bold to indicate it is required. These do not apply to offline registration and
are not checked when patron records are bulk-changed or merged.

b. Select Save to save the additional required fields.

16. If you want to define defaults for user-defined fields (UDFs) or patron custom data
fields (PCDFs) or require any of these fields for patron registration, select the Data
Field Defaults tab, and do the following:

Note:

User-defined fields are set up at Polaris implementation, using a
Patron Services profile at the System level. See Setting Up User-
Defined Fields.

» Select the UDFs subtab to display the UDFs that have been defined for your
library organization.

» Select the checkbox next to each UDF that is required for creating patron
records.

Note:

User-defined fields are set up at Polaris implementation, using
a Patron Services profile at the System level. See Setting Up
User-Defined Fields.

» For free-text UDFs, type text in each UDF box for which you want to specify
default text.

» For drop-menu UDFs, select an option in each UDF drop-menu for which you
want to specify a default option.

Note:
If you require a drop-menu UDF but do not specify a default
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option, the field is blank in a new record but the user must
select an option.

17. If you want to define defaults for patron custom data fields or make these custom
fields required for patron registration, select the Data Field Defaults tab and do the
following:

Note:
You cannot set default values for dates, and fields with a Boolean
type cannot be required.

a. Select the Custom Fields subtab.

b. Select the label text for the field.

Note:
When you select a field, do not select the checkbox unless the
field is required to save the patron record.

c. To specify defaults for the string, Boolean, or integer field type, do the
following:

« String custom field - When you select a string field type, you can enter a
default value of up to 255 characters.

» Boolean custom field - When you select a Boolean field type, you can
select a default value of Yes, No or Undefined. Boolean fields appear
as checkboxes in the patron registration forms. If the default is set to
Yes, the checkbox is selected. If the default is No, the checkbox is not
selected.

« Integer custom field - When you select an Integer field type, you can
enter a default value of up to 255 numbers in the box.

d. After defining the default for a field, select Set Default.
e. Torequire a value in the field, select the checkbox.
f. Select Apply.

18. On the Patron Registration Options dialog box, select Save.

To configure the Patron registration: First name required parameter

Some patrons have a single name instead of a first and last name. To enable saving a
patron record with a single name, set the Patron registration: First name required
parameter to No.
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1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tab.

2. Double-click the Patron registration: First name required row, and select Yes or
No.

3. Select Save.

Related Information

» Default patron passwords - A step in the nightly Patron Processing SQL job can
assign the last four digits of the patron’s primary telephone number (Phone 1) to
the password field of the patron record if a password does not exist. The default
password step is disabled at installation; , contact your Polaris Site Manager to
activate this feature. For more information about patron passwords, see the Pat-
ron Services Guide, "Patron Passwords and User Names."

» Express registration - You can set separate defaults and required fields for
express registration at check-out. See Setting Express Registration Defaults and
Requirements.

 Online registration from PAC - You can allow patrons to register online from the
PAC, and set a birth date requirement and default values for online registration.
See the Public Access Administration Guide, "Set up online patron self-regis-
tration."

Setting Express Registration Defaults and Requirements

The Patron Services parameter Express patron registration options controls the
required fields and default values for express patron registration at check-out. These
requirements and defaults can be different from those used for ordinary registrations.
When a staff member express-registers a patron, the Express Registration workform
opens with the default values, and required fields are displayed in bold type. The
parameter is available at the system, library, and branch levels.

See also: Set express registration default values and required fields

Set Express Registration Default Values and Required Fields
To set required fields and default values for express registration:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.
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. Double-click Express patron registration options. The Express Patron Registration
Options dialog box, General Defaults tabbed page appears. You can set default val-
ues for any or all fields on the Express Patron Registration Options dialog box.

. Select the Enable Express Registration checkbox to allow staff with the appro-
priate permission to express-register patrons. All boxes on the dialog box become
available for editing.

. Select the Add block to verify patron checkbox to add a Verify Patron block to
each record created through express registration.

When this option is selected, an express-registered patron is blocked at the next
check-out. A staff member then verifies details in the patron record and removes
the block. See the Patron Services PDF Guide, Resolve a Verify Patron block.

. Select a code in the Patron Code box.

The available patron codes are set in the Patron Codes policy table. See Defining
Patron Codes.

. Select a library branch in the Registered at box.

If no branch is selected, the patron registration workform defaults to the
workstation branch.

. Select a class in the Statistical Class box.

The Statistical Class box lists the defined classes for the selected branch. See
Defining Patron Statistical Codes.

. Select a language in the Language box.

This setting controls the default selection in a new patron record, but another
language can be selected at registration.

Note:

If you have purchased Polaris licenses for additional languages, you can
enable multi-lingual notices and have the notice sent in the language
specified in the patron record. Search Polaris help for "Delivering Notices
by Phone (Outbound Telephony)."

. Select a method for notifying patrons in the Notification box.

This setting controls the default selection in a new patron record, and the default
notification preference for patrons who register online (patron self-registration).
However, if the value is set to None, the default value for PAC registration will be

© 2023 Innovative (Part of Clarivate)
Page 33



10.

11.

12.
13.

14.

Patron Services Administration Guide

Mailing Address (print). If the value is set to Fax, Telephone 2, or Telephone 3, the
default value for PAC registration will be set to Telephone 1 (displayed as
Telephone in the PAC).

When you set up notification, you can specify the notification method for each
specific notice type, including patron preference. In this case, the notice is sent by
the method specified in the patron record. Search Polaris help for "Delivering
Notices by Phone (Outbound Telephony)."

If you plan to send e-mail notices of any kind to patrons, and want to send these
as plain text by default, check E-mail notices in plain text.

This setting controls the default selection in a new patron record. Individual patron
records can set that patron’s preference for plain text or HTML e-mail notices.

If you plan to offer eReceipts as an option to patrons who prefer these to printed
receipts, and you want to set one or both of these options by default in new patron
records, check E-mail receipts, TXT receipts, or both.

If you check both options, the default patron record setting for eReceipts is ALL;
that is, the patron would receive both e-mail and TXT receipts. For more
information about eReceipts, see Setting Up eReceipts.

Type a telephone area code (three digits) in the Voice Phone 1 Area Code box.

Use one of the following methods to set an expiration term. This is the time that
the patron’s registration expires:

» To set a precise date, select exact date in the second Expiration term box,
and type a date in the first box using the format mm/dd/yyyy.

» To set a date relative to the current date (such as two years from today),
select months or years in the second Expiration term box, and type a num-
ber in the first box.

Use one of the following methods to set an address check term. This is the time
that the patron’s address should be checked:

» To set a precise date, select exact date in the second Address check term
box, and type a date in the first box using the format mm/dd/yyyy.

» To set a date relative to the current date (such as two years from today),
select months or years in the second Address check term box, and type a
number in the first box.
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Select a country in the second Postal Code box, if necessary. If the state is not
required as part of the address, you can leave the state empty.

Type a postal code in the first Postal Code box.

This setting controls the default values in the Postal Code, City, State/province,
and County boxes on the Add/Edit Address dialog box for patron records.

On the UDF Defaults tabbed page, select the checkbox next to each UDF that
should be a required field for creating patron records.

Note:
User-defined fields are set up at Polaris implementation, using a Patron
Services profile at the system level. See Setting Up User-Defined Fields.

For free-text UDFs, type text in each UDF box for which you want to specify default
text.

(Optional) For drop-menu UDFs, select a default option.

Note:
If you require a drop-menu UDF but do not specify a default option, the
field is blank in a new record but the user must select an option.

On the Required Fields tabbed page, select the checkbox next to each field
(Address, Birth date, Gender, Password, Statistical class) that you want to require
for creating patron records.

Click Save on the Express Patron Registration Options dialog box.

Related Information

Online registration from PAC - You can allow patrons to register online from the PAC,
and set requirements and default values for online registration. See the Public Access
Administration PDF Guide, Set up online patron self-registration.

Charging for Patron Registration

If your library wants to charge registration fees to certain types of patrons, such as
temporary, seasonal, or non-resident users, you can set up registration fees by patron
code. The fee is applied automatically when patrons with the specified patron code
register or renew their registrations, and their patron accounts are blocked until the fee
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is paid. Registration fees are applied according to the settings of the registration
branch.

See also:

Staff Client Workflow
Patron Block for Registration Fee

Expired Registration
Offline Workflow

PAC Registration
Polaris ExpressCheck

Set patron registration fees

Staff Client Workflow

If a fee has been defined for the patron code, a Registration Fee dialog box appears
when a staff member selects Save in the new patron record. The dialog box displays the
amount of the fee and the following options:

Pay - The staff member must have the permission Fines: Pay fines at circ to
accept payment for the registration fee. The Pay dialog box opens and displays all
current payment methods, including credit card payments if the organization has
implemented these. Partial payments are possible. If a fee is partially paid, a block
is placed on the patron account (see Patron Block for Registration Fee). If the
option to print a receipt was selected, a receipt prints.

Waive - The staff member must have the permission Fines: Waive fines at circ. A
waive transaction is written to the patron account, and a receipt prints if the
receipt option was selected.

Charge - The charge is written to the patron account. The charge reason is listed
as Registration fee.

Print Receipt - This option is selected by default. Receipts are printed according to
the printer and driver set up for the Check Out workform printer. It is not necessary
to check any specific receipt type on the Check-out options dialog box, but the
printer and driver must be defined. The information printed on the receipt is that
selected for fine receipts with the Patron Services parameter Fine receipt options.
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Patron Block for Registration Fee

If the fee is charged to the patron account or only partially paid, a system block (Patron
registration fee) is placed on the patron account. The block is cleared when the total
charge amount is paid. As with other blocks, clicking on the block text from the Patron
Blocks dialog box opens the Patron Account view. The permission Override circ
blocks is required to override the block at check-out.

Expired Registration

If the expiration date in the patron record is reset (the registration is renewed), and the
patron code requires a registration fee, the system displays the Registration fee dialog
box as for a new registration. If the patron code is changed to non-chargeable at
renewal, the fee dialog box is not displayed.

Note:

If a new patron record is saved with a chargeable patron code and then
changed to a non-chargeable code, no action is taken on the patron
account. If the fee was paid, the payment transaction will remain. If the
fee was charged, the charge will remain on the patron account. The
registration fee and block remain until staff pay or waive the charge.

Offline Workflow

If a new patron record is created offline and the patron code is a chargeable type, the
fee is charged to the patron account and the Patron Registration Fee block is placed on
the patron record. The offline upload file includes a note in the entry for the registration.

PAC Registration

As part of the PAC registration process, the patron selects a home branch. The home
branch’s default settings are used to create the new patron registration. If the default
patron code set for PAC registration is a chargeable code, the program displays a
message to the patron. The default message is Your library account will be charged a
[$] registration fee. Do you want to continue? The message text can be customized or
translated with Polaris WebAdmin (Language Editor).

If the patron chooses to continue, the fee is charged to the patron account and the
Patron Registration Fee block is placed on the record.
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Note:
There is no option to renew an expired patron registration from PAC.

Polaris ExpressCheck

Patrons can renew an expiring registration at the Polaris ExpressCheck workstation if
the option Permit registration renewal if patron record expires is selected in the
parameter Polaris ExpressCheck: Enable. If the patron code is a chargeable type
according to the options set for the patron'’s registered branch, the program displays the
message for an expired patron record and does not offer an option to renew. The patron
must renew the registration at the circulation desk.

Set Patron Registration Fees
To specify which patron codes should be charged a registration fee:
1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.
2. Double-click Registration fee options to display the Registration Fee Options dia-
log box.

The dialog box lists the patron codes that have been selected for use at this
organization (see Defining Patron Codes). The default setting for each patron
code is $0.00 (no charge).

3. Select the patron code for which you want to set a fee.

4. Click the charge for the selected patron code and type the new amount in the
format shown in the dialog box. You can set a separate fee for each patron code
you select.

5. Click OK.

Setting Patron Duplicate Detection

When you save a patron record, Polaris automatically checks for duplicate records. By
default, Polaris checks the patron name fields (first and last names) for duplicates.
Polaris also checks the patron birth date and barcode for matches if this data is in the
record. You can set Polaris to check the following additional patron record fields for
matching criteria:
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Any two user-defined fields (UDFs)
Name on Identification

Phone 1

E-mail address

A match on any of these optional fields triggers a duplicate detection match. For
example, if Phone 1 is selected, a matching phone number triggers a duplicate detection
match, even if the patron names do not match.

Note:

The system compares field to field, for example, barcode to barcode. The
system does not cross-compare fields to find duplicates. For example, the
system does not compare patron name with Name on Identification.

A duplicate is a character-for-character match of the complete field. However, if the field
contains only one character, the system does not detect these records as duplicates.
This prevents unnecessary and false duplicate detection in cases where a library has
used an asterisk or another single character to flag certain records.

The system also uses the birth date to check for duplicate patron records to distinguish
records that might otherwise be considered a match. For example, if there are two
patrons named John Smith, a match is only detected if the birth dates are identical as
well. If no birth date is supplied, duplicate checking uses only the existing criteria.

Notes:

» When a birth date is included in PAC self-registration, the system
uses the birth date to check for duplicate patron records, in addition
to the first name and last name. If no birth date is supplied,
duplicate checking uses only the first and last names. Use the PAC
profile Patron Access options to require a birth date entry for patron
registration from PAC.

» You can opt out of duplicate detection during patron self-
registration in PAC using the Patron Access Options dialog. For
more information, see the Public Access Administration PDF Guide,
Set up online patron self-registration.

When possible duplicate records are detected, the Duplicate Patrons dialog displays a
list of the possible duplicates. To conserve system resources, the list is limited to 500
entries per duplicate detection criterion. For example, if 1,000 patrons have the same
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email address and 30 have the same phone number, Polaris lists 530 possible duplicate
records.

Use the Patron Services parameter Duplication detection options to select one or more
of the optional duplicate-checking fields. This parameter is available at the system,
library, and branch level. The system uses the registration library’s settings.

See also: Set optional patron duplicate detection fields

Set Optional Patron Duplicate Detection Fields

To specify which patron record fields (in addition to the patron name, barcode, and birth
date) are checked during duplicate detection:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tab in the details view.

2. Double-click Duplication detection options to display the Duplicate Detection
Options dialog box.

3. Select the checkboxes for the additional patron record fields that the system
should check for matching criteria. You can select a maximum of two user-defined
fields (UDFs). There is no selection limit in the other sections.

4. Click OK on the Duplicate Detection Options dialog box. The Administration
Explorer appears.

5. Select File > Save to save your changes.

Setting Reading History Options

Your library can save a reading history for a patron’s account. In the staff client, this list
is displayed on the Patron Status workform - Reader Services view. (The Circulation
permission Patron Status: Display reader services is required to view a patron’s reading
history on the Patron Status workform.) When reading histories are enabled for a
patron’s registered branch, patrons can also view their reading histories by accessing
their patron accounts through the PAC. The reading history contains basic information
for each item the patron has checked out since the reading history was started.

Use the Patron Services parameter Reading history to enable reading histories, set the
amount of time an entry remains in the reading history, and set the maximum number of
entries that can be retained in the reading history at once. The parameter is available at
the system, library, and branch level. After the parameter is set, staff can start reading
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histories for specific patrons. If reading history is enabled in Polaris Administration, the
Reading History view is available on the Patron Registration workform in the Polaris
Web App (Leap). See the Patron Services PDF Guide, Working with Reading Histories.

Important:

If your system includes Polaris Outreach Services, reading histories are
automatically enabled for outreach services patrons, regardless of the
Reading History parameter setting. Separate settings control reading
history limits for outreach services patrons. See Set reading history limits
for outreach patrons. For more information about outreach services
workflows, see the Patron Services PDF Guide, Outreach Services
Processing.

See also: Enable reading histories

Enable Reading Histories
To enable and limit patron reading histories:
1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.
2. Double-click Reading history. The Reading History Setup dialog box appears.

3. Select Enable reading history to allow Polaris to save reading histories for pat-
rons. If this option is checked and your library also uses the Polaris Web App
(Leap), users can access the Reading History view from the Patron Registration
workform in Leap. If the Enable reading history box is unchecked, the view is not
available from the Patron Registration workform in Leap.|

4. Specify the length of time (from check-out date to current date) to retain an entry
in the Reading History list:

a. Type the number of months or years in the first History length box.
b. Select the unit of time (months or years) in the second History length box.

5. In the Maximum history box, type the maximum number of items that can be
retained at one time in the Reading History list.

Note:

An entry’s creation date in the reading history is usually, but not always,
the check-out date. For example, offline uploads may cause some
variation. Also, Polaris does not consider the exact time of check-out. If
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the Maximum history value is exceeded, and several items were checked
out on the same date, Polaris deletes the items from the reading history in
an unspecified order.

Click OK on the Reading History Setup dialog box.
Select File > Save to save your changes.

Related Information

Reading history limits for outreach services patrons - See Set reading history limits

for outreach patrons.

Start and stop histories for specific patrons - See the Patron Services PDF Guide,
Working with Reading Histories.

Allow patrons to start and stop reading histories from the PAC - Set the Patron Ser-
vices profile Patron can enable/disable reading history to Yes. This setting
applies when reading histories are enabled for the organization and the patron is
not an Outreach Services patron.

Stop all reading histories - To stop recording all reading histories, clear the Enable
reading history checkbox on the Reading History Setup dialog box. When the
checkbox is cleared, new reading histories cannot be created, and existing his-
tories are not incremented. However, existing individual histories are not cleared.
If a reading history is stopped from the patron record, the patron’s existing history
is cleared.

Allow staff members to remove items from reading histories - Staff members with
the Circulation permission Reading history: Remove non-ORS patron history
entries: Allow can remove individual items from the reading histories of non-out-
reach services patrons. Staff members with the Circulation permission Reading
history: Remove ORS patron history entries: Allow can remove individual items
from the reading histories of outreach services patrons. See the Patron Services
PDF Guide, Working with Reading Histories.

Allow patrons to remove individual items from reading histories - Set the PAC pro-
file Patrons can remove reading history to Yes. The setting affects both Power-
PAC and Mobile PAC. The system uses the setting for the patron’s registered
branch. When a patron removes an item from the reading history, the item is also
removed from the reading history list in the staff client (Patron Status workform -
Reader Services view).
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Setting Up Patron Messages

Staff members with the appropriate permissions can post predefined or free-text
messages to specific patron accounts. The messages are posted from the Patron
Registration workform or posted and managed from the Patron Status workform - Notes
view, and patrons can read and delete them from the PAC patron account. In Polaris
Administration, you set up the predefined messages, translate them into Polaris
PowerPAC licensed languages if necessary, and set an automatic expiration period for
patron messages. For instructions, see: Set up patron messages in Polaris
Administration.

See also:

o Patron Messages in the Staff Client and Leap

e Patron Messages in PAC

Patron Messages in the Staff Client and Leap

Staff members need the organizational-level Circulation permission Post patron
message: Allow to post or modify messages in a patron account, and the system-level
Circulation permission Delete patron message: Allow to delete messages. To post a
message from the Patron Registration workform, select Tools, Post Message.To post a
message from the Patron Status workform - Notes view, click Add Message in the
message area of this view.

If a patron has unread messages, an alert message appears in the Patron Blocks dialog
box during check-out. Staff members can continue the check-out operation or cancel it,
or click the block text to open the Patron Status workform - Notes view. The alert
message does not place any blocks on patron activity in the PAC.

For detailed staff client procedures, see the Patron Services PDF Guide, Posting Patron
Messages.

Patron Messages in PAC

The My Record page in the PAC patron account displays a Messages drawer that the
user clicks or taps to expand the Messages area. The side portion of every page of the
patron account also displays counts of new and read messages that are convenient
links to open the Messages area of the account. When the Messages area is expanded,
the patron can check messages and mark them as read or delete them.
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When a patron marks a message as read, the status is noted in the Patron Status
workform - Notes view in the staff client. When a patron deletes a message, the
message is also deleted from the Patron Status workform - Notes view. (Messages are
also automatically removed according to the expiration period set in Polaris
Administration.)

Note:

Patrons can also view their messages in the patron account on SIP self-
check workstations if the SIP provider supports this feature. They may
also print on the SIP checkout receipt. Messages are shortened to 250
characters if necessary, and they cannot be marked as read or deleted.

Set up Patron Messages in Polaris Administration

The messages you define in Polaris Administration are available for selection in the
Library assigned list when a staff member posts a message to a patron account.

To set up patron messages:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.
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2. Double-click Patron message text: Configure. The Patron Message Text dialog
box appears.

3. To add a message, follow these steps:
a. Type up to 250 characters in the Message text box. Your message can
include alpha-numeric and special characters, and URLs.

b. Click Add. The message is added to the list with an icon that indicates the
organizational level at which it was added.

Note:

The Message list includes all the messages added at the
system and parent library levels as well as the branch level.
The appropriate organizational icon indicates the level at
which the message was added. To add a message from a
parent organization for use by your organization, click the
message. The text appears in the Message text box. Then
click Add. Only messages defined at your organizational level
can be modified or translated.

c. Click Apply to save your changes and continue to work with this dialog
box, or click OK to save your changes and close the dialog box.

4. To modify an existing message, follow these steps:

a. Select the message in the Messages list. The message is displayed in the
Message Text box.

b. Edit the message in the Message Text box.
c. Click Modify. The modified message is placed in the Messages list.
d. Click Apply to save your changes and continue to work with this dialog box,
or click OK to save your changes and close the dialog box.
5. To translate an existing message, follow these steps:

a. Select the message in the Messages list and click Translate. The Language
Strings dialog box opens.

b. Select a language from the Choose language list. The options are the
languages licensed for Polaris PowerPAC.

c. Type your translation in the language column next to the English equi-
valent.
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d. Toinsert a diacritic character, click Diacritics. The Character Picker dia-
log box opens.

e. Select a graphic character set, select the character, and click Insert.
For details on choosing diacritic characters, see the Cataloging PDF
Guide, Choose characters/diacritics from a chart. The Character Picker
dialog box closes.

f. Click Apply to save your changes and continue to work with the Patron
Message Text dialog box, or click OK to save your changes and close
the dialog box.

6. To delete a message, follow these steps:
a. Select the message in the Messages list.
b. Click Delete.

If the message is linked to any patron record, a warning message is
displayed. You can cancel the deletion or continue to delete the message. If
you delete it, it is removed from any patron accounts where it is currently
posted.

c. Click Apply to save your changes and continue to work with the Patron
Message Text dialog box, or click OK to save your changes and close
the dialog box.

7. To set an expiration period for patron messages, follow these steps:

a. Double-click the Patron Services parameter Patron message text: Expiration
period for the organization.

b. Set the number of days (0-99) that a message should remain in a patron
account (unless it is manually deleted).

After a message has been posted for the time period you set, it is
automatically deleted.

Note:

The time is counted from 11:59 on the day the message is
created through 11:59 or after of the final day. (The exact time
depends on when the automatic deletion job runs.) For
example, if the time limit is 5 days, a message created at 2:00
p.m. on Monday will expire at or after 11:59 p.m. Saturday. The
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period is not affected if the message text is modified.
However, if the expiration period is changed, all messages are
immediately affected. For example, reducing the expiration
period may cause some messages to expire immediately and
shorten the life of others.

c. Select File > Save from the Administration Explorer menu bar.

Related Information

Staff procedures - See the Patron Services PDF Guide, Posting Patron Messages.

Setting Up Patron Photos

From the Patron Photo view in the Patron Record workform, staff members can take a
photo, replace an old photo with a new one, upload an existing image file, or delete the
photo from the patron record. If the workstation is set to display the photo, it also
appears on the Check Out workform with the other patron information. (The patron’s
photo does not appear in the PAC.)

Workstations used to process patron photos require a Windows-compatible webcam
and associated software. Follow the installation instructions that accompany the
webcam.

Note:

You cannot install webcam software on a thin client (terminal server
environment) or use it via Remote Desktop, so you cannot take new
patron pictures by these means. However, if the pictures are loaded from
another source or captured on a conventional workstation with webcam
software, they are displayed normally in terminal server and Remote
Desktop environments.

For information about taking and editing patron photos, see the Patron Services PDF
Guide, Working with Patron Photos.

See also:

e System Administration Settings

» Importing Photos from an Existing Database

» Replace the default photo
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System Administration Settings

The Patron Services profile Display photo ID controls the display of patron photos in the
Patron Record workform and the Check Out workform. It also controls whether patron
photographs are displayed in the Patron Registration workform in the Polaris Web App
(Leap). The profile is available at the system, library, branch, and workstation levels, and
is set to Yes by default.

The following system-level Circulation permissions control the ability to work with
patron photos in the Patron Photo view of the Patron Registration workform:

» Modify photo IDs

» Delete photo IDs
The permissions are not automatically granted at installation, so you must specifically

assign them or supply a supervisor override. (The permissions do not affect the photo
display in the Check Out workform.)

Importing Photos from an Existing Database

A set of existing patron photos can be imported into Polaris in a batch. Imported or
uploaded images are limited to one megabyte (1 MG) each. Contact your Polaris Site
Manager for more information.

Replace the Default Photo
To use a custom image as the default photo instead of the Polaris logo by editing the
registry:
1. From the Start menu, select Run and type regedit. The Registry Editor opens.
2. Inthe Registry Editor, select HKEY_LOCAL_MACHINE, Software, Polaris, [version],
Clients.

3. Right-click in the Clients pane (right side of the Explorer) and select New, String
Value from the context menu.

4. Type PatronDefaultPhoto in the string value name box and press ENTER.

5. Double-click the new string value and type the complete path for your image file in
the Edit String dialog box. Then click OK.

When you open a patron registration workform, or the Check Out workform without
a photo, your custom default image is displayed instead of the Polaris logo.
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Setting Options for Deleting Patron Records

When a patron record is deleted, it is permanently removed from the Polaris database.
You can manually delete patron records (see the Patron Services PDF Guide, Deleting

Patron Records ) or you can specify criteria whereby patron records are automatically
deleted each night.

With either method, you can specify blocks that prevent certain records from being
deleted.

Note:

Staff must have the following Circulation permissions to delete patron
records and override blocks to deletion: Patron registration: Delete, and
Patron registration: Override blocks to delete.

You can set Polaris to automatically delete patron records that have been inactive for a
specified number of days. If you set Polaris to immediately delete unblocked records
that meet this criterion, you can also choose to place any blocked records in an
exceptions record set. You should regularly review this record set. If you do not want
any records to be deleted immediately, set Polaris to place all the records that are
candidates for deletion, both blocked and unblocked, in a record set where they can be
reviewed. After review, some records may be edited and retained, while others may be
manually deleted from within the record set.

Note:

Automatic deletion is accomplished through a nightly SQL job, Patron
Delete. The job is not enabled by default. For details, see the Polaris
Administration PDF Guide, Polaris Permission Groups - Default
Permissions Reference.

Records that are blocked from automatic deletion, whether placed in a record set or not,
are deleted automatically when the circumstances that prevented deletion no longer
exist. System-assigned circulation blocks prevent automatic deletion. Library-assigned
or free-text circulation blocks do not prevent automatic deletion.

The Patron Services parameter Patron delete options sets the criteria that affect both
manual and automatic deletion of patron records. The parameter is available at the
system, library, and branch level.

Note:
Even when a patron record is manually deleted in the Polaris staff client, it
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is not immediately removed from the database. Instead, the barcode is
modified and the name, address, e-mail address, and user-defined fields
are made blank, and the record is not returned in Find Tool search results.
The altered record is then deleted as part of the nightly Patron Processing
SQL job. This process optimizes staff client performance, and does not
affect the settings, procedures, and conditions for automatically and/or
manually deleting patron records described here.

See also:

» Retaining Financial Information for Deleted Patron Records

» Set options for deleting patron records

e Set blocks for patron record deletion

Retaining Financial Information for Deleted Patron Records

Certain patron account data from deleted patron records is saved in separate database
tables for the period specified in the Patron Services parameter Account transaction
deletion. If an associated item record is also deleted, the item record ID, barcode, title,
author, and material type are retained. This process ensures the accuracy of the
following reports even when the transacting patron records have been deleted:

 Daily Cash Balance Detail
» Daily Cash Drawer
 Daily Cash Drawer POS

+ Billed Patrons

» Fines and Fees

» Fines and Fees Summary
e Non-POS Payments

Note:

The Daily Cash Balance Detail, Daily Cash Drawer, and Daily Cash Drawer
POS reports can use retrospective data dating back to the beginning of
the calendar year during which Polaris 4.0 was installed. The other reports
listed here use only data from patron records deleted after Polaris 4.0 was
installed. This is because these reports include both charge and payment
transactions, and the retrospective data does not include charges.
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The saved data is then purged according to the parameter setting in the nightly Patron
Processing job. For example, if the setting for Account transaction deletion is two
years, any data older than two years is purged when the job runs. For more information
about setting the Account transaction deletion parameter, see Setting Patron
Accounting Options. For more information about the cash reports, see the Patron

Services PDF Guide, Patron Financial Reports.

Set Options for Deleting Patron Records

To set up automatic patron record deletion:

Important:

If you plan to place deleted records in a record set for later review, you
must set up the record set before you do this procedure. For more
information, search the Polaris help for "Creating and Using Record Sets."

. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

. Double-click Patron delete options. The Patron Delete Options dialog box appears
with the Method tabbed page displayed.

. To turn off automatic deletion completely, so that patron records are not deleted
automatically under any circumstances, click None and go to step 10.

. If you want Polaris to delete all patron records that are not blocked from deletion,
click Delete automatically. The Use exceptions record set checkbox is available. If
you want Polaris to place blocked records in a record set, do the following steps:

a. Select the Use exceptions record set checkbox. The Existing record set
option is selected, indicating that blocked records are placed in an existing
record set. (The New record set option is not currently functional.)

b. Click Select to search for and select the existing record set in which records
are placed.

. If you want Polaris to place all patron records (blocked and unblocked) in a record
set for review and manual deletion, click Write to record set. The Existing record
set option is selected, indicating that all records are placed in an existing record
set. (The New record set option is not currently functional.)

Note:
If you click None, Polaris does not run automatic processing for patron
record deletion.
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If you clicked Write to record set, click Select to search for and select the existing
record set in which records will be placed.

. If you selected Delete automatically or Write to record set, click Criteria to display

the Criteria tabbed page.

Note:
The Delete based on expiration option is not currently functional.

In the Delete if inactive for days box, type the number of days for which a patron
record must be inactive to be automatically deleted.

Note:

The Last Activity Date field in the patron record tracks patron activity. It
is updated in the following circumstances. Staff client: item check-out;
renewal; quick-circ item check-out; when a claim is made on an item,
when a charge is paid. PAC: log-in to patron account; placing and
modifying hold and ILL requests; online renewal; patron information
updates; payments; access to remote databases that require log-in.
Polaris ExpressCheck, SIP self-check units:check-out and renewal; patron
account access; payments. Time and print management applications: log-
in. Inbound telephony: Access account information and renew items. It is
also updated when payments are made on the patron’s account.

Click Save on the Patron Delete Options dialog box.

Related Information

Working with patron record sets - Search the Polaris help for "Creating and Using
Record Sets" and "Bulk-Changing Patron Records."

Preventing record deletion - See Set blocks for patron record deletion.

Purging patron ID information from transactions - See Removing Patron ID Inform-
ation from Transaction Files.

Set Blocks for Patron Record Deletion

To specify when Polaris blocks patron records from automatic or manual deletion:

1.

In the Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.
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2. Double-click Patron delete options to display the Patron Delete Options dialog
box, Method tabbed page.

3. Click the Blocks tab to display the Blocks tabbed page.
4. Specify the situations that should prevent a record from being deleted:

» Outstanding charge - Select the Block if the last outstanding charge date is
greater than days checkbox, and type the number of days.

e Account balance - Select the Block if the account balance due is over checkbox,
and type the amount.

» Credit balance - Select the Block if the account has a credit amount over check-
box, and type the amount.

» Deposit balance - Select the Block if the account has a deposit amount over
checkbox, and type the amount.

» Notes in patron record - Select the Block if patron has notes checkbox. This set-
ting applies to both non-blocking and blocking notes.

 Last activity date - Select the Block if the patron record Last Activity Date is
within the last . . . days checkbox, and type the number of days. This option
blocks manual deletion if the last activity date is within the specified period. It
does not apply to automatic deletion.

Note:

The Last Activity Date field in the patron record tracks patron activity.

It is updated in the following circumstances:

—Staff client: item check-out; renewal; quick-circ item check-out; when a
claim is made on an item, when a charge is paid.

—PAC: log-in to patron account; placing and modifying hold and ILL
requests; online renewal; patron information updates; payments; access
to remote databases that require log-in.

—Polaris ExpressCheck, SIP self-check units: check-out and renewal;
patron account access; payments.

—Time and print management applications: log-in.

—Inbound telephony: Access account information and renew items.

5. Click Save on the Patron Delete Options dialog box.
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Setting Patron Accounting Options

Certain Patron Services parameters control what options are available for handling
financial transactions in patron accounts:

 Credit for overpayment - Controls whether staff members can accept an over-
payment on charges and place a credit on the patron’s account. The charges are
paid, and the credit can then be carried on the account or refunded to the patron.

« Distributed waives - Controls whether a specified waived amount can be deducted
from every charge on the patron’s account. If a particular charge is greater than or
equal to the waived amount, the specified waived amount is deducted from the
charge. If a charge is less than the specified waived amount, no action is taken.

» Account transaction deletion - Controls how long finished transactions are listed
in the patron’s transaction summary. A deposit or charge transaction is con-
sidered finished when the outstanding amount is 0. Your settings for this para-
meter apply to all patrons registered at the branch. This setting also determines
how long some patron account data from deleted patron records is saved for cer-
tain financial reports. See Retaining Financial Information for Deleted Patron
Records.

These parameters can be set at the system, library, or branch level. At the system level,
you can also set Polaris to waive fines automatically at check-out or renewal. You may
want to waive fines automatically at check-out for items that are overdue on one
patron’s account, but “recovered” when the item is being checked out to another patron.
At renewal, you can set Polaris to waive the fine on an overdue item if the same patron
is renewing the item.

See also:

e Waive All Option in the Patron Status Workform - Account View

+ Set patron accounting options

o Set Polaris to waive fines at check-out or renewal

Waive All Option in the Patron Status Workform - Account View

By default, the Waive All icon and shortcut key are available for use in the Patron Status
workform - Account view. When the permissioned staff member clicks the icon, all of
the patron’s fines are waived.
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You can choose to make the Waive All icon and shortcut key unavailable for use. In
Polaris Administration, set the Patron Services parameter Waive All displays to No. The
parameter is available at the system, library, and branch levels. The system uses the
setting of the workstation’s logged-on branch.

This setting makes the icon and shortcut key unavailable and prevents staff members
from accidentally waiving all fines with a single click.

Note:

The Waive All displays parameter setting affects only the Waive All icon
display and shortcut key function. It does not affect a staff member’s
permission to waive fines.

Set Patron Accounting Options

To set Polaris to accept patron overpayments as credits, distribute waives,
automatically waive fines at check-out or renewal, and limit the transactions listed in the
patron’s transaction summary:

1.

In the Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

To allow credit for overpayment to be carried on patron accounts, double-click
Credit for overpayment, and select Yes.

If this parameter is set to No, when an overpayment is accepted, the charge is paid
and a message prompts the staff member to refund the difference.

To allow a specified amount to be waived from multiple charges, double-click Dis-
tributed waives, and select Yes.

If this parameter is set to No, the Distributed waive option is not available on the
Waive dialog box when a charge is being waived.

To limit how long transactions are listed in a patron’s transaction summary, follow
these steps:

a. Double-click Account transaction deletion.The Finished Transaction deletion
setup dialog box appear.

b. Select Enable finished transaction deletion.

c. Select years or months, and type the number of years or months that trans-
actions should be retained.
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Most finished deposit or charge transactions older than the period you
specify will be deleted from patron transaction summaries, including
charges for lost/billed items. However, the following transactions
remain in the transaction summary, regardless of your setting:
payments that have been refunded or credited, including lost-and-paid
transactions that were refunded or credited; deposits that have been
credited; any transaction associated with a credit; any transactions that
occur for patron accounts currently in collection.

Important:

After the cut-off date, all completed transactions are removed
from the system, including lost-and-paid transactions. Set this
parameter to a minimum of one year, for example, if you
reimburse patrons for lost-and-paid material when the material
is found within a year.

Note:

This setting also determines how long some patron account
data from deleted patron records is saved for certain financial
reports. See Retaining Financial Information for Deleted Patron
Records.

5. Click OK on the dialog box.
6. Select File, Save.

Related Information

» Permission to create a credit manually - Staff members must have the permission
Create a patron account credit: Allow to create a credit manually for a patron
account. For more information, see Setting Circulation Permissions.

» Permission to distribute a waived amount - If you allow distributed waives, staff
members who set up the waived amount need the permission Fines: waive fines
at circ: Allow. For more information, see Setting Circulation Permissions.

Set Polaris to Waive Fines at Check-Out or Renewal

To waive fines automatically when an overdue item is recovered at check-out to another
patron, or when a patron renews an overdue item:
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1. Inthe Administration Explorer tree view, open the Parameters folder for the sys-
tem, and select the Patron Services tabbed page in the details view.

2. To have Polaris automatically waive fines on items recovered at check-out, double-
click Overdues: Clear fine if recovered at check-out, and select Yes.

If this parameter is set to No, the fine remains in the account of the patron who
incurred the overdue charge and the item is checked out to the new patron.

3. To have Polaris automatically waive fines on items being renewed, double-click
Overdues: Clear fine if recovered at renewal, and select Yes.

If this parameter is set to No, the fine remains in the patron’s account when the
patron renews the item.

4. Select File, Save.

Setting Payment Method Options

When a staff member accepts a payment from a patron, the staff member selects a
payment method such as Cash or Check to describe the payment. Use the Payment
Methods policy table to display or suppress the following payment method options for
use in the staff client:

» Cash

» Check

» Collection agency

 Credit card

 Credit card - Manual

 Debit card

e Smart card

» Voucher
For example, if you do not use a collection agency, you can suppress this option from
display. Additionally, if your library does not have an integrated solution but offers a non-
integrated payment option, you can select Credit card - Manual to make this option
available in the staff client when taking payments. Libraries that already have an
integrated solution will leave the Credit card - Manual option unselected in the Payment

Methods table. You can also set the order in which the options are displayed in the
payment dialog boxes.
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Note:
The Credit card - Manual option does not make credit card payments
possible from PAC or MPAC.

The payment options you select in the policy table appear in the following situations:

» Pay dialog box - Paying charges from the Patron Status workform - Patron

Account view (if the patron account has a credit, Pay from credit is an automatic
option); paying overdue charges when renewing an item from the Patron Status
workform - Items Out view; paying charges when checking in an item; paying over-
due charges when renewing an item from the Check Out workform

Declare lost item dialog box - Paying charges when declaring an item lost from the
Patron Status workform - Iltems Out view

Create credit dialog box - Creating a credit from the Patron Status workform - Pat-
ron Account view (Collection agency option does not apply to this situation)

Create deposit dialog box - Creating a deposit from the Patron Status workform -
Patron Account view (Collection agency option does not apply to this situation)

Payment methods can be set from the system, library, and branch organization levels in
the Administration Explorer. However, you specify the options for each branch. When
you open the table at the system level, you can view and change entries for any branch.
At the library level, you can view and change entries for the branches associated with
the library. At the branch level, you can view and change entries for the selected branch.

Note:

These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify
payment methods table: Allow.

See also: Display or suppress payment methods.

Display or Suppress Payment Methods

To display or suppress payment methods, and set the order in which they are displayed
for staff selection:

1.

In the Administration Explorer, open the Policy Tables folder for the organization,
and select Payment Methods. The Payment Methods table is displayed in the
details view. By default, all payment methods are set to be displayed. The default
display order is alphabetical.
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Select the branch/method combination to display or suppress.

. Click to display the Modify Payment Methods dialog box.

In the Selected box, select Yes to display the method as an option, or select No to
suppress the method from display.

Note:

Polaris does not currently support debit card payments, and you should
suppress this option for all branches. If you accept credit card payments,
and your provider processes debit cards as credit cards, staff members
should select Credit card or Credit card - Manual as the method for a
debit card payment.

5. Click OK on the dialog box.

7.

To set the display order of the payment methods, select a branch/payment

method and click the up arrow|| + ||to move the option higher in the list, or click

the down arrow|| ¢ || to move it lower in the list.

Your changes affect all the dialog boxes that display the payment methods for
that branch.

Select File > Save to save your changes.

Related Information

» Set fine amounts - See Setting Fine Amounts.

e Credit card transactions - See Setting Up E-Commerce.

Date Sources in Patron Records

Dates for transactions in patron records are derived from the server or client
workstation when records are added or modified.

Note:

For more information about time and locale consistency among servers
and workstations, see the Polaris Administration PDF Guide, Ensuring
Locale and Time Consistency.

See also:
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Creating Patron Records Online

Creating Patron Records Offline

Modifying a Patron Record from Patron Registration Workform (Online Only)

Creating Patron Records Online

The registration date defaults to the server date in the Patron Registration work-
form. (The expiration date and address expiration date are calculated from this
date.)

The creation date in the patron record properties sheet uses the server date.
The transaction date for a patron registration fee is the server date.

TransactionHeaders.TranClientDate uses the server date when the creation trans-
action is queued.

TransactionHeaders.TransactionDate uses the server date when the creation
transaction is processed from the queue.

In TransactionDetails, where the TransactionSubTypelD is 187 (Patron Regis-
tration Date), the value is the client workstation date.

Creating Patron Records Offline

The registration date defaults to the offline workstation date in the Patron Regis-
tration workform. (The expiration date and address expiration date are calculated
from this date.)

The creation date in the patron record properties sheet uses the offline work-
station date.

The transaction date for a patron registration fee is the offline workstation date.
TransactionHeaders.TranClientDate uses the offline workstation date when the
creation transaction is queued.

TransactionHeaders.TransactionDate uses the server date when the creation
transaction is processed from the queue.

In TransactionDetails, where the TransactionSubTypelD is 187 (Patron Regis-
tration Date), the value is the offline workstation date.

Modifying a Patron Record from Patron Registration Workform (Online Only)

TransactionHeaders.TranClientDate uses the server date when the modification
transaction is queued.
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Deleting a Patron Record (Online Only)

e TransactionHeaders.TranClientDate uses the server date when the deletion trans-
action is queued.

Removing Patron ID Information from Transaction Files

Polaris records system transactions in transaction log files that are used for reporting,
trouble-shooting, and system tracking purposes. Many circulation and patron
accounting transactions are associated with specific patrons, and the log files that
record these transactions store the specific patron IDs associated with the transactions.
Using the Patron Services parameter Remove patron ID from circ transactions, you can
purge this patron-specific information from your transaction records after a time period
you specify. The same settings also purge patron IDs from item record histories. A
nightly SQL job, PurgePatronIDFromCircTransactions, purges the patron IDs from the
transactions according to your settings.

Important:
Patron IDs are not removed from transactions generated by the system
unless this feature is enabled at the system level.

See also:

e Circ Transactions from Which Patron IDs Are Purged

« Remove Patron ID Report

» Set up patron identification purging

Circ Transactions from Which Patron IDs Are Purged

The table lists the transactions from which patron IDs are purged if you choose to
enable this feature.

Note:
The obsolete transaction IDs listed in the table are no longer used but
may still exist in your transaction records.

Transaction Type ID Transaction Description

2011 OBSOLETE: Renewal
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Transaction Type ID Transaction Description

Overdue Block

2012 OBSOLETE: Renewal
Overdue Block Override

2090 OBSOLETE: Add hold
request

2091 OBSOLETE: Reactivate hold
request

2092 OBSOLETE: Cancel hold
request

2093 OBSOLETE: Satisfy hold
request

2094 OBSOLETE: Ship item for
hold

2095 OBSOLETE: Receive item for
hold

2096 OBSOLETE: Deny item for
hold

2097 OBSOLETE: Bibliographic
hold

2098 OBSOLETE: Serial issue hold

2099 OBSOLETE: Item specific
hold

2111 OBSOLETE: Trap item for
hold

2112 OBSOLETE: Trap hold renew
cancelled

2150 OBSOLETE: Patron check out
or renewal block
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Transaction Type ID Transaction Description

2183 OBSOLETE: Claim block

2185 OBSOLETE: Claim cancelled

2186 OBSOLETE: Claim block

2187 OBSOLETE: Claim block
override

6001 Check out

6002 Check in

6005 Hold request created

6006 Holds become held (item
received for hold request)

6007 Holds become expired

6008 Holds become unclaimed

6009 Holds become denied

6010 Holds become pending

6011 Holds become not supplied

6012 Holds become shipped

6013 Holds become cancelled

6026 Item claimed lost

6027 Item claimed never had

6028 Item claimed returned

6033 ILL Request created

6034 ILL Request become active

6035 ILL Request received

6036 ILL Request returned

6037 ILL Request become
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Transaction Type ID Transaction Description

cancelled

6039 Hold satisfied (item checked
out to patron)

6049 Patron accounting auto
waive void

7000 eCommerce Payment

Remove Patron ID Report

When you enable patron ID purging, you can run a report to track the number of patron
IDs purged during a time period you specify. Select Utilities, Reports and Notices from

the Pol

aris Shortcut bar, select Circulation in the Polaris Reports dialog box, and double-

click Remove Patron ID from circ transactions process log. For more information,

search

Set up

To ena

the Polaris help for Circulation Reports.

Patron Identification Purging

ble automatic purging of patron identification information from transaction logs

and item record histories after a specified time period:

Note:

These settings are available at the system, library, and branch levels.
Patron identification information is removed from transactions and item
record histories according to the transacting branch’s settings (not
according to the settings of the patrons’ registered branches). The
transacting branch is identified in the transaction header

OrganizationlD field. Patron IDs are not removed from transactions
generated by the system unless this feature is enabled at the system level

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the Patron Services tab in the details view.

2. Double-click Remove patron ID from circ transactions. The Remove patron ID
from circ transactions dialog box opens.

3. Select Enable patron ID removal. The Term options become available.
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4. Select an interval or select a date:

» Select months, years, or days in the Term box, and set the appropriate number.
For example, if you set the term to 2 years, patron identification information is
kept for two years following the date of the transaction, then purged from the
transaction database and item record histories. The program identifies trans-
actions from which to remove patron information by counting back the number of
days starting from beginning of the day it runs (12:00 midnight) through the final
day (12:00 midnight).

Example:

The term is set to 30 days. When the program runs on the night of August
30, it will count back from midnight August 30 through the full day to
midnight July 31. The patron ID will be removed from all transactions prior
to 12:00 July 31.

» Select exact date, and type a date or select a date from the drop-down calendar.
Information for that date will be purged. This option is most useful for testing or
implementing the purge feature for a short period of time.

Important:

Automatic lost item recovery actions, which take action on the patron
account if a lost item is recovered within a set period of time, depend on
the availability of patron ID information. If your organization uses
automatic lost item recovery actions, be sure to coordinate the settings
so that the patron ID is available if the lost item is recovered within the
time period you specify. See Setting Lost ltem Recovery Defaults.

5. Click OK.

Related Information

Specifying transactions to log - See Polaris Administration PDF Guide, Logging
Transactions.
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Setting Up E-Commerce - Overview and Requirements

To submit credit card payments from the Polaris staff client, PowerPAC, ExpressCheck,
or Leap, you must establish a connection to a payments gateway and then configure the
gateway in Polaris Administration. A license is required for each payments gateway
provider.

To accept credit card payments from a staff client, Leap, or ExpressCheck workstation,
a credit card reader must be attached to the workstation. When you install Polaris on a
workstation where staff will accept credit card payments, the credit card reader option
must be selected. You can set up credit card payment processing for the selected e-
commerce payment gateway in Polaris Administration at the system, library, or branch
level.

To accept PowerPAC or Mobile PAC online payments, you must enable secure socket
layer (SSL) for the Web server in Polaris Administration. For PowerPAC, set the SSL:
Enable PowerPAC parameter for the Web server to Yes. For Mobile PAC, set the SSL:
Enable Mobile PAC parameter for the Web server to Yes. See the Polaris Administration
PDF Guide, Setting Web Server Parameters. Patrons must have SSL protocol enabled for
their Web browsers and must accept the certificate the first time they log on from
outside the library.

The link for paying fines in PowerPAC and Mobile PAC is on the Fines and Fees page in
the patron account. If your library is set up to allow online credit card payments from
PowerPAC, be sure the PowerPAC and Mobile PAC profiles, Navigation: Fines & fees, are
set to Yes for your organization in Polaris Administration.

E-Commerce transactions appear on Polaris financial reports. Search Polaris help for "E-
Commerce Credit Card Reports."

For general information regarding e-commerce and Polaris, see these topics:

e Credit Card Payments from the Staff Client
e Credit Card Payments from PowerPAC or Mobile PAC
e Credit Card Payments from Polaris ExpressCheck

« Privacy and Refund Policy Display Options
e Credit Card Donations from PowerPAC or Mobile PAC
o E-Commerce Partial Payments

e Credit Card Payment Manager
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For instructions on setting up one of the e-Commerce gateways that can process credit
card payments from the Polaris staff client or Leap, ExpressCheck, PowerPAC, and
MobilePAC, see the topic for the gateway your library will use:

Note:
EnvisionWare and Comprise are the only payments gateways that handle
credit card payments made from Leap.

e E-Commerce with EnvisionWare®

o E-Commerce with Comprise™ SmartPAY™

e E-Commerce with PayPal® Payflow Pro®

e E-Commerce with Class Point of Sale

For instructions on setting up one of the e-Commerce gateways that processes web
payments from PowerPAC and Mobile PAC only, see the topic for the gateway your
library will use:

o E-Commerce with Payments Gateway Secure Web Pay

o E-Commerce with PayPal Payflow Link

« E-Commerce with JetPay (PowerPAC only)

Credit Card Payments from the Staff Client

The staff member selects the charges in the patron's account, selects Pay, and selects
Credit Card as the payment method. The fine amount is displayed, and the staff
member selects Submit.The system creates Store Order, Store Transaction, and Store
Details entries within the Pending status; sends the request to the e-commerce gateway
provider; and sends a query result request to the payment gateway provider. The staff
member swipes the credit card through the card reader attached to the workstation.
When the credit card is authorized, the system notifies the payment gateway provider
that the transaction is finished, the Store Order is updated to a Complete status, the
Store Transaction is updated to a Success status, and the patron account is updated. A
confirmation message is displayed, and a receipt is generated as with any other
payment method.

Note:
Staff members require the Fines: Allow credit card payments to accept
credit card payments and Fines: Allow refunds to process refunds.

© 2023 Innovative (Part of Clarivate)
Page 67



Patron Services Administration Guide

Possible error messages:

» Timeout message - The transaction timed out and is canceled.

» Payment did not go through as entered - Transaction is not authorized or is can-
celed by the gateway.

» Update patron account failed - The patron’s credit card was charged, but the pat-
ron account was not updated.

For instructions on setting up one of the e-Commerce gateways that can process credit
card payments from the Polaris staff client, Leap, ExpressCheck, PowerPAC, and
MobilePAC, see the topic for the gateway your library will use:

Note:
EnvisionWare and Comprise are the only payment gateways for credit
card payments from Leap.

E-Commerce with EnvisionWare®

E-Commerce with Comprise™ SmartPAY™

E-Commerce with PayPal® Payflow Pro®

E-Commerce with Class Point of Sale

Credit Card Payments from PowerPAC or Mobile PAC

If both the patron's registered branch and the PAC connection branch are set up with an
e-commerce provider to allow credit card payments from PACs, patrons can pay
charges from the Fines & Fees view in their library accounts. The patron selects the
charges to pay and clicks or taps Pay fines now. The example below shows the Fines &
Fees view in PowerPAC.

Fines & Fees
u Title Amount | Balance Transaction Date | Type Reazon
B EKnitting workshop 55.00 55,00 75T Charge  Overdue ltem
Charges: Deposits: Credits: 50.00
55,00 G0
i Pay Fines Howl [
R ——
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When the transaction is complete, the patron may receive an email receipt, depending
on the patron account settings. When a payment is made in the PAC, a note in the
Patron Status workform, Account view indicates the payment was made.

For instructions on setting up one of the e-Commerce gateways that can process credit
card payments from the Polaris staff client, ExpressCheck, PowerPAC, and MobilePAC,
see the topic for the gateway your library will use:

e E-Commerce with EnvisionWare®

e E-Commerce with Comprise™ SmartPAY™

o E-Commerce with PayPal® Payflow Pro®

e E-Commerce with Class Point of Sale

For instructions on setting up one of the e-Commerce gateways that processes web
payments from PowerPAC and Mobile PAC only, see the topic for the gateway your
library will use:

o E-Commerce with Payments Gateway Secure Web Pay

o E-Commerce with PayPal Payflow Link

« E-Commerce with JetPay (PowerPAC only)

Credit Card Payments from Polaris ExpressCheck

Credit card payments for fines and fees are allowed from Polaris ExpressCheck if both
the patron's registered branch allows credit card payments, and the ExpressCheck
workstation's branch allows credit card payments. If credit card payments are enabled
for ExpressCheck, patrons can log in and submit payments for fines and fees from
ExpressCheck workstations that are equipped with a credit card reader. The patron
selects the charges to pay on the Fines and Fees page, and selects Pay fines now. The
patron swipes the credit card through the card reader. When the transaction is
complete, the patron may receive an e-mail receipt that lists the charges paid, provided
and email address is in the patron record. The Patron Status workform, Account view
displays a note that the payment was made through ExpressCheck.

Possible error messages:

» Timeout message - The transaction timed out and is canceled.

» Payment did not go through as entered - Transaction is not authorized or is can-
celed by the gateway.
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» Update patron account failed - The patron’s credit card was charged, but the pat-
ron account was not updated.

For instructions on setting up one of the e-Commerce gateways that can process credit
card payments from the Polaris staff client, ExpressCheck, PowerPAC, and MobilePAC,
see the topic for the gateway your library will use:

e E-Commerce with EnvisionWare®

e E-Commerce with Comprise™ SmartPAY™

e E-Commerce with PayPal® Payflow Pro®

e E-Commerce with Class Point of Sale

Privacy and Refund Policy Display Options

When you set up an e-commerce for PowerPAC, MobilePAC, or ExpressCheck, you can
select the options: Display privacy policy and/or Display refund policy. The text for
these display options is set for the patron's registered branch using PolarisWebAdmin
(Language Editor) as follows:

» PowerPAC Privacy Policy - You specify your privacy policy text for PowerPAC
using Polaris WebAdmin (Language Editor). The message ID is PACML_
PAYMENT_PRIVACYPOLICY_1066. The system uses the text specified for the pat-
ron’s registered branch. For information about editing PAC language files, see the
Polaris WebAdmin (Language Editor) Guide or WebAdmin online Help. Any custom
text and markup must be responsive to the user's device.

» PowerPAC Refund Policy - You specify your refund policy text for PowerPAC using
Polaris WebAdmin (Language Editor). The message ID is: PACML_PAYMENT_
REFUNDPOLICY_1067. The system uses the text specified for the patron'’s
registered branch. For information about editing PAC language files, see the
Polaris WebAdmin (Language Editor) Guide or WebAdmin online Help. Any custom
text and markup must be responsive to the user's device.

» Mobile PAC Privacy Policy - You specify your privacy policy text for Mobile PAC
using Polaris WebAdmin (Language Editor). The message ID is MP_CRUMBS_
FINESANDFEES_PRIVACY. The system uses the text specified for the patron’s
registered branch. For information about editing PAC language strings, see the
Polaris WebAdmin (Language Editor) Guide or WebAdmin online Help.
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» Mobile PAC Refund Policy- You specify your refund policy text using Polaris
WebAdmin (Language Editor). The message ID is MP_CRUMBS_FINESANDFEES_
REFUND_POLICY. The system uses the text specified for the patron’s registered
branch. For information about editing PAC language strings, see the Polaris
WebAdmin (Language Editor) Guide or WebAdmin online Help.

» ExpressCheck Privacy Policy- You specify your privacy policy text for
ExpressCheck using Polaris WebAdmin (Language Editor). The message ID is EC_
TEXT_POLICY_PRIVACY. For information about editing ExpressCheck language
strings, see the Polaris WebAdmin (Language Editor) Guide or WebAdmin online
help.

» ExpressCheck Refund Policy - You specify your refund policy text using Polaris
WebAdmin (Language Editor). The message ID is EC_TEXT_POLICY_REFUND. For
information about editing ExpressCheck language strings, see the Polaris WebAd-
min (Language Editor) Guide or WebAdmin online help.

Credit Card Donations from PowerPAC or Mobile PAC

When you enable credit card donations from PowerPAC and/or Mobile PAC, the list of
receiving organizations is limited to those with credit card processing enabled. When a
patron makes a donation, the receiving organization's credit card settings are applied. If
the connection organization is a branch, and that branch has enabled credit card
processing and donations, the donation can be made to that branch only. However, if
the PAC connection organization is the library system, and donations are not enabled at
the system level, a donation can still be made to any library or branch that accepts
donations.

» Enabling donations - Use the Credit Card Payment parameter Online Payments:
Configure for your organization. Select your e-commerce provider in the Payment
processing gateway list, and select the PowerPAC tab in the Online Payment Set-
tings dialog box. Select Allow donations. Repeat using the Mobile PAC tab, if
appropriate. For specific instructions, see Credit Card Payments from PowerPAC
or Mobile PAC and select the link for your e-commerce provider.

» Donation branch order in PAC - In the PAC, the patron chooses a branch from a list
when making a donation. The branch display order is controlled in PAC Admin-
istration. See the Public Access Administration PDF Guide, Setting Up Polaris
PowerPAC - Overview topic.
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» Suppressing a branch from the donation branch list - Use the system-level PAC pro-
file Suppress branches to prevent a branch from appearing in the list. For Polaris
PowerPAC, this profile also suppresses the selected branches from the con-
nection branch list (Switch to another branch), the list of branches on the Search
Options scoping page, and the list of branches on the Advanced Search scoping
page. For Mobile PAC, the profile suppresses the branch from the drop-down lists
on the Library Hours and Preferences pages.

Important:

The donation Web part appears in the PowerPAC dashboard when you
assign it to the page. Be sure to assign the donation Web part to the
pages where you want it to appear. See Assign Web parts to public pages.
To display the donation link in Mobile PAC, set the Mobile PAC profile
Navigation: Donations to Yes.

Using Google's reCAPTCHA on the PAC Donations Page

Libraries that use PayPal Payflow Pro for credit card payments through Polaris
PowerPAC or Mobile PAC can enable Google's free reCAPTCHA feature, which adds
human verification to the process of submitting a donation to the library. This minimizes
the possibility of a robotic "user" making many small fake donations to the library to
verify stolen credit card information. Genuine donors identify a picture or select I'm not
a robot to continue with the donation process. For more information about reCAPTCHA,
see https://www.google.com/recaptcha/intro/index.html.

See also:

e E-Commerce with PayPal® Payflow Pro®
o Set up Google's reCAPTCHA on the PAC Donations page

E-Commerce Partial Payments

Partial payments are supported in the staff client only. Patrons can select specific fines
to pay or opt to pay all, but they cannot make partial payments from the PowerPAC,
Mobile PAC, or ExpressCheck. The patron’s registered branch settings determine the
specific credit card processor and parameters. For donations, the selected recipient
branch’s settings determine the specific credit card parameters.
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Credit Card Payment Manager

Staff members can view transaction details and refund payments made with a credit
card using the Credit Card Payment Manager, available from the Utilities menu on the
Polaris Shortcut Bar. The system Circulation permission, Access Credit Card Payments
Manager: Allow, is required to access the Credit Card Payment Manager. The Credit
Card Payment Manager shows only those orders and transactions where the staff client
workstation’s log-on branch and the transacting branch use the same payment gateway.

For more information about using the Credit Card Payment Manager, see Managing
Credit Card Orders.

Excluding In-House Workstations from Web-Based Payments

To prevent web-based credit card payments from within the library, set the system-level
Credit Card Payments parameter Exclude local workstations from web based
payments to Yes. This setting supports a lower level of PCI compliance responsibility on
the library’s part by preventing web-based payments through EnvisionWare from within
the library network. “Local workstations” are those defined in the In-House IP Addresses
database table. Add the library’s wi-fi connection to the table if you also want to exclude
payments from mobile devices within the library.

When you exclude local workstations from web-based payments, the Pay option is
suppressed from the patron account Fines & Fees page, and the Donation link displays a
message.

For more information about the In-House IP Address table, see Identifying In-House
Computers.
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E-Commerce with EnvisionWare®

Libraries licensed to use EnvisionWare as the payments gateway for submitting credit
card payments can select from the following options in the Credit Card Payment >
Online payments configure parameter in Polaris Administration:

« Enable credit card payments from the PAC (PowerPAC and Mobile PAC) - When
this option is selected, patrons can use the EnvisionWare eCommerce Services
Self Service application to submit credit card payments from the PAC. The Polaris
APl is required.

» Enable credit card payments from the staff client or Leap without using Envi-
sionWare's point of sale (POS) Staff Register software - When this option is selec-
ted, staff members can submit credit card payments from the Polaris staff client.

» Enable credit card payments from the staff client using EnvisionWare's Staff
Register application - When this option is selected, staff members use the Envi-
sionWare Staff Register application to submit credit card payments from the
Polaris staff client. SIP is required.

» Enable credit card payments from ExpressCheck.

Note:

Partial payments can be accepted in the staff client, but not in
ExpressCheck. Refunds for credit card payments cannot be processed
through EnvisionWare.

See also:

 Staff Client Credit Card Payments - EnvisionWare
o ExpressCheck Credit Card Payments - EnvisionWare

« PAC Payments - EnvisionWare

o Set up EnvisionWare processing in Polaris Administration

Staff Client Credit Card Payments - EnvisionWare

In Polaris Administration, your library can set up credit card payments from the staff
client using EnvisionWare's Staff Register interface or the Polaris interface. If Enable
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ExpressCheck/Staff Client (without POS) is selected for the library organization, the
Polaris credit card payment interface is used. If Enable Staff Client with POS is selected
for the library organization, the EnvisionWare Staff Register interface is used.

Staff client credit card payments without EnvisionWare's Staff Register
interface

The staff member can pay a patron’s charges via EnvisionWare when it is the selected
payment gateway for the staff member’s log-on branch (see Set up EnvisionWare
processing in Polaris Administration ). The system checks whether the payment is an
overpayment, which is not allowed, or under the minimal amount set for credit card
transactions, and displays appropriate messages to stop the transaction in these cases.
Otherwise, the Credit Card Payment dialog box opens.

B Credit Card Payment s par [ %
E I Hyou would like to contimees with this Franssction, dick Submit.
. I’i
Amaiint
Fine amaurt b7 ]
Processing fes 5050

T 1500

Mote:

Cancel

Note:

Entries in the Note field on this dialog box appear on the Polaris Store
Order. For information about viewing credit card transactions and
“orders,” see Managing Credit Card Orders.

Staff client credit card payments using EnvisionWare's Staff Register
interface

When the option Enable Staff Client with POS is selected, the Staff Register application
is used to submit payments initiated from the Polaris staff client. Credit card payments

can be made from the Patron Status workform, Patron Account view or the Check In
workform.
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The user selects Pay, and the EnvisionWare Staff Register application opens where the
user selects the fines or fees the patron is paying.

ExpressCheck Credit Card Payments - EnvisionWare

The logged-on ExpressCheck user selects the charges to pay on the patron account
Fines & fees page, and selects Pay. The confirmation screen is displayed.

A 8050 processing fes will be added 1o this enline payment.
Fa It youwould like Lo conlinuea with this transaction, click

I Accept.

= Print receipt
) Fines and Fews Summary:
Email '.cﬂmt Date Rt Tda Arraun Balsres
TW142011  Replecsran Cogl Thaea ritgth of the mrachin.. 2590 =Z=00
Armnaunt S3EE0
oy Poly Hemnd oty AESGEPL == Firesl Canceal |

When the user selects Accept, the screen instructs the user to swipe the credit card.

Plaasea slida your cradil card’s magnealic strip through the
attached reader.

%

# Print receipt
Finies and Faes Sumimany:
A | Dam Reagadn Tie Amcurt | Bsfance
10400 Raplaseman Cosl Tha migh of ha machien . 52500 52500
Ameunt 525,50
Privacy Poder BrhwdPosy (000 | inish Cancal |

The Polaris system creates Store Order, Store Transaction, and Store Details entries
with Pending status, sends the request to EnvisionWare, and sends a query result
request to EnvisionWare every 5 seconds. When the credit card is swiped and
authorized, a success message is displayed and the user selects Finish.

© 2023 Innovative (Part of Clarivate)
Page 76



Patron Services Administration Guide

v

= Print recedpt
Fings ared Fesn Summary:
= Email receaipt Tiote C—

4011 Repbiceswan Ton

Prvncy Poliay Hetnd Poy  Scosph v

Please click the Finish bulton to complate this ransaction.

Authorization Successful!

Trle
Thes sryth <f the rschin

Smaurnt
52500

Balance
sE00

Asmaunt FI550

Finish

The Polaris system then notifies EnvisionWare the transaction is finished, the ILS Store
Order is updated to Complete status, the ILS Store Transaction is updated to Success
status, and the patron account is updated. A print or e-mail receipt is generated
according to the receipt option the user selected.

PAC Payments - EnvisionWare

Payments from PowerPAC and Mobile PAC are Web-based, and patrons enter their
credit card information by typing it in an online form.

The logged-on patron selects the charges to pay on the patron account Fines & Fees
page, and clicks Pay Fines Now!. If the library has specified a processing fee, a

message is displayed.

Fines & Fees

n Tithe
B Enitting workshop 35.00 35.00

Charges: Daposits:
56,00 000

Gredits: 50.00

i Pay Fines Now! |

Amount | Balance | Transaction Date  Type

AT

Reaszon

Charge  Owerdus lem

The EnvisionWare Self Service application opens displaying the amount owed in the

Transaction Options window.
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@' Pay Fines/Fees

Access Account(s)
EXN

Transaction Options
Fines/Fees Owed: $23.85

Please select one of the following options.

The patron selects Pay Fines/Fees.

The Itemized Fines window displays each charge.

Description

"Charge" The beggar maid : stories of
Flo and Rose

"Charge" Organic farming : yesterday's
and tomorrow's agriculture

"Charge" Stranger's forest

Check/Uncheck All

Itemized Fines

Fines/Fees Owed: $23.85

Amount

$8.95

$5.95

$8.95

Total:

Please select the fines/fees you would like to pay.

Payment

8.95

$23.85

Patron Services Administration Guide

The patron selects the checkbox next to each charge to pay, and selects Submit.

The Payment Options window opens.

Payment Options

You have selected to pay: $23.85

Please select one of the following options.

[é;l Pay From Credit Card

Balance: $0.00

= Ed

No funds available in your Library Deposit Account

The patron selects Pay From Credit Card.

The Credit Card window opens.
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The patron enters the credit card information, and selects Submit.

Credit Card

Please enter your credit card information.

Card Holder Name: I:l
Credit Card Type: VISA v
Credit Card Number: |:|
Expiration Date
CVC Number: |:|

The patron selects the Submit button to submit the payment to EnvisionWare for
processing. If the payment is successful, a confirmation is displayed. The patron

account is updated in Polaris.

Set up EnvisionWare Payment Processing in Polaris Administration

To set up Polaris and Leap for EnvisionWare eCommerce payment processing in Polaris

Administration:

1. Inthe Administration Explorer tree view, open the Parameters folder for the
organization, and click the Credit Card Payment tab in the details view.

File Edit Help

N-=-H ER

Admmistration Explorer - System EParameters

Community Library A
(55 Parameters

Profiles
Permissions
Security
Policy Tables

Parameter

+m Corinth's Free Library
+m Digital Branch

FOA it B T | o

< >

Acquisitions / Serials
SelfCheck Unit

. @] Database Tables [ Online payments: Configure

3 PAC Motification

Credit Card Payment NCIP

2. Double-click Online Payments: Configure.

The Online Payments Settings dialog box opens.
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Online Payment Settings >

Payment processing gateway

Envision\Ware V| | Properties

PowerPaC Staff Client / Leap ExpressCheck Mobile PAC

[v] Allow online payments

Minimum fine ($):
Processing fee ($):

Send email receipt

[ ] Allowr manual credit card data entry if card reader is attached

OK Cancel Help

3. Select EnvisionWare in the Payment processing gateway list.
4. Click Properties.

The EnvisionWare properties dialog box opens.
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EnvisionWare =
Connection

Enable PAC Payments

Y L R RN oris. envisionware. net/ e CommerceWebModule/| Login?|

PAC Return URL: ‘ http:,’,’qa-quantum.pularisIibrary.com,-‘polarisfpatrnna(‘

MPAC Return URL: ‘ https://qa-quantum.polarislibrary.com/mobile/ ‘

Enable ExpressCheck / Staff Client (without POS) [ Leap

Payment service URL: ‘ https://ecspolaris.envisionware.net:31962 ‘

Port number: ‘ 5015

Inactivity timeout: : seconds

[_|Enable Staff Client with POS

Server URL: ‘localhost ‘

Port number: ‘ ‘

Timeout: 10 -2 minutes

5. To allow patrons to make credit card payments from the PAC, select Enable PAC
Payments and enter the following connection information:

» Payment page URL - Payment page URL - System level only. Provided by Envi-
sionWare.

* PAC Return URL - Typically the Polaris PowerPAC patron account Fine &
Fees page, displayed when the user clicks the return link on the Envi-
sionWare final payment transaction page (maximum 250 characters, alpha-
numeric):
https://www.mylibrary.org/polaris/patronaccount/finesfees.aspx, where
www.mylibrary.org/polaris is your PAC web site.

o MPAC Return URL - Typically the Polaris Mobile PAC patron account Fine &
Fees page, displayed when the user clicks the return link on the Envi-
sionWare final payment transaction page (maximum 250 characters, alpha-
numeric):
https://www.mylibrary.org/mobile/FinesAndFees/UpdateAccount, where
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www.mylibrary.org/mobile is your Mobile PAC web site. This field is
required. If you do not use Mobile PAC, simply enter your PAC Return URL.

. To allow credit card payments from Polaris ExpressCheck units, the Polaris staff
client (without using EnvisionWare's Staff Register software), or Leap, select
Enable ExpressCheck/Staff Client (without POS) / Leap and enter the following
connection information:

» Payment service URI
e Port number
¢ Inactivity timeout seconds

. To allow credit card payments from the Polaris staff client using EnvisionWare's
Staff Register software, select Enable Staff Client with POS and enter the fol-
lowing connection information:

e Server URL
e Port number
e Timeout minutes

. Click OK to save the settings, close the properties dialog box, and return to the
Online Payment Settings dialog box.

. Click the PowerPAC tab on the Online Payments Settings dialog box, and select
Allow online payments.

Note:

The option Allow online payments is available only if you selected Enable
PAC payments on the EnvisionWare properties dialog box. The other
information on this tab is controlled by EnvisionWare's Self Service web
application and cannot be edited in Polaris.
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Online Payment Settings X
Payment processing gateway
EnvisionWare V| | Properties
PowerPAC  Staff Client / Leap ExpressCheck Mobile PAC
[«] Allovs online payments
$1.00
£0.00
Send email receipt
Display privacy policy
Display refund policy
Allow donations
$0.00
Allow patron to designate title purchase
oK Cancel Help

10. Click the Staff Client / Leap tab and select Allow online payments.

Note:

The option Allow online payments is available on the Staff Client tab only
if you selected Enable ExpressCheck/Staff Client (without POS) or
Enable Staff Client with POS.The other information can be edited only if
you selected Enable ExpressCheck/Staff Client (without POS). If Enable
Staff Client with POS is selected, EnvisonWare's Staff Register

application controls these settings.
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Online Payment Settings >

Payment processing gateway

Envision\Ware V| | Properties

PowerPaC Staff Client / Leap ExpressCheck Mobile PAC

[v] Allow online payments

Minimum fine ($):
Processing fee ($):

Send email receipt

[ ] Allowr manual credit card data entry if card reader is attached

OK Cancel Help

11. If Enable ExpressCheck/Staff Client (without POS) is selected in the EnvisionWare
properties dialog box, set the payment and receipt options:

 Enter the minimum fine amount you want to accept by credit card pay-
ment in the Minimum fine box. The default value is the lowest possible
value, $0.01.

» To charge a processing fee for fine payments, specify the amount in the
Processing fee box. The maximum value is $20.00.

» To send an email receipt for fine payments, select Send email receipt.
» To allow staff members to enter credit card numbers manually, select
Allow manual credit card data entry if card reader is attached.

12. Click the ExpressCheck tab on the Online Payments Settings dialog box, and
select Allow online payments.

Note:
The option Allow online payments is available only if you selected Enable
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ExpressCheck/Staff Client (without POS) on the EnvisionWare properties
dialog box.

Online Payment Settings x

Payment processing gateway

EnvisionWare V‘ | Properties

PowerPAC Staff Client / Leap BxpressCheck Mobile PAC

[ ] Allow online payments

$3.00

£0.00
Send email receipt
Display privacy policy

Display refund policy

0OK Cancel Help

Set the payment, receipt, and policy display options for ExpressCheck as follows:

» Set the minimum fine amount you want to accept by credit card payment.
The default value is the lowest possible value, $0.01.

» To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

» To send an email receipt to the patron, select Send email receipt.

» To display a privacy policy link in ExpressCheck, select Display privacy
policy. See Privacy and Refund Policy Display Options.

» To display a refund policy link in ExpressCheck, select Display refund policy.
See Privacy and Refund Policy Display Options.
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14. Click the Mobile PAC tab on the Online Payments Settings dialog box, and select
Allow online payments.

Note:

The option Allow online payments is available only if you selected Enable
PAC payments on the EnvisionWare properties dialog box. The other
information on this tab is controlled by EnvisionWare's Self Service web
application and cannot be edited in Polaris.

Online Payment Settings *

Payment processing gateway

Envision\Ware v‘ | Properties

PowerPAC Staff Client / Leap ExpressCheck Mobile PAC

[] Allows online payments

$5.00

£0.00
Send email receipt
Display privacy policy

Display refund policy

Allow donations
$0.00

Allow patron to designate title purchase

0K Cancel Help

15. Click OK to save your settings.
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E-Commerce with Comprise SmartPAY

Polaris supports e-commerce with Comprise SmartPAY Merchant Service Program
(MSP) from Comprise Technologies, Inc., a PCl-compliant hosted payment solution
suitable for both Polaris Virtual Private Cloud (Hosted) and Polaris ILS turnkey
customers in the United States and Canada. Comprise SmartPAY, which handles
authorization requirements, is responsible for PCl compliance. Polaris stores only the
last four digits of the credit card number and the store order when payment is made
through Comprise SmartPAY. For more information about the Comprise SmartPAY
solution, see: http://www.comprisetechnologies.com/?page_id=32

With Comprise SmartPAY MSP, the library can accept credit card and debit card
payments made from the Polaris staff client, Leap, Polaris ExpressCheck, Polaris
PowerPAC, and Mobile PAC. Comprise SmartPAY uses a single SmartServer linked with
your library’s Polaris database, and the library will have a single Comprise account for all
payment portals. Each staff client and ExpressCheck workstation that will accept credit
card payments must have a Comprise SmartTerminal (the SmartPAY card reader
device) connected to it.

Refunds must be performed at a staff client workstation with a SmartPAY
SmartTerminal device attached. Both the branch that took the payment and the branch
issuing the refund must use SmartPAY. The refund transaction is initiated in Polaris, for
example from the Patron Account. The user is prompted to swipe the card in the
SmartTerminal device. The same card that made the payment must be used. Each
refund requires a card swipe. If the user is refunding 3 separate payments, the card
must be swiped 3 times.

SmartPAY refunds are issued “per payment,” not per charge. For example:
« If 3 charges were paid with a single payment transaction, the total of all 3 can be
refunded with a single refund transaction/card swipe.

« If 3 charges were paid with 3 separate payment transactions, then each must be
refunded with separate refund transactions—3 card swipes.

 Partial refunds are supported when refunding any payment. If 3 charges were paid
with a single transaction, a partial refund of each payment is supported.
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» Automatic refunds related to lost item recovery are not supported. Polaris recom-
mends that you disable any Refund option for lost-and-paid recovery when using
SmartPAY. If automatic refund is enabled with SmartPay, the payment will be left
as is in the patron account. No refund is created.

« Refunds made from the SmartPAY web interface (not using the API from within
the Polaris staff client) are not reflected in the patron account and cannot be
duplicated in Polaris.

Note:
Credit card payments for Polaris Fusion digital materials through
SmartPAY are not available at this time.

See also:

o Staff Client Payments - Comprise SmartPAY

ExpressCheck Payments - Comprise SmartPAY

PAC Payments - Comprise SmartPAY
SmartPAY Staff User Interface
Set up Comprise SmartPAY processing in Polaris Administration

Staff Client Payments - Comprise SmartPAY

The staff member can pay a patron’s charges via Comprise SmartPAY when Comprise
SmartPAY is the selected payment gateway for the staff member’s log-on branch (see
Set up Comprise SmartPAY processing in Polaris Administration), and a SmartTerminal
is connected to the workstation. The system checks whether the payment is an
overpayment, which is not allowed, or under the minimal amount set for credit card
transactions, and displays appropriate messages to stop the transaction in these cases.
Otherwise, the Credit Card Payment dialog box opens.
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B Credit Card Payment = par [ =]
b l Hyou would like to contimee with this Fonsaction, dick Submit.
: I.i":
Amaiint
Fine mourt 75 1]
Processing fee 5050

T 1500

Micte:

Cancel

Note:

Entries in the Note field on this dialog box appear on the Polaris Store
Order. For information about viewing credit card transactions and
“orders,” see the Patron Services PDF Guide, Managing Credit Card
Orders.

When the staff member clicks Submit, the system creates Store Order, Store
Transaction, and Store Details entries with Pending status, sends the request to
SmartPAY, and sends a query result request to SmartPAY every 5 seconds. When the
credit card is swiped at the SmartTerminal device and authorized, the system notifies
SmartPAY that the transaction is finished, the ILS Store Order is updated to Complete
status and the ILS Store Transaction to Success status, and the patron account is
updated. A confirmation message is displayed after a few seconds, and a receipt is
generated as with any other payment method.

ExpressCheck Payments - Comprise SmartPAY

The ExpressCheck workstation must be equipped with a SmartTerminal card reader.
The logged-on ExpressCheck user selects the charges to pay on the patron account
Fines & fees page, and selects Pay. The confirmation screen is displayed.
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A 8050 processing fes will be added to this online payment.
# If youwould like to continua with this transaction, click
4 Accept.

“ Print receipt
Fines and Fess Summary:

Dites Foasmsit Tie Amount  Balarcs
1W142011 Faplsceman Com Thaa rytgth of the rgchin... 2500 2500

~ Emaill recalpt

Aumaunt $IE80

paeey oty Aami oty ACCEPL »> | Firest Cancel |

When the user selects Accept, the screen instructs the user to swipe the credit card at
the SmartTerminal device.

Plaasea slida your cradil card’s magnealic strip through the
attached reader.

1E

* Print receipt

Fires and Faes Summany:

Dl Reasan e Amgurs | Baanes
10400 Raplaseman Cosl Tha migh of ha machien . 52500 52500

~ Email receipl

At 525,50

Py Prasy BetndPpecy  OOCE0 "'| Finizh Cancal |

The Polaris system creates Store Order, Store Transaction, and Store Details entries
with Pending status, sends the request to SmartPAY, and sends a query result request
to SmartPAY every 5 seconds. When the credit card is swiped at the SmartTerminal
device and authorized, a success message is displayed and the user selects Finish.
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= Print recedpt

= Email receaipt

Poyocy Policy  Hefund Poliy

Fings ared Fess Summary

it Resson

4011 Repbiceswan Ton

Authorization Successful!

Trin

Thes syt f this usssin

Please click the Finish bulton to complate this ransaction.

Smaurnt
52500

Asmaunt

Finish

Balance
sE00

IS5

The Polaris system then notifies SmartPAY the transaction is finished, the ILS Store

Order is updated to Complete status and the ILS Store Transaction to Success status,
and the patron account is updated. A print or e-mail receipt is generated according to
the receipt option the user selected.

PAC Payments - Comprise SmartPAY

Payments from PowerPAC and Mobile PAC are Web-based, and patrons enter their
credit card information by typing it in an on-screen form.

Note:

You can prevent Web-based credit card payments from within the library
by setting the system-level Credit Card Payments parameter Exclude local
workstations from web based payments to Yes. See Excluding In-House
Workstations from Web-Based Payments.

The logged-on PAC user selects the charges to pay on the patron account Fines & Fees
page, and clicks Pay Fines Now. If the library has specified a processing fee, a message

is displayed.
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When the user clicks Accept, the Fines & Fee summary page is displayed. This page

be redirected to SmartPAY.

totals the selected charges and processing fee, if any, and informs the user that they will

LEARY IO W

SEAHIH ¥ COMBUIREY § | MY ACCOUNT ¥

Finizi aavdl Fais

Type R Title: AT

g Orverdue iBn T s rminuts s [Compsc s disd ¥5.4

Crasge | Resplcament Cosl The dearmabs - joompad sucio deg] 3 noesl 848085

Dharga Frocoaing Fas 3.
Toml E5T 95

O W D TSR W SO a

<% Back || Condinusrs |

Privacy Podey | Refing Poliy

When the user clicks Continue, the SmartPAY checkout page opens.
Note:

The “time remaining” value on this page is configured by Comprise
SmartPAY. The default value is 90 seconds.
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The user enters credit card payment information and an e-mail address. SmartPAY will

send an e-mail receipt for the payment to the e-mail address specified on this page.
When the user clicks FINISH, the SmartPAY payment confirmation page is displayed.

Smart@ oo e

o=

|||||||

The ID number on this page is the Polaris patron record ID, and the invoice number is the
Polaris Store Order ID.

When the user clicks Finish, a printable receipt page is displayed. The library information
shown on the e-mail receipt and on this page is specified by Comprise as part of your
setup process. The Invoice number is the Polaris Store Order ID, and the Track number
is the Comprise transaction ID. The user can click Print to print the receipt, or click
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Finish to return to the Polaris PAC page specified in Polaris Administration (see Set up
Comprise SmartPAY processing in Polaris Administration). Similar processing is
available for donations.

SmartEi aomer

Teim Tromeriptios Assainn

SmartPAY Staff User Interface

SmartPAY also provides a SmartPAY API Staff User Interface at

https://dev.comprisetechnologies.com/SMARTPAYAPI/WEBSMARTPAY.dII?Adminlog
in

You can use this interface to get a transaction report, and credit or void transactions.
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Supply the username and password provided by SmartPAY, and log in. From the
Activity tab, you can list all transactions made from SmartPAY terminals or online for
the specified time period.

SmartE moysugmne

a1

Credits can be made for any transactions that were made before today and have a
remaining payment balance. Voids can be made for payment transactions that were
made today. However, Credits and Voids made from the SmartPay API Staff User
Interface do not update the patron account in Polaris. The staff member must manually
reconcile these transactions within Polaris.
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Set Up Comprise SmartPAY Processing in Polaris Administration

Only one payment gateway can be selected for a branch or library organization.
However, within a consortium that uses the Polaris turnkey ILS, branch and library
organizations may implement different gateways; some may use Comprise SmartPAY,
while others may choose other gateways.

If your library has multiple Comprise accounts, you can set the following fields at the
Branch level: Payment page/service URL, Customer Name, and Customer ID.

To set up Polaris for Comprise SmartPAY credit card processing in Polaris
Administration for the appropriate organizations:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the Credit Card Payment tab in the details view.

2. Double-click Online Payments: Configure.

File Edit Help

D-=-H &
Admmistration Explorer - System —EParameters
= i Li -~
f Community Library Patron Services a PAC Motification

= b : Acquisitions / Serials aloging
aramelters N
SelfCheck Unit Request Credit Card Payment NCIP

4 Profiles

¥ Permissions

Security
Policy Tables Parameter Value

-] Database Table: % Online payments: Configure SE‘[up .
+ Corinth's Free Library
+ Digital Branch v

N Misial Demenk Toon < >

< >

The Online Payments Settings dialog box opens.

3. Select Comprise MSP in the Payment processing gateway list.
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Online Payment Settings X

Payment processing gateway

Comprise M5P A Properties

PowerPAC Staff Client / Leap ExpressCheck Mobile PAC

[v] Allows online payments

Minimum fine ($):
Processing fee ($):

Send email receipt

Allow manual credit card data entry if card reader is attached

4. Click Properties. The Comprise MSP properties dialog box opens.
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Comprise MSP X
Connection
Payment page/service URL: com/smartpayapi/websmartpay.dl|
Customer Name: FolarisTest
Customer ID: 8200
User Name: Polaris
Password: (IIITY]
Location ID: PolarisTest
FAC Return URL: https://qa-polaris.polarislibrary.con
MPAC Return URL: https://qa-polaris.polarislibrary.con
Donations PAC Return URL: https://qa-polaris.polarislibrary.con
Donations MPAC Return URL: https://qa-polaris.polarislibrary.con
Fostback URL: https://qa-polaris.polarislibrary.con
Inactivity timeout:  s0 = seconds
Cancel Help

5. Enter the following settings on the Connection tabbed page, then click OK:

Payment page/service URL (SmartPay APl Address) - Set at the System
level for a single Comprise account or at the Branch level if you have multiple
Comprise accounts. Provided by Comprise. This is the SmartPAY payment
page.

Customer Name- Set at the System level for a single Comprise account or at
the Branch level if you have multiple Comprise accounts. Provided by Com-
prise, passed to SmartPay during the payment transaction.

Customer ID- Set at the System level for a single Comprise account or at the
Branch level if you have multiple Comprise accounts. Provided by Comprise,
passed to SmartPay during the payment transaction.

User name - Provided by Comprise. Each branch has its own user name.
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Password - Provided by Comprise. Each branch has its own password.

Location ID - Provided by Comprise. Apply to PAC only. Pass to SmartPay
WEB API. One per branch.

PAC Return URL - PowerPAC page to which the user is returned after fines
payment, typically the patron account page. Maximum 250 alphanumeric
characters.

MPAC Return URL - Mobile PAC page to which the user is returned after
fines payment, typically the patron account page. Maximum 250 alpha-
numeric characters.

Note:
When a patron cancels a payment from PowerPAC or Mobile
PAC, the appropriate Return URL page is displayed.

Donations PAC Return URL - PowerPAC page to which the user is
returned after a donation payment. Maximum 250 alphanumeric char-
acters.

Donations MPAC Return URL - Mobile PAC page to which the user is
returned after a donation payment. Maximum 250 alphanumeric char-
acters.

Postback URL - The location on the library Web site used to update the
Polaris database. This location applies to both PowerPAC and Mobile
PAC, and is not branch-specific. Maximum 250 alphanumeric char-
acters.
Format:https://servername:port/payments/PostbackSmartpay.aspx
For example:https://mylib-
rary.com/polaris/payments/PostbackSmartpay.aspx

Inactivity timeout - Specifies how long Polaris waits for the credit trans-
action to be processed before canceling it. This setting applies to
ExpressCheck and the staff client only (not to PowerPAC or Mobile
PAC).

Note:

You can also set an Inactivity timeout value set for
ExpressCheck transactions (SelfCheck Unit parameters,
Polaris ExpressCheck: Options). The default value for both
settings is 60 seconds. Polaris ExpressCheck times out after
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the total of both settings to ensure that the ExpressCheck
application never times out before the credit card transaction
processing time.

6. To set up credit card payments from Polaris PowerPAC, be sure Comprise MSP is
still selected in the Online Payments Settings dialog box, and follow these steps:

a. Click the PowerPAC tab on the Online Payments Settings dialog box, if it is
not already selected.

b. Select Allow online payments. The payment options become available.

Note:

The link for paying fines is on the Fines and Fees page of the
patron account. Be sure the PowerPAC profile Navigation:
Fines & fees is set to Yes for the organization. See the Public
Access Administration PDF Guide, Enable patron account
access - PowerPAC.

c. Set the minimum fine amount you want to accept by credit card pay-
ment.The default value is the lowest possible value, $0.01. If the
amount the patron owes falls below your setting, the Pay fines link is
not displayed in the PAC.

d. To charge a processing fee for fine payments, specify the amount in
the Processing fee box for online payments. The maximum value is
$20.00.

Note:

The e-mail receipt option is not applicable, because SmartPAY
sends the receipt to the e-mail address the patron specifies on
the SmartPAY payment page.

e. To display a privacy policy link in Polaris PowerPAC, select Display pri-
vacy policy. See Privacy and Refund Policy Display Options.

f. To display a refund policy link in Polaris PowerPAC, select Display
refund policy. See Privacy and Refund Policy Display Options.

g. To accept credit card payments for donations, select Allow donations.

© 2023 Innovative (Part of Clarivate)
Page 100



h.

Patron Services Administration Guide

To charge a processing fee for donations, specify the amount in the
Processing fee box for donation payments. The maximum value is
$20.00.

. To allow donors to direct a donation toward a title purchase in a spe-

cific subject area, select Allow patron to designate title purchase. This
option places an appropriate control on the donations page, where the
donor can specify a title purchase.

7. To set up credit card payments from Mobile PAC, follow these steps:

a.
b.
C.

Click the Mobile PAC tab on the Online Payments Settings dialog box.
Select Allow online payments. The payment options become available.

Set the minimum fine amount you want to accept by credit card payment.
The default value is the lowest possible value, $0.01. If the amount the pat-
ron owes falls below your setting, the Pay fines link is not displayed in
Mobile PAC.

To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

Note:

The e-mail receipt option is not applicable, because SmartPAY
sends the receipt to the e-mail address the patron specifies on
the SmartPAY payment page.

To display a privacy policy link in Mobile PAC, select Display privacy
policy. See Privacy and Refund Policy Display Options.

To display a refund policy link in Mobile PAC, select Display refund
policy. See Privacy and Refund Policy Display Options.

To accept credit card payments for donations, select Allow donations.

To charge a processing fee for donations, specify the amount in the
Processing fee box for donation payments. The maximum value is
$20.00.

. To allow donors to direct a donation toward a title purchase in a spe-

cific subject area, select Allow patron to designate title purchase. This
option places an appropriate control on the donations page, where the
donor can specify a title purchase.

8. To set up credit card payments from the staff client, follow these steps:
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Note:

To accept credit card payments, the staff client workstation
must be equipped with a Comprise SmartTerminal credit card
reader, and you must specify the SmartTerminal ID for each
workstation. See step 11.

Click the Staff Client tab on the Online Payments Settings dialog box.

Select Allow online payments. The payment options become available.

Set the minimum fine amount you want to accept by credit card pay-
ment.

To charge a processing fee for fine payments, specify the amount in
the Processing fee box for online payments. The maximum value is
$20.00.

To provide an automatic e-mail payment receipt to patrons, select
Send email receipt. The e-mail receipt is sent to the e-mail address in
the patron record. If the patron record does not include an e-mail
address, no e-mail receipt is sent. The staff member cannot specify an
e-mail address during the payment process.

Note:

The manual data entry option is not applicable. Staff client
workstations must use the Comprise SmartTerminal to swipe
the patron’s credit card.

9. To set up credit card payments from Polaris ExpressCheck, follow these steps:

Note:

To accept credit card payments, the Polaris ExpressCheck workstation
must be equipped with a Comprise SmartTerminal credit card reader, and
you must specify the SmartTerminal ID for each workstation. See step 11.

a.

Click the ExpressCheck tab on the Online Payments Settings dialog
box.

Select Allow online payments. The payment options become available.

Set the minimum fine amount you want to accept by credit card pay-
ment.
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d. To charge a processing fee for fine payments, specify the amount in
the Processing fee box for online payments. The maximum value is
$20.00.

e. To provide an automatic e-mail payment receipt to patrons, select
Send email receipt. The e-mail receipt is sent to the e-mail address in
the patron record. If the patron record does not include an e-mail
address, no e-mail receipt is sent. The patron cannot specify an e-mail
address during the payment process.

f. To display a privacy policy link on the processing fee, payment, and pay-
ment verification pages in Polaris ExpressCheck, select Display privacy
policy. See Privacy and Refund Policy Display Options.

g. Todisplay a refund policy link on the processing fee, payment, and pay-
ment verification pages in Polaris ExpressCheck, select Display refund
policy. See Privacy and Refund Policy Display Options.

h. Click OK to save your settings.

10. For each staff client and ExpressCheck workstation with a SmartTerminal, spe-
cify the payment terminal ID by following these steps:

Note:
Comprise supplies the terminal ID values for your workstations.

a. From the workstation listed in Administration Explorer or the work-
station workform, select Parameters > Credit Card Payment.

© 2023 Innovative (Part of Clarivate)
Page 103



Patron Services Administration Guide

File Edit Help
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b. Double-click Payment Terminal ID and enter the workstation SmartTer-
minal ID.

c. Select File > Save, or click E
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Polaris supports PayPal’s Payflow Link payment gateway for credit card payments from
Polaris PowerPAC and Mobile PAC. The Payflow Link gateway is a “redirect and
postback” method of providing credit card payments from Polaris PAC applications. An
advantage of this method is that much of the responsibility of PCI compliance falls to
the gateway, which handles authorization requirements, rather than the library. No credit
card information is stored in the Polaris database when payment is made through the
Payflow Link hosted payments site. For more information about the Payflow Link
gateway, see
https://merchant.paypal.com/cgi-bin/marketingweb?cmd=_render-content&content_
ID=merchant/payment_gateway

Important:

PayPal supports TLS 1.0. If Payflow link is attempting to post back to the
Polaris PAC site, it will fail if the server has been configured to allow TLS
1.1 and TLS 1.2 connections (TLS 1.0 has been disabled)

The logged-on PAC user selects the charges to pay and clicks Pay Fines Now. When the
user clicks Pay Fines Now, the Payflow Link checkout page opens. After the credit card
payment transaction has been set up and finalized, the user clicks a link to return to the
Fines & Fees page in the Polaris patron account. Payflow Link sends an e-mail receipt
for the payment to the user’'s e-mail address specified on the Hosted Checkout page.
Similar processing is available for donations.

The Polaris e-commerce licenses for Polaris PowerPAC and Mobile PAC (if your system
includes Mobile PAC) are required to use this feature. For fine payments, both the PAC
connection branch and the patron’s registered branch must support credit card
processing. The patron’s registered branch settings determine the specific credit card
processor and parameters. For donations, the selected recipient branch'’s settings
determine the specific credit card processor and parameters.

Payments from the staff client or from Polaris ExpressCheck are not supported.

Note:
When the payment processing gateway for the staff client log-in branch is
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Payflow Link, the Credit Card Payments Manager is not available from the
Utilities menu. At branches where the Credit Card Payments Manager is
accessible, store orders and store transactions do not appear for Payflow
Link transactions.

See also:

e Refunds
» Payflow Link Reports

« Set up the PayPal Payflow Link gateway account

o Set up Payflow Link processing in Polaris Administration

Refunds

With the Payflow Link hosted gateway solution, refund transactions are not integrated in
Polaris. Credit card refunds must be handled separately, both through Payflow Link and
manually from the Polaris patron account in the Polaris staff client. For example, if a
replacement charge has been paid via credit card, the refund must be issued manually
from the Polaris patron account transaction summary and then again from Payflow
Link. Work with Payflow Link to establish the appropriate staff accounts for handling
refunds, then establish the refunds workflow with your staff. Do not allow staff to issue
refunds to credit card payments from the Polaris patron account as cash or credit;
instead, they must select Refund.
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Note:
.

If a patron successfully pays by credit card using the Payflow Link web
page and the transaction is voided because Polaris was unable to update
the database, then no record of a payment is made in Polaris and the
patron’s credit card payment will be voided by Payflow Link. If a staff
member attempts to manually void a transaction using the PayPal
manager, the void transaction is not reflected in Polaris.

Polaris also supports integrated credit card processing, such as PayPal’s Payflow Pro
(see E-=Commerce with PayPal® Payflow Pro®), which does offer credit card refunds
from within Polaris. In systems where some sites use an integrated solution and others
use a gateway solution such as Payflow Link, refunds can only be made in these
circumstances:

» The staff client log-on branch supports integrated payments and the Online Pay-
ments: Configure option in Polaris Administration (Credit Card parameters) is set
to allow payments from the staff client for the integrated solution.

» The original payment was made using the integrated solution and the Online Pay-
ments: Configure option is set to allow payments from the staff client for the integ-
rated solution.
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Otherwise, when an attempt is made to refund a credit card payment in Polaris, a
message displays indicating that no refund transaction can be created. The credit card
is not refunded and the patron account is left as is. This situation might occur if a
consortium has implemented both integrated and hosted credit card payment solutions,
or a library or consortium has changed from one solution to another and the refund is
attempted after the change.

Lost Item Recovery

If a lost-and-paid item is recovered at check-in and the payment was made via credit
card, and the library has set the lost-and-paid item recovery options to automatically
credit the patron’s account, a “dummy” refund is created instead of a credit. The refund
will appear as a refund in the Polaris patron account and a refund transaction created.
This transaction is available for reporting in the Refunds to Credit Card Payments report.
You can use the report to cross-check transactions logged in Payflow Link. (Note that
the refund must also be made from Payflow Link.)

Instead of automatically crediting the patron’s account, you may want to set the lost-
and-paid item recovery options to Leave as is. With this setting, the payments remain in
the Polaris patron account and the refund or credit can be done from Payflow Link. Or
your library may choose to disable all automatic recovery actions, requiring staff to
create manual refunds when a lost-and-paid item is recovered. For more information
about setting lost item recovery options, see Setting Lost Item Recovery Defaults.

Payflow Link Reports
Payflow Link offers transaction reports; for example:

e Transaction Summary Report
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i igen Hame e Tirews Tove Samismeal SIS Transacoen Mode
Py P P alans FayFlow Vet My 02, 3013 1o Wad May 02, 2012 US Paoic Al TranseSong Tesl

Dewnload: 1. ASCH Text - e a2

TRARSACTIN TRANSACTION FRESIAT CARD MIMBSUM  WANIWUM  AVERAGE  TOTAL

TYPE PROCESSOR COLMT CO0E TYPE  CURREHCY AMOUNT ARCUMT ANOUNT AAADMINT

Lale FONS ! a vizs |USD B30 1500 1150 4800
Mastilie

Wodd FDME 2 d Wiza uso B30 1500 1150 23.08
Hastalls

Dizwricad 1 ASCH Test = | G0 12 ol 2 Fare

© 2023 Innovative (Part of Clarivate)
Page 108



Patron Services Administration Guide

 Daily Activity Transaction Report - The transaction IDs match those stored in the
ILSStoreTransactions.OrgID Polaris database table. Comment1 is the payment

reason and transacting organization; Commnet2 is the Polaris store order ID and
the patron barcode, if any.

Daily Activity Transaction Report
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£.13.93 A Courty Public Library -
Gerteal
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Set up the PayPal Payflow Link gateway account

Your library can establish a merchant account with Payflow Link directly. To set up the
account:

1. Sign up for your Payflow Link gateway account.
2. Log on to PayPal Manager.
3. Go to Service Settings and select Setup.
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4. Under Choose your settings, set Transaction Process Mode to Live when you are
ready to go live with credit card payments. (For set-up purposes, set this option to

Test.)

Note:

Settings under Display options on payment page are optional.

5. Under PayPal Express Checkout, set Enable PayPal Express Checkout to Yes.
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6. Under Billing Information, specify the required and editable fields for the billing
information the user must supply.

ted page.

Under Payment Confirmation, Show confirmation page, select On a PayPal hos-
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Enter text for your return URL. This text labels the link that returns the patron to the
Polaris PowerPAC patron account Fines & Fees page, or the equivalent page in
Mobile PAC if a mobile device is detected.

In the Enter Return URL box, type the URL for the interim page that redirects the
user to Polaris PowerPAC or Mobile PAC, if a mobile device is detected:
https://www.mylibrary.org/polaris/payments/payflowlinkreturn.aspx, where
www.mylibrary.org/polaris is your PAC web site.

Set Return URL Method to Link.

Paymeni Confirmatian
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O g webafe
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Under Silent Post for Data Transfer, set Use Silent Post to Yes.

In the Enter Silent Post URL field, enter the post-back URL for your site:
https://www.mylibrary.org/polaris/Payments/PostbackPayflowLink.aspx, where
www.mylibrary.org/polaris is your PAC web site.

Select Void transaction when my server fails to receive data sent by the silent

post.

Silent Fost for Date Transter
Use Sleml Post oo
Enter Sl POStURAL: g
¥ Wi ERTESCION whsn iy v Bk 1S sk il & el Sy B il el pail
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Under Email Confirmation, set Do you want us to confirm payment by email to
Yes.
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Emall Confirmation
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15. Under Configure Security Options, set Enable Secure Token to Yes.
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Set up Payflow Link processing in Polaris Administration
To set up Polaris for Payflow Link credit card processing in Polaris Administration:
1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the Credit Card Payment tab in the details view.
2. Double-click Online Payments: Configure. The Online Payments Settings dialog

box opens.
3. Select Payflow Link in the Payment processing gateway list.

© 2023 Innovative (Part of Clarivate)
Page 112



Patron Services Administration Guide

Cbrs Paymars: Sattings S
Payrsant procemsing owleary
Fa e L4 E [P
i)
Birbin Flspanek (CLESSS

|
Fatawih, |
P PayEEIS GAIEwRAY |
PavPal s Payfiow Fro |
¥ | Al (i PRATEERES
v fne () §1.00

Proomeng e {fe 3000

| Doy pePeacp Py
Dtaplary FefLoned pokcy
7| Allewn dorarions
Prommng fe (f:  80.02

] Mo pariron (o desgraris e purchass

(3 Canodd Heip

4. Click Properties. The Payflow Link Properties dialog box opens.
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5. Enter the following settings on the Connection tabbed page, then click OK:

» PAC Hosted checkout page URL - From PowerPAC, the redirect page link to the
Payflow Link hosted checkout page (maximum 250 characters, alphanumeric).
Obtain this setting from Payflow Link. Example: https://payflowlink.paypal.com

 MPAC Hosted checkout page URL - From Mobile PAC, the redirect page link to the
Payflow Link hosted checkout page (maximum 250 characters, alphanumeric).
Obtain this setting from Payflow Link.

» Request secure token URL - The PayFlow API URL:
https://payflowpro.paypal.com for live operation, or
https://pilot-payflowpro.paypal.com for test.

» Vendor - Optional. Your library’s main account name. Obtain this setting from Pay-
flow Link.
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 Login ID - Your Payflow Link login ID.
» Password - Your Payflow Link password.

» Partner - Typically PayPal. However, if you set up an account through a partner
such as bank, type the partner’s code. Obtain this setting from your partner; for
example, WFB for Wells Fargo bank.

6. To set up credit card payments from Polaris PowerPAC, be sure PayFlow Link is
still selected in the Online Payments Settings dialog box, and follow these steps:

a. Click the PowerPAC tab on the Online Payments Settings dialog box, if it is not
already selected.

Cnling Paywess Settings 'ﬂ
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b. Select Allow online payments. The payment options become available.

c. Set the minimum fine amount you want to accept by credit card payment. The
default value is the lowest possible value, $0.01. If the amount the patron owes
falls below your setting, the Pay fines link is not displayed in the PAC.

d. To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

e. To display a privacy policy link in Polaris PowerPAC, select Display privacy policy.
See: Privacy and Refund Policy Display Options.

f. To display a refund policy link in Polaris PowerPAC, select Display refund policy.
See: Privacy and Refund Policy Display Options.

g. To accept credit card payments for donations, select Allow donations.
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. To charge a processing fee for donations, specify the amount in the Processing
fee box for donation payments. The maximum value is $20.00.

i. To allow donors to direct a donation toward a title purchase in a specific subject

area, select Allow patron to designate title purchase. This option places an appro-
priate control on the donations page, where the donor can specify a title purchase.

. To set up credit card payments from Mobile PAC, follow these steps:

. Click the Mobile PAC tab on the Online Payments Settings dialog box.
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. Select Allow online payments. The payment options become available.

. Set the minimum fine amount you want to accept by credit card payment. The
default value is the lowest possible value, $0.01. If the amount the patron owes
falls below your setting, the Pay fines link is not displayed in Mobile PAC.

. To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

. To display a privacy policy link in Mobile PAC, select Display privacy policy. See
Privacy and Refund Policy Display Options.

. To display a refund policy link in Mobile PAC, select Display refund policy. See Pri-
vacy and Refund Policy Display Options.

. To accept credit card payments for donations, select Allow donations.

. To charge a processing fee for donations, specify the amount in the Processing
fee box for donation payments. The maximum value is $20.00.

i. To allow donors to direct a donation toward a title purchase in a specific subject

area, select Allow patron to designate title purchase. This option places an
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appropriate control on the donations page, where the donor can specify a title pur-
chase.

8. Click OK to save your settings.
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E-Commerce with JetPay

Polaris supports the use of JetPay for accepting credit card payments from Polaris
PowerPAC. JetPay is a hosted method of accepting credit card payments from
PowerPAC. You can enable the use of JetPay at the system, library, or branch level.

When you use JetPay for payments, JetPay handles much of the responsibility of
Payment Card Industry Data Security Standard (PCI DSS) compliance for your library. No
credit card information is stored in the Polaris database when a payment is made via
JetPay.

Note:
The use of JetPay for payments from the staff client, Polaris
ExpressCheck, or Mobile PAC is not supported.

To enable JetPay e-commerce, you must:

1. Set up a JetPay account.
2. Set up JetPay processing in the Administration Explorer.

For additional information about handling refund transactions when using JetPay for
credit card payments, search Polaris help for "Handling Refunds When Using JetPay.'
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Set Up a JetPay Account

To enable the use of JetPay for accepting credit card payments from Polaris PowerPAC,
contact JetPay to establish an account for your library.

When establishing your library's JetPay account, make a note of the following two
pieces of information:

» Client key
» Web key

You will need this information to set up JetPay processing in the Administration
Explorer.
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Set Up JetPay Processing in the Administration Explorer

Note:
To complete this workflow, your library must have already established a

JetPay account. For more information, see Set Up a JetPay Account.

To configure Polaris to use JetPay for processing credit card payments from
PowerPAC:

1. Inthe Administration Explorer tree view, navigate to the organization for which you
want to enable JetPay processing, and click Parameters > Credit Card Payment.

2. Double-click Online Payments: Configure.

The Online Payments Settings dialog box opens.
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Online Payment Settings x

Payment processing gateway

| JetF'ay| e Properties

PowerPAC  Staff Client [ Leap ExpressCheck Mobile PAC

Allow online payments

Minirnum fine (£):

Send email receipt
[ isplay privacy policy
[ pisplay refund policy

[ ] allow donations

Allow patron to designate tile purchase

Cancel e

3. In the Payment processing gateway list, select JetPay.
4. Click Properties.

The JetPay dialog box appears.
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JetPay >

Connection

Transaction LIRL:

Payment page URL:

Transaction fee URL:

Client key:

Web key:

PAC return URL:

| |
Post-back URL: | |
| |
| |

Donations PAC return URL:

Library absorbs fees: ]

Cancel Help

5. Enter the following connection information:
a. Transaction URL - Enter the following URL:

https://magic.collectorsolutions.com/magic-api/api/transaction/redirect
b. Payment page URL - Enter the following URL:
https://magic.collectorsolutions.com/magic-ui/PaymentRedirect
c. Transaction fee URL - Enter the following URL:
https://magic.collectorsolutions.com/magic-api/api/fee

d. Client key - Enter the client key provided when your library set up a JetPay
account.

e. Web key - Enter the web key provided when your library set up a JetPay
account.

f. Post-back URL - Enter the post-back URL for your site, using the format
below:
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https://<www.mylibrary.org/polaris>/payments/PostbackJetPay.aspx

Note:
Replace <www.mylibrary.org/polaris> with your Polaris
PowerPAC URL.

This field accepts a maximum of 250 alphanumeric characters.

g. PAC return URL - Enter the URL that will be displayed when the user clicks
the return link on the JetPay final payment transaction page. To use your lib-
rary's PowerPAC patron account Fine & Fees page, use the format below:

https://<www.mylibrary.org>/polaris/patronaccount/finesfees.aspx

Note:
Replace <www.mylibrary.org/polaris> with your Polaris
PowerPAC URL.

This field accepts a maximum of 250 alphanumeric characters.

h. Donations PAC return URL - If you plan to accept donations, enter the URL of
the Polaris PowerPAC page that will be displayed when the user clicks the
return link on the JetPay final payment transaction page. This field is
required. If you do not plan to accept donations, simply enter your PAC
Return URL. This field accepts a maximum of 250 alphanumeric characters.

i. Library absorbs fees - Select this checkbox if you want the library to absorb
the JetPay credit card processing fee. This checkbox is a shadow setting of
how your account is set up in JetPay to display warnings and fees to the pat-
ron and it must match the corresponding setting in JetPay. If this checkbox
is not selected, the processing fee is billed to the patron.

j. Click OK.
6. Configure the following settings on the PowerPAC tab of the Online Payments Set-
tings dialog box:
a. Allow online payments - Select this checkbox to enable the use of JetPay for
credit card payment processing.

Note:
In PowerPAC, patrons pay fines on the Fines and Fees page of
the patron account. Be sure the PowerPAC profile Navigation:
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Fines & fees is set to Yes for the organization to allow patrons
to access this page. For more information, see the Public
Access Administration PDF Guide, Enable patron account
access - PowerPAC.

b. Minimum fine - Enter the minimum fine amount that will be accepted via
credit card payment. The default value for this setting is $1.00.

Note:

If the amount a patron owes is less than the Minimum fine
value, the Pay fines link does not appear in the patron's
account in Polaris PowerPAC.

c. Processing fee -This is controlled completely by JetPay and should be set up
there. To charge a processing fee for fine payments, enter an amount in the
Processing fee box. The maximum value for this setting is $20.00. The
default value is $0.00.

d. Display privacy policy - To display a privacy policy link in Polaris PowerPAC,
select Display privacy policy. For more information, see Privacy and Refund
Policy Display Options.

e. Display refund policy - To display a refund policy link in Polaris PowerPAC,
select Display refund policy. For more information, see Privacy and Refund
Policy Display Options.

f. Allow donations - Select this checkbox to enable the use of credit card pay-
ments for donations.

g. Processing fee - This is controlled completely by JetPay and should be set
up there. To charge a processing fee for donations, enter an amount in the
Processing fee box for donation payments. The maximum value is $20.00.
The default value is $0.00.

h. Allow patron to designate title purchase - Select this checkbox to allow the
donor to direct a donation toward a title purchase in a specific subject area.
When this option is selected, the donations page includes a field where the
donor can specify a title purchase.

7. Click OK to save your settings.
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E-Commerce with Payments Gateway Secure Web Pay

Polaris supports Payments Gateway Secure Web Pay (SWP) for credit card payments
from Polaris PowerPAC and Mobile PAC. Payments Gateway SWP is a hosted “redirect
and postback” method of providing credit card payments from Polaris PAC applications.
An advantage of this method is that much of the responsibility of PCI compliance falls
to Payments Gateway, which handles authorization requirements, rather than the library.
No credit card information is stored in the Polaris database when payment is made
through the Payments Gateway hosted payments site. For more information about
Payments Gateway, see:

http://www.paymentsgateway.com/home.aspx

Payments from the staff client or from Polaris ExpressCheck are not supported.

Note:

When the payment processing gateway for the staff client log-in branch is
Payments Gateway, the Credit Card Payments Manager is not available
from the Utilities menu. At branches where the Credit Card Payments
Manager is accessible, store orders and store transactions do not appear
for Payments Gateway transactions.

See also:

e Refunds
* Payments Gateway Reports

o Set up the Payments Gateway SWP account

e Set up Payments Gateway processing in Polaris Administration

Refunds

With the Payments Gateway hosted solution, refund and void transactions are not
integrated in Polaris. Credit card refunds must be handled separately, both through
Payment Gateway'’s Virtual Terminal management interface and manually from the
Polaris patron account in the Polaris staff client. For example, if a replacement charge
has been paid via credit card, the refund must be issued manually from the Polaris
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patron account transaction summary and then again from the Virtual Terminal. Work
with Payments Gateway to establish the appropriate staff accounts for handling
refunds, then establish the refunds workflow with your staff. Do not allow staff to issue
refunds to credit card payments from the Polaris patron account as cash or credit;
instead, they must select Refund.
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Voided payments, as when the connection fails, are not recognized in
Polaris, and the voided transaction will appear in Polaris as a completed
transaction.

Polaris also supports integrated credit card processing, such as PayPal’s Payflow Pro
(see E-=Commerce with PayPal® Payflow Pro®), which does offer credit card refunds
from within Polaris. In systems where some sites use an integrated solution and others
use a gateway solution such as Payments Gateway, refunds can only be made in these
circumstances:

» The staff client log-on branch supports integrated payments and the Online Pay-
ments: Configure option in Polaris Administration (Credit Card parameters) is set
to allow payments from the staff client for the integrated solution.
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PPl Parpfioss Pres - Properties |

» The original payment was made using the integrated solution and the Online Pay-
ments: Configure option is set to allow payments from the staff client for the integ-
rated solution.

Otherwise, when an attempt is made to refund a credit card payment in Polaris, a
message displays indicating that no refund transaction can be created. The credit card
is not refunded and the patron account is left as is. This situation might occur if a
consortium has implemented both integrated and hosted credit card payment solutions,
or a library or consortium has changed from one solution to another and the refund is
attempted after the change.

Lost Item Recovery

If a lost-and-paid item is recovered at check-in and the payment was made via credit
card, and the library has set the lost-and-paid item recovery options to automatically
credit the patron’s account, a “dummy” refund is created instead of a credit. The refund
will appear as a refund in the Polaris patron account and a refund transaction created.
This transaction is available for reporting in the Refunds to Credit Card Payments report.
You can use the report to cross-check transactions logged in the Virtual Terminal. (Note
that the refund must also be made from the Virtual Terminal.)

Instead of automatically crediting the patron’s account, you may want to set the lost-
and-paid item recovery options to Leave as is. With this setting, the payments remain in
the Polaris patron account and the refund or credit can be done from Payments
Gateway. Or your library may choose to disable all automatic recovery actions, requiring
staff to create manual refunds when a lost-and-paid item is recovered. For more
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information about setting lost item recovery options, see Setting Lost ltem Recovery
Defaults.

Payments Gateway Reports

Payments Gateway offers extensive reporting capabilities. After your account is
established (see Set up the Payments Gateway SWP account), you can log in and select
Transactions to search for specific transactions.
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Select Reporting, Origination to see detailed organization-level reports.
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Set up the Payments Gateway SWP account

Your library establishes a merchant account with Payments Gateway directly. You can
set up one Payments Gateway SWP account for each branch that will offer credit card
processing, or set up one account for your entire system, associated with a specific
library administrator. To set up a Payments Gateway SWP account.

1. Go to http://www.paymentsgateway.com/home.aspx
and follow the instructions to set up a SWP merchant account.
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2. Login to Payments Gateway Virtual Terminal (VT) with your SWP Merchant ID,
username, and password at
https://www.paymentsgateway.net/vt3/login.aspx

3. Onthe Payments Gateway VT page, select Gateway Settings, Gateway Key.
4. Generate the API Login ID and the Secure Transaction Key.

Record these values for use in Polaris Administration. See Set up Payments
Gateway processing in Polaris Administration.

Click Update.
Select Gateway Settings, Secure Web Pay.

Click the Main tab if it is not already selected.

© N o o

In the Return Page 1 field, enter the post-back URL for your site:
https://www.mylibrary.org/polaris/Payments/PostbackPaymentsGateway.aspx,
where

www.mylibrary.org/polaris is your PAC web site. (Both PowerPAC and Mobile
PAC use the same post-back URL.)

Important:
Payments Gateway does not accept hyphens in the post-back URL (Return
Page 1).

You will enter the same URL in Polaris Administration. See Set up Payments
Gateway processing in Polaris Administration.
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Set Accept eCheck to No, and set Accept Credit Card Transactions to Yes.
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11. Inthe Contact Info section, supply the information that should appear on the Hos-
ted Checkout page.
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12. Click Update.
13. Click the Field Settings tab and make the following settings:

« Bill To Information settings are recommended.
 Ship To Information - We recommend that you set these fields to Hidden.

» Merchant Defined Fields - Consumer order ID - Displays the order ID on Payments
Gateway reports, necessary for identifying transactions (set to Required). When
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this option is set to required, the order ID is also displayed on the Hosted Checkout
page. You can type a description that will make sense to the patron; for example,
Polaris Payment ID. Set the other Merchant Defined Fields to Hidden.
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14. Click Update.

Set up Payments Gateway processing in Polaris Administration

To set up Polaris for Payments Gateway SWP credit card processing in Polaris
Administration:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the Credit Card Payment tab in the details view.
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2. Double-click Online Payments: Configure. The Online Payments Settings dialog
box opens.

3. Select Payments Gateway in the Payment processing gateway list.

Online Payment Settings

Payment processing gateway

| v) Properties

PowerPAC | Staff Client | ExpressCheck | Mabile PAC

Allow online payments

Minimum fine () §1.00

Processing fee (8): | $0.00
Send email receipt

[ pisplay privacy policy

[ ] Display refund policy

[ Allow donations
$0.00

Allow patron to designate title purchase
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4. Click Properties. The Payments Gateway Properties dialog box opens.

5. Enter the following settings on the Connection tabbed page and click OK:

» Hosted checkout page URL - The redirect page link to the Payments Gateway Hos-
ted Checkout page (maximum 250 characters, alphanumeric). Obtain this setting
from Payments Gateway.

Example:
https://sandbox.paymentsgateway.net/swp/co/default.aspx

» Login ID - The API Log In ID generated on your Payments Gateway VT page (max-
imum 250 characters, alphanumeric). See Set up the Payments Gateway SWP
account.

» Secure Transaction Key - The Secure Transaction Key generated on your Pay-

ments Gateway VT page (maximum 250 characters, alphanumeric). See Set up the
Payments Gateway SWP account.

» Current Version - Payments Gateway Secure Web Pay API current version number
(maximum 10 characters, alphanumeric). The current version is 1.0.

» Post-back URL - The Payments Gateway term for this is Return Page 1. Enter the
post-back URL for your site (maximum 250 characters, alphanumeric):
https://www.mylibrary.org/polaris/Payments/PostbackPaymentsGateway.aspx,
where
www.mylibrary.org/polaris is your PAC web site.

e Important:
Payments Gateway does not accept hyphens in the post-back URL (Return Page

1.
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PAC Return URL - Typically the Polaris PowerPAC patron account Fine & Fees
page, displayed when the user clicks the return link on the Payments Gateway final
payment transaction page (maximum 250 characters, alphanumeric):
https://www.mylibrary.org/polaris/patronaccount/finesfees.aspx, where
www.mylibrary.org/polaris is your PAC web site.

MPAC Return URL - Typically the Polaris Mobile PAC patron account Fine & Fees
page, displayed when the user clicks the return link on the Payments Gateway final
payment transaction page (maximum 250 characters, alphanumeric):
https://www.mylibrary.org/mobile/FinesAndFees/UpdateAccount, where
www.mylibrary.org/mobile is your Mobile PAC web site. This field is required. If
you do not use Mobile PAC, simply enter your PAC Return URL.

Donation PAC Return URL - If you plan to accept donations, enter the URL of the
Polaris PowerPAC page that should be displayed when the user clicks the return
link on the Payments Gateway final payment transaction page (maximum 250
characters, alphanumeric). This URL is typically your Polaris PowerPAC home
page. This field is required. If you do not plan to accept donations, simply enter
your PAC Return URL.

Donation MPAC Return URL - If you plan to accept donations, enter the URL of the
Polaris Mobile PAC page that should be displayed when the user clicks the return
link on the Payments Gateway final payment transaction page (maximum 250
characters, alphanumeric). This URL is typically your Polaris Mobile PAC home
page. If you do not plan to accept donations, or do not use Mobile PAC, simply
enter your PAC Return URL.

. To set up credit card payments from Polaris PowerPAC, be sure Payments Gate-
way is still selected in the Online Payments Settings dialog box, and follow these
steps:

. Click the PowerPAC tab on the Online Payments Settings dialog box, if it is not
already selected.
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. Select Allow online payments. The payment options become available.

Note:

The link for paying fines is on the Fines and Fees page of the patron
account. Be sure the PowerPAC profile Navigation: Fines & fees is set to
Yes for the organization. See the Public Access Administration PDF
Guide, Enable patron account access - PowerPAC.

. Set the minimum fine amount you want to accept by credit card payment. The
default value is the lowest possible value, $0.01. If the amount the patron owes
falls below your setting, the Pay fines link is not displayed in the PAC.

. To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

. To display a privacy policy link in Polaris PowerPAC, select Display privacy policy.
See Privacy and Refund Policy Display Options.

. To display a refund policy link in Polaris PowerPAC, select Display refund policy.
See Privacy and Refund Policy Display Options.

. To accept credit card payments for donations, select Allow donations.

. To charge a processing fee for donations, specify the amount in the Processing
fee box for donation payments. The maximum value is $20.00.

i. To allow donors to direct a donation toward a title purchase in a specific subject

area, select Allow patron to designate title purchase. This option places an appro-
priate control on the PAC donations page, where the donor can specify a title pur-
chase.
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7. To set up credit card payments from Mobile PAC, follow these steps:

a. Click the Mobile PAC tab on the Online Payments Settings dialog box.
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b. Select Allow online payments. The payment options become available.

Note:

The link for paying fines is on the Fines and Fees page of the patron
account. Be sure the Mobile PAC profile Navigation: Fines & fees is set to
Yes for the organization. See the Public Access Administration PDF
Guide, Patron Account (My Account) in Mobile PAC.

c. Set the minimum fine amount you want to accept by credit card payment. The
default value is the lowest possible value, $0.01. If the amount the patron owes
falls below your setting, the Pay fines link is not displayed in Mobile PAC.

d. To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

e. Todisplay a privacy policy link in Mobile PAC, select Display privacy policy. See
Privacy and Refund Policy Display Options.

f. To display a refund policy link in Mobile PAC, select Display refund policy. See Pri-
vacy and Refund Policy Display Options.

g. To accept credit card payments for donations, select Allow donations.

h. To charge a processing fee for donations, specify the amount in the Processing
fee box for donation payments. The maximum value is $20.00.
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i. To allow donors to direct a donation toward a title purchase in a specific subject
area, select Allow patron to designate title purchase. This option places an appro-
priate control on the donations page, where the donor can specify a title purchase.

. Click OK to save your settings.
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Active Payment Manager (Class Point of Sale) manages cash, check, and credit card
payments for the library and other agencies in the network. When a payment is made
through Class POS (from the Polaris staff client or by credit card from PAC), the
transaction is recorded in the patron’s account in Polaris.

Note:

If you are working in the Polaris staff client, you may be able to take credit
card payments in Class Point of Sale, but processing takes place entirely
within Class Point of Sale.

All system-defined Polaris fee reason codes (that is, codes equal to or less than 0) must
be entered in the Class POS application as the “Third Party ID” for the corresponding
Class POS item. Your Polaris Site Manager assists you in setting up these entries. This
ensures that when a staff member selects an overdue item charge to pay in Polaris, for
example, the Class POS software also identifies the reason for payment as overdue
item.

Class POS software must be installed with the Polaris staff client on the workstation,
but staff members do not need to start Class POS. You are prompted to log on to Class
POS only once, at the first payment action in the Polaris staff client session.

You can take payments for overdue charges from the Patron Status workform - Account
view or from the Check In workform. The Class POS interface automatically opens, and
you can make the payment according to the library’s policies. Payments for billed and
lost items must be made from the Patron Status workform - Account view.

Note:

When you pay from the Check In workform, but cancel the transaction in
Class POS, the charge remains on the patron’s account but does not
appear again on the Check In workform. At this point, you must pay the
charge from the Patron Status workform - Account view.

Payment transactions at check-out and at check-in from the item record workform are
not integrated with Class POS, so you may want to set the system-level Circulation
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permission Fines: pay fines at circ so that staff are not allowed to pay fines through
Polaris in these situations. Instead, the staff member creates a charge during the
transaction, and then pays the charge from the Patron Status workform - Account view.
For example, if the Overdue Fine dialog box appears at renewal, and the patron wants to
pay the fine, the staff member selects Charge Account in the Overdue Fine dialog box,
then pays the charge from the Patron Status workform - Account view. If the Patron
Status workform - Account view is already open, you can refresh the workform (F5) to
see and pay the charge. You can also refund a credit through Class POS from the Patron
Status workform - Account view. When the Refund function is selected, the Class POS
application is launched to process the refund and the transaction is recorded in both
Class POS and Polaris. For more information about refunding a credit, see the Patron
Services PDF Guide, Refund a credit amount.

Class POS does not handle payments from patron account credits or deposits. If your
library relies on Class POS software and POS reports to reconcile the cash drawer with
patron account transactions, you may want to prohibit deposit transactions in Polaris.

Important:

The effective interaction between Polaris and Class POS rests on charges,
payments, and credit refunds being initiated in Polaris. It is possible to
configure the Class POS interface independently of Polaris, and add
options that might initiate a payment, charge, or refund from Class POS.
However, Polaris interacts with Class POS as a payment manager only.
For example, charges initiated and paid in Class POS can result in a credit
transaction in the Polaris patron record that has no history in the Polaris
database.

Polaris waive transactions are unaffected by the use of Class POS, and they are not
registered or reported in Class POS.

You can accept credit card payments from the PAC through Class POS. To set up
Polaris for Class POS credit card processing, you will need the following information
from your Class POS representative: the URL to the Class online payment page for your
site and the Class POS database identifier (Item ID) for online library fine payments.

See also:

» Set up Class Point of Sale credit card payments

Set up Class Point of Sale credit card payments

To set up credit card payments from the PAC if your library uses Class Point of Sale.
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Note:

Credit card processing from Polaris ExpressCheck is not supported
through Class Point of Sale. If you are working in the staff client, you may
be able to take credit card payments in Class Point of Sale but processing
takes place entirely within Class Point of Sale.

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the Credit Card Payment tab in the details view.

File Edit Help
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2. Double-click Online Payments: Configure. The Online Payments Settings dialog
box appears.

3. Select Active Network (CLASS) in the Payment processing gateway list.
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. Enter the following settings, and click OK:

POS Web URL - The URL to the Class online payment page for your site.

POS Item ID (Library Fines) - The Class POS database identifier for online library
fine payments.

Note:
Obtain these settings from your Class POS representative.

. Click the PowerPAC tab on the Online Payments Settings dialog box, if it is not
already selected.

. Select Allow online payments.

. Set the minimum fine amount you want to accept by credit card payment. If the
amount the patron owes falls below your setting, the Pay fines link is not dis-
played in the PAC.

. Click OK to save your settings.
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E-Commerce with PayPal® Payflow Pro®

Polaris supports integrated credit card payment processing using the credit card
processing service PayPal® Payflow Pro®. You can accept credit card payments from
the staff client, Polaris PowerPAC and Mobile PAC, and Polaris ExpressCheck for
charges on the patron account and donations to the library (PAC only). A separate
license is required for each application. You can set up credit card processing at the
system, library, or branch level; you can make separate settings for the staff client, PAC,
and Polaris ExpressCheck.

To accept credit card payments with PayPal, your library establishes an account with
PayPal directly, or with an e-commerce provider such as a bank that offers PayPal
Payflow Pro payment processing.

To set up Polaris for PayPal Payflow Pro credit card processing, you will need the
following information regarding the library’s Payflow Pro account:

« Vendor (library) name, user name and password
 Partner code (PayPal or your e-commerce provider)
» PayPal’s server name

See also:

o Set up PayPal Payflow Pro credit card payments

Set up PayPal Payflow Pro Credit Card Payments
To set up credit card payment processing with the PayPal Payflow Pro service:

See also: Test Values for Payflow Pro Processing and Credit Card Error Logs.

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the Credit Card Payment tab in the details view.

2. Double-click Online Payments: Configure. The Online Payments Settings dialog
box appears.

3. Select PayPal’s Payflow Pro in the Payment processing gateway list.
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4. Click Properties. The PayPal Properties dialog box opens to the Connection
tabbed page.

5. Enter the following settings on the Connection tabbed page:

» Vendor - Your library’s main account name. Obtain this setting from PayPal or your
e-commerce partner.

» Username and Password - Obtain these settings from PayPal or your e-commerce
partner. Once you have a username and password, you can set up others for the
same account if you need to track manual transactions.

« Partner - Enter your partner’s code here (PayPal or your e-commerce provider).

» Timeout - Set the number of seconds that should elapse with no action before the
payment connection times out. The default is 30 seconds.

» Server - Type payflowpro.paypal.com for live transactions, or
pilot-payflowpro.paypal.com for testing purposes. See Test Values for Payflow
Pro Processing for credit card values you can use for testing.

Note:
The payflowpro.paypal.com setting is typical, but may be different
depending your bank.

6. Click the Settings tab, and enter the following information on the Settings tabbed
page:

» Cancel SALE method - This setting determines the appropriate automatic action
(VOID or CREDIT) to cancel a SALE transaction. A sale may be canceled when it
has been approved but fails AVS (Address Verification) and/or CVV2 (Card Veri-
fication Value 2) verification, or when a Polaris database error occurs. If a pro-
cessor batch-processes sales transactions at the end of the day, a VOID
transaction may be used to prevent the canceled SALE from settling. The library is
charged only one transaction fee. However, some processors are host-based and
do not use the batch method; in this case, all SALE transactions are settled imme-
diately and a CREDIT transaction must be used to cancel the SALE. For these pro-
cessors, the library is charged two transaction fees (one for the SALE and one for
the CREDIT).

Important:

You must contact your processor or PayPal e-commerce account provider
to determine if the processor uses the batch method or if they are host-
based. If the processor uses the batch method, you must also verify that
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SALE transactions can be voided. If so, you can select VOID for the Cancel
SALE method and avoid paying two transaction fees. Most processors
use the batch method. However, if the processor uses the host method,
you must select CREDIT as the cancel sale method, and you will be
charged two transaction fees when a sale is canceled. (Examples of host-
based processors include PayPal and Global Payments Central.)

Tip:
Log files record errors, warnings, and information about credit card
transactions.

» E-Mail credit card processing errors to - This option is highly recommended. Spe-
cify a staff e-mail address to receive automatic e-mail messages when a credit
card transaction fails and staff intervention is required. The message includes
details about the failure, so the staff member can then take action on the failed
transaction, either contacting the patron or adjusting the Polaris patron record
manually.

Example:

A patron's credit card is charged, but due to some type of error or
processing rule, the transaction needs to be canceled or a partial credit
needs to be applied. (This could be due to AVS or CVV2 failures or a
database update error.) If the cancel or credit transaction fails, the patron
credit card account is charged, but the transaction is not reflected in the
Polaris patron record. A staff member needs to adjust the patron account.

» AVS - Address verification, a security measure that may be provided as part of
your contract with your e-commerce partner. AVS matches the street address and
Zip code on the Polaris payment form with the street address and Zip code in a
credit card database that PayPal accesses. Select this option to use AVS. Then
select a level of verification. For the following options, Y indicates the value
matches, N indicates the value does not match, and X indicates that the card-
holder’'s bank does not support the check:

—Full indicates that the street address must be Y and the Zip code must be Y (YY)
or the transaction is declined. There can be no N values and no X values. Earlier
versions of Polaris automatically used this level.

—Medium indicates that there can be no N values (YY, XY, YX, XX allowed).
—Light declines transactions only when both values equal N. All other com-
binations are accepted.
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Note:

Occasionally AVS is faulty and a billing address, though correct, fails to be
matched. In this case the user receives a message and the transaction is
voided. If you find this is a problem, you may want to set the checking
level to Light or clear (uncheck) the AVS option. Also note that the billing
address that is displayed when the payment form opens is taken from the
address information in the Polaris patron record, and may be different
from the patron’s credit card billing address. The billing address can be
changed on the payment form. Once it is changed, it is not checked
against the patron’s record again during the transaction.

e CVV2 - Card Validation Value 2, a security measure that may be provided as part
of your PayPal contract with your e-commerce partner. This option requires the
user to enter a code usually located on the back of the credit card. Select this
option to use CVV2.

» Pre-authorize SALE - Available only when you select AVS and/or CVV2 veri-
fication. Select this option to AUTHORIZE a transaction before submitting the
SALE transaction. An AUTHORIZE transaction returns an approval/decline without
actually charging the cardholder’'s account for the full “sale.” Set the amount to a
small dollar amount such as $1 (the default) to process the AVS and CVV2 inform-
ation. If AVS or CVV2 fails, the cardholder is warned, and the actual charge is not
placed on the credit card account. This eliminates the need for VOID/CREDIT pro-
cessing of a SALE based on failed AVS or CVV2. If the AUTHORIZE transaction is
approved and AVS/CVV2 passes all tests, then a SALE transaction is issued for
the full amount. If a SALE is declined for the full amount, the new VOID or CREDIT
option would be used to cancel the SALE transaction.

Note:

An AUTHORIZE transaction will still place a small hold (for example, $1)
on the credit cardholder’s funds. Depending on the cardholder's bank, the
hold may remain for 24 hours to a week. While this style of processing
credit card payments can help reduce SALE issues based on AVS and
CVV2 processing, it requires an additional transaction fee for every credit
card payment.

7. Click the Supported Credit Cards tab.

8. Select the types of credit cards your provider supports, and click OK. The PayPal
properties dialog box closes.
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Note:

You can set the credit card types at the system, library, or branch level.
The Supported Credit Cards tabbed page indicates the organization from
which the settings have been inherited. If you make a change at the
branch level, the branch name is displayed on the tabbed page. To revert
to the settings of a higher level organization, clear all the checkboxes and
click OK. Then open the tabbed page again. The settings of the higher
level organization are displayed, and the name of the organization is
displayed on the tabbed page.

. To set up credit card payments from Polaris PowerPAC, follow these steps:

. Click the PowerPAC tab on the Online Payments Settings dialog box, if it is not
already selected.

. Select Allow online payments. The payment options become available.

Tip:
You can use this setting to prevent payments so small that they are offset
by your e-commerce provider’s transaction fees.

. Set the minimum fine amount you want to accept by credit card payment. The
default value is the lowest possible value, $0.01. If the amount the patron owes
falls below your setting, the Pay fines link is not displayed in the PAC.

. To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

. If you want patrons to receive an automatic payment receipt, select Send email
receipt.

. The e-mail receipt lists each fine covered by the transaction. The patron can spe-
cify an e-mail address on the payment form. The sender’s address is that specified
in the PAC profile Email notification: Email address of sender.

Note:

The link for paying fines is on the Fines and Fees page of the patron
account. Be sure the PowerPAC profile Navigation: Fines & fees is set to
Yes for the organization. See the Public Access Administration PDF
Guide, Enable patron account access - PowerPAC.

. To display a privacy policy link on the processing fee, payment, and payment veri-
fication pages in Polaris PowerPAC, select Display privacy policy. See Privacy and
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Refund Policy Display Options.

. To display a refund policy link on the processing fee, payment, and payment veri-

fication pages in Polaris PowerPAC, select Display refund policy. See Privacy and
Refund Policy Display Options.

. To accept credit card payments for donations, select Allow donations.
. To charge a processing fee for donations, specify the amount in the Processing

fee box for donation payments. The maximum value is $20.00.

To allow donors to direct a donation toward a title purchase in a specific subject
area, select Allow patron to designate title purchase. This option places an appro-
priate control on the donations page, where the donor can specify a title purchase.

To set up credit card payments from the staff client, follow these steps:

Click the Staff Client tab on the Online Payments Settings dialog box.
Select Allow online payments.
Set the minimum fine amount you want to accept by credit card payment.

To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

To provide an automatic e-mail payment receipt to patrons, select Send email
receipt. The e-mail receipt is sent to the e-mail address in the patron record. If the
patron record does not include an e-mail address, no e-mail receipt is sent. The
staff member cannot specify an e-mail address during the payment process.

If staff workstations have credit card readers but you also want to allow manual
data entry, select Allow manual credit card data entry if card reader is attached.
To set up credit card payments from Polaris ExpressCheck, follow these steps:

Click the ExpressCheck tab on the Online Payments Settings dialog box.
Select Allow online payments. The payment options become available.
Set the minimum fine amount you want to accept by credit card payment.

To charge a processing fee for fine payments, specify the amount in the Pro-
cessing fee box for online payments. The maximum value is $20.00.

To provide an automatic e-mail payment receipt to patrons, select Send email
receipt. The e-mail receipt is sent to the e-mail address in the patron record. If the
patron record does not include an e-mail address, no e-mail receipt is sent. The
patron cannot specify an e-mail address during the payment process.
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To display a privacy policy link on the processing fee, payment, and payment veri-
fication pages in Polaris ExpressCheck, select Display privacy policy. See Privacy
and Refund Policy Display Options.

. To display a refund policy link on the processing fee, payment, and payment veri-

fication pages in Polaris ExpressCheck, select Display refund policy. See Privacy
and Refund Policy Display Options.

To set up credit card payments from Mobile PAC, follow these steps:

Click the Mobile PAC tab on the Online Payments Settings dialog box.
Select Allow online payments. The payment options become available.

Note:

Credit card payments for fines and fees are allowed from Mobile PAC if
both the patron’s registered branch and the Mobile PAC connection
organization allow credit card payments.

Tip:
You can use this setting to prevent payments so small that they are offset
by your e-commerce provider’s transaction fees.

Set the minimum fine amount you want to accept by credit card payment. The
default value is the lowest possible value, $0.01. If the amount the patron owes
falls below your setting, the Pay fines link is not displayed in Mobile PAC.

. To charge a processing fee for fine payments, specify the amount in the Pro-

cessing fee box for online payments. The maximum value is $20.00.

. If you want patrons to receive an automatic payment receipt, select Send email

receipt. For fine receipts, the system uses the setting of the patron’s branch. For
donations (see step h below), the system uses the setting of the donation’s receiv-
ing branch. The e-mail receipt lists each fine covered by the transaction. The pat-
ron can specify an e-mail address on the payment form. The sender’s address is
that specified in the PAC profile Email notification: Email address of sender.

To display a privacy policy link on the processing fee, payment, and payment veri-
fication pages in Mobile PAC, select Display privacy policy. See Privacy and
Refund Policy Display Options.

To display a refund policy link on the processing fee, payment, and payment veri-
fication pages in Polaris Mobile PAC, select Display refund policy. See Privacy and
Refund Policy Display Options.

. To accept credit card payments for donations, select Allow donations.
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i. To charge a processing fee for donations, specify the amount in the Processing
fee box for donation payments. The maximum value is $20.00.

j. To allow donors to direct a donation toward a title purchase in a specific subject
area, select Allow patron to designate title purchase. This option places an appro-
priate control on the donations page, where the donor can specify a title purchase.

13. Click OK to save your settings.

Test Values for Payflow Pro Processing
Use the values in the following tables to test Payflow Pro credit card transactions.

Credit Card Numbers

Use the following credit card numbers for testing. Any other card number produces a
general failure.

American Express 378282246310005
American Express 371449635398431
Amex Corporate 378734493671000
Australian BankCard | 5610591081018250
Diners Club 30569309025904
Diners Club 38520000023237
Discover 6011111111111117
Discover 6011000990139424
JCB 3530111333300000
JCB 3566002020360505
MasterCard 5555555555554444
MasterCard 5105105105105100
Visa 4111111111111111
Visa 4012888888881881
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Credit Card Type Account Number

Visa 4222222222222

Result Codes Resulting From Amount Submitted

$0-$1000

Amount Result (RESPMSG)

0 (Approved)

§1001 - $2000

Certain amounts in this range
return specific result codes.
These can be generated by
adding $1,000 to that result
code. For example, for result
13 (Referral), submit the
amount $1013. If the amount
is in this range but does not
correspond to a result code
supported by this testing
mechanism, result 12
(Declined) is returned.

$2001+

12 (Declined)

Testing AVS - Address (AVSADDR)

Submitted Value for Example STREET

AVSADDR Result

STREET Value
000-333 24285 Elm Y
334-666 49354 Main
667 or higher or 79232 Maple X
begins with a non-
numeric character
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Testing AVS - Zip (AVSZIP)

Submitted Value Example ZIP

AVSZIP Result

for ZIP Value
00000-50000 00382 Y
5001-99999 94303
Any value (if STREET=79232 X

street address is | Maple,

667 or higher or ZIP=20304
begins with a
non-numeric
character)

Testing CVV2MATCH

CVV2 Value CVV2MATCH Value

000-300 Y
301-600 N
601 or higher | X

Credit Card Error Logs

Credit card log files track errors, warnings, and information about credit card
transactions made with Payflow Pro. These are located in the following folders:

Staff client transactions -
C:\ProgramData\Polaris\[version]\Logs\Polaris_Errors_[machine]_[date].log

Polaris PowerPAC transactions -
C:\ProgramData\Polaris\[version]\Logs\POWERPAC\
PowerPAC_Errors_[machine]_[date].log

Mobile PAC transactions -
C:\ProgramData\Polaris\[version]\Logs\MOBILEPAC\
MobilePAC_Errors_[machine]_[date].log

Polaris ExpressCheck transactions -
C:\ProgramData\Polaris\[version]\Logs\ExpressCheck_Errors_[machine]_[date].log
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If you set up automatic e-mail for errors that require staff intervention (see Set up
PayPal Payflow Pro credit card payments), note that these are also included in the log
files. Check the log files regularly to be sure that credit card processing is working

properly.

Note:

The e-mail receipts sent to patrons for fine and Polaris Fusion payments
also include a message if an error occurred that requires the patron to
contact the library. Four language strings support this feature:
PACML_PAYMENT_EMAIL_FINESRECEIPT_1063
PACML_PAYMENT_EMAIL_FINESRECEIPT_1064
PACML_PAYMENT_EMAIL_FUSIONRECEIPT_CONTACT
PACML_PAYMENT_EMAIL_FUSIONRECEIPT_SUCCESS

You can view and edit the text in these language strings with Polaris
WebAdmin (Language Editor). See the WebAdmin help file for more
information.

Set up Google's reCAPTCHA on the PAC Donations page

For libraries that use PayPal Payflow Pro for credit card payments through Polaris
PowerPAC or Mobile PAC, Google's free reCAPTCHA feature adds human verification to
the process of submitting a donation to the library. This minimizes the possibility of a
robotic "user" making many small fake donations to the library to verify stolen credit
card information. Genuine donors identify a picture or select I'm not a robot to continue
with the donation process. For more information about reCAPTCHA, see
https://www.google.com/recaptcha/intro/index.html.

When reCAPTCHA is enabled, users cannot proceed past the first donations page in
PowerPAC or Mobile PAC until they pass the reCAPTCHA test.

To implement reCAPTCHA, you will need a Google account. Using your Google account
credentials, obtain your domain-specific site key and secret key from Google:

Go to: www.google.com/recaptcha

Select the Get reCAPTCHA button in the upper right corner.

Log in with your Google account email and password and follow the instructions.

w N~

4. Record your reCAPTCHA site key and secret key.

Next, set up reCAPTCHA in Polaris system administration. The reCAPTCHA settings are
available at system, library, and branch levels:
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. Inthe Administration Explorer tree view, open the Parameters folder for the organ-

ization, and click the Credit Card Payment tab in the details view.

. Double-click Online Payments: Configure. The Online Payments Settings dialog

box appears.

Select PayPal’s Payflow Pro in the Payment processing gateway list.
Click Properties. The PayPal Properties dialog box opens.

Select the reCAPTCHA tab.

PayPal

Connection | Settings | Supported Credit Cards | reCAPTCHA

[]Enable reCAPTCHA for donations

Select (check ) Enable reCAPTCHA for donations.
Type your site key in the Google site key field.
Type your secret key in the Google secret key field.
Click OK.
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Setting Up Circulation Workforms

You can customize the fields that appear on the Check Out and Check In workforms, so
that only the information needed by your staff members is displayed. These options can
be set at the system, library, or branch level using the Patron Services parameters
Check-out: Optional patron data and Check-in: Listview options. The settings for the
Check Out workform also apply to the patron data in the header of the Patron Status
workform.

You can specify different fields for normal and bulk check-ins using the Check-In
Listview options. The settings for bulk checkin also apply to the Receive Shipment
workform available from the Acquisitions menu.

See also:

o Setting Up the Check Out Workform
o Setting Up the Check In Workform
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You can customize the Check Out workform so that only the patron and item
information needed by your staff is displayed. Patron data fields are displayed in the
workform header. Item data is displayed in the columns of the item list view.
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Item data options

See also:

» Set patron data fields for the Check Out workform
» Set item data fields for the Check Out workform

Set patron data fields for the Check Out workform

To set which optional patron data fields appear, and the order in which they appear, in
the header of the Check Out workform:

Note:

You can set these options at the system, library, or branch level. The
settings you make here also control the patron data displayed in the
header of the Patron Status workform.
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. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

. Double-click Check-out: Optional patron data. The Optional Patron Data Display
dialog box appears.

. To display a field in the Check Out workform header, select the field in the
Options list and click Add. The options include the user-defined fields set up for
your system. The field is placed in the Selections list.

Note:

If you select eReceipt, the field will be displayed regardless of whether
you have enabled eReceipts for this organization. If eReceipts are enabled
and you later decide to disable them, remember to remove the eReceipt
option from the Check Out workform header. For more information about
eReceipts, see Setting Up eReceipts.

. To move a field higher or lower in the workform header, select the field in the
Selections list, and click Up or Down.

. Toremove a field from the workform header, select the field in the Selections list,
and click Remove. The field is placed in the Options list.

. Click OK on the dialog box. The Administration Explorer appears.

7. Select File > Save.

Set item data fields for the Check Out workform

To set which item information appears, and the order in which it appears, in the list view
of the Check Out workform:

Note:
You can set these options at the system, library, or branch level.
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. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

. Double-click Check-out: Listview options. The Check-out Listview Options dialog
box appears.

Chack-cut Liskii Options =%™]
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. To display a field in the item list view on the Check Out workform, select the field
in the Options list and click Add. The field is placed in the Selections list, and will
be displayed as a data column in the list view.

Note:
For serials, the title field includes issue information.

. To move a column to the left or right in the workform list view, select the field in
the Selections list, and click Up (left) or Down (right).

. Toremove a field from the list view, select the field in the Selections list, and click
Remove. The field is placed in the Options list.

. Click OK on the dialog box. The Administration Explorer appears.

. Select File > Save.
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Setting Up the Check In Workform

Use the Patron Services parameter Check-in: Listview options to customize the Check
In workform so that only the patron and item information needed by your staff displays
in the workform. You can specify different fields for normal and bulk check-in.

Note:

If your library sends enriched EDI orders using Polaris Acquisitions and
receives and checks in shipments of shelf-ready barcoded materials, your
settings for bulk check-in are also used for the Check-In Shelf-Ready
Materials workform. See the Patron Services PDF Guide, Checking In
Shelf-Ready Items.
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See also: Set Check In list view fields for patron and item data

Set Check In list view fields for patron and item data

To specify the information that appears in the list view of the Check In workform:
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Note:

You can set these options at the system, library, or branch level.

Patron Services Administration Guide

In the Administration Explorer tree view, open the Parameters folder for the organ-

ization, and select the Patron Services tabbed page in the details view.

Double-click Check-in: Listview options. The Check-in listview options dialog box

appears.

Check-in: liskaew options

ol

In the Normal column, select the fields (Title, Material Type, Call Number, Shelf
Location, Patron Name, Assigned Branch, Collection) to display for normal check-
in. The selected fields will be displayed as data columns in the Check In workform
list view for normal check-in. The title field includes issue information for serials.

Note:

Select Assigned Branch if you allow circulation staff to change an item'’s
barcode, circulation status, or shelf location from the Check In Workform.
These operations can be performed only when an item'’s assigned branch
is the same as the workstation’s logged-in branch, so it is useful to know

the assigned branches of the items in the Check In list view.

In the Bulk column, select the fields (Title, Material Type, Call Number, Shelf Loca-
tion, Patron Name, Assigned Branch, Collection) to display for bulk check-in. The
selected fields will be displayed as data columns in the Check In workform list
view for bulk check-in.

These settings (except Patron Name) are also used in the Check-In Shelf-
Ready Materials workform if your library sends Enriched EDI orders using
Polaris Acquisitions and receives and checks in shipments of shelf-ready
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barcoded materials. See the Patron Services PDF Guide, Checking In Shelf-
Ready Items.

5. Click OK on the dialog box. The Administration Explorer appears.
6. Select File > Save.
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Setting Up Circulation Receipts

Polaris provides a number of printed receipts that you can configure to suit your library’s
policies. You can also enable eReceipts, so patrons can receive check-out, renewal, and
fine receipts by e-mail or text message.

See also:

o Setting Up Printed Receipts
o Epson® ReStick™ Printers - Hold and In-Transit Slips

o Setting Up eReceipts
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Setting Up Printed Receipts

Polaris provides the following printed circulation receipts and slips:

Check-out/renewal receipt - Lists the items checked out or renewed for a patron
during a circulation session. For set-up information, see Set check-out receipt

options.

Items Out receipt - Printed from the Patron Status workform - Items Out view, this
receipt lists all the items a patron currently has checked out. For set-up inform-
ation, see Set Items Out receipt options.

Check-in receipt - Lists the items checked in for a patron or group of patrons. If
items are selected from multiple patrons, the items are grouped by patrons, and
three blank lines are added at the end of each group. If auto-cut receipt printing is
enabled, the receipt is cut at the end of each patron’s group of items. (Iltems with
no patron information, for example those that went from In to In at check in, are
also grouped together and separated from patron items.) For set-up information,
see Set check-in receipt options.

Fine receipt - Lists the fines and fees paid or waived for overdue items, replace-
ment items, and other fees for a patron. For set-up information, see Set fine
receipt options.

Hold slip - Identifies a held item and the patron for whom the item is being held.
Four types of hold slips are available:

Default hold slip - A hold slip prints automatically when an item’s status becomes
Held as a result of a circulation transaction (for example, the item is checked in).
Libraries typically place the hold slip with the held material for identification pur-
poses. The slip also prints when an ILL item is received on the Request Manager
workform - ILL Requests view. For set-up information, see Set hold slip options.

Hold call slip - For libraries that call their patrons for held items. It includes exten-
ded information and is laid out so that it can be folded to expose the title when
placed in a book, with all the necessary patron information located below the fold.
See Enable hold call slips.

Hold/ILL pick-up slip - For libraries that allow patrons to pick up their own held
items. This slip is inserted in the book so that the patron’s name (in a specified
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format) and the pick-up date are visible on the shelf. By default, this slip is printed
horizontally on the receipt paper, and requires a line mode receipt printer such as a
Star® TSP600, Star TSP700, or Dell™ T200. The settings for this slip also apply to
an equivalent ILL pickup slip, printed when an interlibrary loan item is received. Ver-
tical printing settings are also available. For set-up information, see Set up hold
pickup slips.

« In-transit slip - Prints automatically when an item'’s status changes to In Transit
(because it belongs to another branch) or Transferred (because it will fill a hold
and needs to be sent to the pick-up library) during a circulation transaction. You
can also choose to print the in-transit slip only when the status changes to Trans-
ferred (see the Patron Services PDF Guide, Set the workstation to print receipts
and slips). In Polaris Administration, you can choose the information to include on
the slip and select the option to combine the in-transit and pickup slips. See Set in-
transit slip options.

Note:

When an item’s status changes to Transferred to fill a request, the in-
transit slip includes the text FOR HOLD. The text does not appear on in-
transit slips printed when an item is checked in and just needs to be
shipped back to its assigned branch.

In Polaris Administration, you also specify which printers are available for selection from
staff client workforms, and you can specify receipt printer control codes for printer
options such as bold type, in addition to the set of control codes that Polaris provides
for specific receipt printers. See Set receipt printer control codes.

Important:

You must also set up receipt or slip printing at each staff client
workstation that generates receipts or slips. See the Patron Services PDF
Guide, Setting Up Receipt Printing from Workforms.

Note:
Polaris also supports hold pickup and in-transit slips printed from Epson
ReStick printers. See Epson® ReStick™ Printers - Hold and In-Transit Slips.

Set check-out receipt options

Check-out receipts always display the library name, date/time, type of receipt, item titles,
and due dates. You can add any of the following information: call number (item); item
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bar code; item count (total number of items); library phone number; material type; patron
barcode (limited - last 5 digits of the patron barcode); patron name; staff record number
(unique identification number from the staff member record); Web address (library URL
defined in the organization record); any user-defined fields from the patron record.

To select additional information to appear on check-out receipts:

Note:

You can set these options on the system, library, or branch level. Your
settings affect receipts generated from the staff client and from Polaris
ExpressCheck, but do not affect offline check-out receipts. The offline
information is fixed and cannot be changed in Polaris Administration.

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Check-out: Receipt options. The Check-out Receipt Options dialog
box appears.

Check-out Receipt Options [COB (br): Community Library ] H

Settings defined at...

COB {br): Community Library

Select content to appear on...

Both printed and e-mail receipts: E-mail receipts {(additional):
Call number ”~ Indude Custom note from printed receipts
Item barcode Indude summary data
Ttem count
[ Library phone Prompt for eReceipt configuration in Leap
Material type
[] Patron barcode [limited] TXT receipts:
Fatron name Author
[] staff record number [ call number
[] web address Due date
[ 10 Number [] 1tem barcode
[ Privileges | Restrictions Material type
[] voter Registration w Title

Print receipts only with prompt

0K, Cancel Help
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3. Toinclude a field in the check-out receipt, select the field in the Both printed and
e-mail receipts list. User-defined fields are grouped together at the end of the list.

Note:
For more information about setting up eReceipts (e-mail and TXT
receipts), see Setting Up eReceipts.

4. To include additional information on e-mail receipts, select Include custom note
from printed receipts or Include summary data.

* Include custom note from printed receipts: allows you to type a custom
note. On the circulation workstation, select Circulation, Options from the
Polaris Shortcut Bar, and type the custom text in the Circulation Options dia-
log box - Receipt Printer Options tabbed page.

 Include summary data: automatically adds the following patron account
information:

o number of items currently checked out;

o number of open requests (the total number of Hold requests with a
status of Active, Inactive, or Pending, and the number of ILL requests
with a status of Active or Inactive);

° number of items (ILL or Hold) with a status of Held;
° total amount of unpaid charges.

5. To prompt for eReceipts when checking out in Leap, select Prompt for eReceipt
configuration in Leap. If this checkbox is selected, and you check out a patron in
Leap for whom eReceipts is set to None, the prompt appears and you can set up
eReceipts for the patron right from check out. For more information, see Leap
online Help.

6. If you want to print a receipt only when the patron requests one, select Print
receipts only with prompt. (If the option is not checked, no prompt is displayed
and the receipt is always printed when check-out receipts are enabled for the work-
form.) This option applies only to online staff client operations; a checkout receipt
with limited data is always printed during offline circulation.

Note:
You can enable e-mail or text message check-out receipts for patrons
who prefer these to printed receipts. See Setting Up eReceipts.

This option can reduce unnecessary printing. When the Check out receipt
option is checked on the workform Tools, Options menu and the option to
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prompt for the optional check-out receipt has been enabled for the
workstation branch, the prompt to print a receipt is displayed when the Enter
key is pressed to signal the end of the check-out transaction. The prompt to
print the receipt is displayed during the following processes: normal and
reserve item check out from the staff client Check Out workform; RFID check
out; media dispenser unit check out; offline check out.

Note:

The receipt prompt is not displayed for renewals from the Patron Status
workform - Items Out view. However, staff can optionally print a “receipt”
from this view by suppressing check-out receipt printing from the
workform Tools options, and then printing receipts on demand by printing
the Items Out list. (CTRL+ALT+P). You can specify the information
included in the printed version of the Items Out list. See Set Items Out
receipt options.

7. Click OK on the dialog box.

Important:

At each staff client workstation, you must enable the receipt from each
workform that generates the receipt. See the Patron Services PDF Guide,
Setting Up Receipt Printing from Workforms.

Related Information

» E-Receipts - Patrons can receive check-out and renewal receipts by e-mail or text
message. See Setting Up eReceipts.

» Custom note text - You can specify custom note text to appear on check-out,
Items Out, and fine receipts. For details, see the Patron Services PDF Guide, Set-
ting Up Receipt Printing from Workforms.

» You Saved message - You can add a “you saved” message to the check-out and/or
renewal receipt. The message helps to remind patrons of the value of library ser-
vice by displaying how much it would cost to purchase the items. For details, see
You Saved Receipt Messages.

» Bound-With receipts - See the Patron_Services PDF Guide, Notices, Slips, Receipts
and Other Data Displays.
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Set Items Out receipt options

Staff members can print a patron’s Items Out list from the Patron Status workform -
Items Out view. This “receipt” lists all the items a patron currently has checked out. The
header of the Items Out list always includes the library name and date/time. You can
include the following optional header data: author, call number, collection, due date, any
custom note set for printed receipts, item’s assigned branch, item barcode, item count,
library phone, material type, limited patron barcode, patron name, renewals left, title,
library Web address, and user-defined fields.

Note:

If you choose to print check-out receipts only when prompted (see Set.
check-out receipt options), the receipt prompt is not displayed for
renewals from the Patron Status workform - Items Out view. However,
staff can optionally print the Iltems Out “receipt” from this view by
suppressing check-out receipt printing from the workform Tools options,
and then printing receipts on demand by printing the Items Out list
(CTRL+ALT+P).

To select additional information to appear on the Items Out list:

Note:
You can set these options on the system, library, or branch level. The
system uses the settings for the workstation’s log-on branch.

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Items out receipt options. The Items Out Receipt Options dialog box
appears.
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Settings defined at...

COB (br): Community Library

Select content for the Items Out slip:

Author ~
[ call number |
[ collection |
Due date

[ tndude Custom note from printed receipts

[ 1tem assianed branch

Item barcode

Item count

Library phone

Material type

Patron barcode [limited]

Patron name w

oK Cancel Help

3. Toinclude a field in the Items Out receipt, select the field in the Select content list.
User-defined fields are grouped together at the end of the list.

4. Click OK.

Related Information

« Custom note text - You can specify custom note text to appear on check-out,
Items Out, and fine receipts. For details, see the Patron Services PDF Guide, Set-
ting Up Receipt Printing from Workforms.

» You Saved message - You can add a “you saved” message to the printed Items
Out list. The message helps to remind patrons of the value of library service by dis-
playing how much it would cost to purchase the items. For details, see You Saved
Receipt Messages.

Set check-in receipt options

Check-in receipts can be printed from the Check In workform - Normal view and Check
In workform - Bulk view. They include the item barcode, title, author, material type, call
number, and patron’s limited barcode. The following information fields are also
available for use: author, due date, item’s assigned branch, full patron barcode, patron
name, status. You can set these options on the system, library, or branch level.

Note:
The Check In workform list view can also be printed on a receipt printer.

To set the information that appears on check-in receipts:
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1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Check-in: Receipt options. The Check-in Receipt Options dialog box
appears.

- —
Chedi-n Redeipt Options |

3. Toinclude a field in the check-in receipt, select the field in the Options list and
click Add. The field is placed in the Selections list.

4. Toremove a field from the check-in receipt, select the field in the Selections list,
and click Remove. The field is placed in the Options list. To print check-in receipts,
at least one field must be listed in Selections.

5. Click Save on the dialog box.

Set fine receipt options

Fine receipts always display the library name, date/time, type of receipt, title, reason
(from the charge transaction), the amount paid or waived, and total charges. You can
add any of the following information: call number (associated item); item barcode;
material type; patron name; library phone number; Web address (library URL); patron
name; last 5 digits of the patron barcode; staff record number (unique identification
number from the staff member record); any user-defined field from the patron record;
transaction number (unique identifying number of the transaction). You can also set
Polaris to print duplicate fine receipts if your audit policies require them. To select
additional information to appear on fine receipts and enable duplicate receipts if
required.

Note:
You can set these options at the system, library, or branch level.
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1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Fine receipt options. The Fine Receipt Options dialog box appears.

r —
Fine Receipt Dptiors L _J

Sanm Carcal Hulp

3. To print a field on the fine receipt, select the field in the Options list and click Add.
The field is placed in the Selections list. (To remove a field from the fine receipt,
select the field in the Selections list, and click Remove. The field is placed in the
Options list.)

Note:

The options include any user-defined fields. If you add Suppress for
waived charges, the fine receipt is not printed for only a waived
transaction. However, if a transaction contains both payments and
waives, the receipt is printed regardless of this setting.

4. Click Save on the dialog box.

5. To enable duplicate printed fine receipts for the organization, set the Patron Ser-
vices parameter Fine receipts: Print duplicate receipt to Yes.

Note:

At each staff client workstation, you must enable the receipt from each
workform that generates the receipt. See Loading... this may take several
minutes to complete..

Related Information

» E-Receipts - Patrons can receive fine receipts by e-mail or text message. See Set-
ting Up eReceipts.
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Custom note text - You can specify custom note text to appear on check-out,
Items Out, and fine receipts. For details, see the Patron Services PDF Guide, Set-
ting Up Receipt Printing from Workforms.

Bound-With receipts - See the Patron_Services PDF Guide, Notices, Slips, Receipts
and Other Data Displays.

Set hold slip options

Hold slips always display pickup location, date the item was trapped for the hold, held
till (unclaimed) date, item title, item call number, item barcode, any display notes (in
bold), and item’s assigned branch. You can add any of these options to print on a hold

slip:

Patron name (if selected, this is printed in bold at the top of the slip)
Last 5 digits of the patron barcode (Limited patron barcode)
Patron phone (all phone numbers from the patron record)

Patron address (home address from the patron record if available, otherwise the
first available address in the patron record)

Notification method
Patron e-mail address
Any user-defined fields from the patron record

Note:
If you add any user-defined fields and enable hold call slips (see Enable
hold call slips), the fields you specified appear on the hold call slip.

The illustration shows an example.
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To select additional information to appear on hold slips.

Note:

You can set hold slip, hold call slip, and hold pickup slip parameters on the
system, library, or branch level. For details about these slips, see Setting
Up Circulation Receipts.

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Hold slip options. The Hold Slip Options dialog box appears.

Hold Shp Qphans

Conbenis. Seecion

3. To print additional fields on the hold slip, select the field in the Options list and
click Add. The field is placed in the Selections list. (To remove a field from the
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hold slip, select the field in the Selections list, and click Remove. The field is
placed in the Options list.)

4. Click Save on the dialog box.

Enable hold call slips

Hold call slips are specially-formatted hold slips that contain additional title information
for libraries that manually call patrons. For details, see Setting Up Printed Receipts. If
you enable hold call slips, from any specific workform, the hold slip, the hold call slip, or
the hold pickup slip can be selected as the default hold “receipt,” but not more than one
per workform.

To enable the hold call slip:
1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.
2. Double-click Holds call slip: enable, and select Yes.

Note:

If you specified user-defined fields for hold slips (see Set hold slip
options), these appear on the hold call slip. All the other fields are fixed
and cannot be customized in Polaris Administration.

The illustration shows an example.

3. Select File > Save.
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Hold pickup slips are formatted for libraries that allow patrons to pick up their own held
items. These slips require a line mode receipt printer.

At the System level, you can set options to combine the hold pickup and in-transit slips
or append hold call slip to the pickup slip.

To set up hold pickup slips:

Note:

Your settings for the holds pickup slip also apply to the equivalent ILL
pickup slip, which is printed when an interlibrary loan item is received.

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Hold pickup slip options. The Hold Pickup Slip Options dialog box

opens.

Held Pickup Slip Options
Options Contents Selection

[/] Enable Pickup Slip

Print options

—l Print full patron name |7 Print 3 ~ characters of patron last name
: = - o

[V]Print |5 »  digits of the patron barcode

[ Large print

Orientation Hold slips combined
) Horizontal
| Trailing blank | None
) Vertical " - Y . . " —
‘ 3 - ®) Combine hold pickup and in-transit slip

® Tag

) Append hold call slip to pickup slip

Save Cancel

Help

3. Select Enable Pickup Slip

4. Specify the patron identification to appear on the slip:

» Select Print full patron name to print the entire name in this format: Last
name (comma), First name (no comma) and Middle initial. Example: Smith

JohnT.

 Print x characters of patron last name, and set the number of characters to
print the name in this format: First x number of characters of the last name

(no comma) and the first initial of first name. Example: Smit J

If the control is set to print only 1 character of the last name, only the first
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character of the last name is printed, not the first or middle initial.

If you chose to include the patron’s name or limited

characters, it is printed in bold, large characters at the top of the slip. If you
do not check either option, no name appears on the slip.

Note:

Printer limitations restrict the name to approximately 38 characters,
depending on the width of the characters and the printer model.
Very long names may be cut off even if you specified the full patron
name. If you set the number of characters to 1, only the first
character of the last name is printed.

» Toinclude a patron barcode on the slip, select Print x digits of the patron
barcode, and specify the number of digits to print, counting to the left from
the last digit of the barcode.

Note:

Print x digits of the patron barcode must be selected (checked) at
the pickup branch to allow for the patron’s barcode to print on the
slip. See Set in-transit slip options.

» To print the barcode in large print, select Large print.
5. Select a printing orientation for the slip:
 Horizontal (default) - The hold pickup slip is inserted in the material, expos-
ing the patron name and pickup date. The material is shelved so that the slip
extends horizontally from the material.

» Vertical - The hold pickup slip is a wrapper that is typically taped to the spine
of the material. The pickup date is printed horizontally at the top and the pat-
ron’s name is printed vertically down the slip. Any additional content is prin-
ted in small type under the pickup date.

» Tag - The hold pickup slip is inserted into the material. When the slip is inser-
ted, the patron name and pickup date are exposed at the top of the slip, prin-
ted horizontally, and the “tail” of the slip is inside the material. The material is
shelved so that the slip extends above the material. Any additional content is
printed in small type under the item barcode.

6. Select a number in the Trailing blank spin control to specify the number of blank
lines to insert on the right side or horizontal slips or the bottom of vertical slips.
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7. Under Hold slips combined, select one of the following options:

» None - This is the default. Hold slips are not combined.

» Combine hold pickup and in-transit slip - When this option is selected at the
System level, hold pickup and in-transit slips are combined.

» Append hold call slip to pickup slip - When this option is selected at the Sys-
tem level, check the Append call slip checkbox. The option will be selected
for all organizations in the system, but it can be unchecked.

8. To print additional fields on the hold pickup slip, click the Contents Selection tab.
The Contents Selection tab displays the available options in the left column of the
dialog box, and the selected options in the right column.

Hold Pickup Slip Options

Options Contents Selection

Options: Selections:

[tem barcode

last 4 digits of patron phone
Title

Pickup branch abbreviation
Unclaimed date

9. To add a field to be printed on hold pickup slips, select it in the Options column
and click Add to add it to the Selections column. To remove a field, select it in the
Selections column and click Remove.
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« last 4 digits of patron phone - You can add the last four digits of the patron’s
phone number after the patron’s name, in the same large font. The system
uses the last four consecutive numeric characters of the Phone 1 field in the
patron record. If this field is blank, or if four consecutive numeric characters
cannot be found, no number is printed.

Examples:

315 634-4512 ext 123

634-4512 WORK

In both cases, the system sees alpha characters in the last 4
characters and moves left until it identifies 4 consecutive numbers.
The slip will print 4512.

634-4512 ex 1234
The system identifies and prints 1234 because there are 4
consecutive numbers.

451 ex.123
The system cannot identify 4 consecutive numbers. No numbers will
be printed on the slip.

» Pickup branch abbreviation - When selected, the pickup branch abbreviation
is printed on all holds pickup slips, and on combination in-transit/holds
pickup slips, regardless of format, at the top of the slip. On horizontal slips,
the branch abbreviation is printed above the patron name in bold capital let-
ters the same font size as the date. On vertical slips, it is printed above the
“Pickup by” date, also in bold capital letters the same size as the date. On tag
slips, it is printed above the patron name in the same size font as the “Pickup
by” date.

» Title - When selected, the title is printed on the hold pickup slips.
 Item barcode - The full item barcode is printed.

Note:

Libraries that process items for holds centrally, sorting held items by
pickup branch, may want to select the pickup branch abbreviation
option to print at the top of the holds pickup slip for ease in sorting.
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« Unclaimed date - The Unclaimed date is the date to pull the item from the
shelf if it has not been picked up. The date is based on a time period defined
by the pickup branch.

Note:

If your library is using a combined in-transit/hold pickup slip, this
date is not available because the slip is printed when the item goes
in-transit.

10. Click OK on the dialog box. The Administration Explorer (Parameters - Patron Ser-
vices) appears.

Note:

At each staff client workstation, you must enable the slip from each
workform that generates the slip. See the Patron Services PDF
Guide, Setting Up Receipt Printing from Workforms.

Set In-Transit Slip Options

When a library uses a combined in-transit slip, the library’s in-transit settings determine
how information displays on the slip. For example, when an item is scanned at the
original library, a combined slip prints containing the pickup branch name and the library
name, in a format set per the original library’s in-transit settings. The patron name and
other contents for the pickup slip are determined per the pickup branch’s setting.

To set information options for in-transit, in-transit for hold slips, or combination in-
transit and pickup slips:
1. Inthe Administration Explorer tree view, open the Parameters folder for the
organization, and select the Patron Services tabbed page in the details view.
2. Double-click In-transit slip options. The In-Transit Slip Options dialog box opens.
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In-Transit Slip Options [Cammunﬂ...n

| Coemitine [n-traes it ond pickup Sip
| Prirt patron nama an In-transe-hold ship
Frirk petron barmode on In-transit-hold skp
Library rams
|1 Frit ibrary Full name

[ Frint library sbrevistion

Bramd reaims
(8] Frint branch full name

i Frint branch abbresiation

Humber of traling bank lines; | 5

ak | Conesl Halp

. Toinclude a requesting patron’s name on the slip, select Print patron name on In-
transit-hold slip.

. Toinclude a requesting patron’s barcode on the in-transit for hold slip, select Print
patron barcode on In-transit-hold slip.

Note:

For the patron’s barcode to display on the in-transit for hold slip, the
pickup branch must have Print x digits of the patron barcode selected in
Hold Pickup Slip Options. See Set hold slip options.

. (Optional) Select Print library full name, Print library abbreviation, or both to print
the parent library of the destination branch. These options apply to all in-transit
slips.

. For the destination branch name, select Print branch full name or Print branch
abbreviation. This option applies to all in-transit slips. You must select one option.

. To control the length of the in-transit slip, select or type the number (0-999) of trail-
ing blank lines to add to the slip.

. Click OK.

Note:

At each staff client workstation, you must enable the slip from each
workform that generates the slip. See the Patron Services PDF Guide,
Setting Up Receipt Printing from Workforms.
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ips only for holds - Search Polaris help for "Set the workstation to

print receipts and slips."

Set receipt printer control codes

To enable large print, bold print, red print, underlining, auto-cutting, or cash drawer for

standard receipt pri

Note:

nters, or to add other kinds of receipt printers to your system:

Install the appropriate printer drivers on the staff client workstations that
use receipt printers.

1. Inthe Administration Explorer tree view, open the Profiles folder at the system
level, and select the Staff Client tabbed page in the details view.

2. Double-click Receipt printer control codes. The Receipt Printer Control Codes dia-
log box appears.

e

Drivers:

Receipt Printer Control Codes ﬂ

Descrption

Epesan (legacy)

Epson TRASE-BY
Epmon THAE8-1S
G Degacy)
MCR 7167
MCR 7163

Sear TER145
Star TSPE13
Ssar TSPE43
Sear TSOEN)
Shar TSFTI0

» e

Epmon T manes
EPSOM TH-T20 RecmiptES

Sear DPEIHD [legecy)

Sear TEFTO0 HAC

Saloctod

[ (4] o] &) [ [4] &

4

Ed
-

Conirol Code Enabied Sinr {%hhdbh.. ] End {Shh3hin.. }
Pt couthesr % EHEA %32

"
Cash dravesr d %170 % 18%0
Emphasized print ik = % iEdS wibsds
Exmended (ariamgad ¥ HIEREI%IEDT | HIE%EIRINNEID
Rad chesscsar [rad
Uncharbrdng
S Clo=s Help
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. If you use receipt printers already listed in the Drivers list, To set optional features
for them:

Note:
Repeat these steps for each printer in your system.

. Select the printer in the Drivers list.

. Select the checkbox for each feature (such as expanded, bold, red, auto-cut, cash
drawer) you want to enable for that printer.

A specific printer may not support all these features. If a feature is not
supported, the Start and End code fields are blank.

Note:

The Expanded setting affects in-transit and hold slips. On the in-transit
slip, the destination branch’s name is printed in a font that is twice as
large as the font on the rest of the slip. On the hold slip, the patron’s name
and the unclaimed date are printed in the large font. Although you set this
option for specific receipt printers, if you choose to print these slips on a
page printer, the font is also enlarged.

. To list the printer for selection in Polaris workforms, be sure the Selected option is
checked.

. Click Save.

. To add a receipt printer and enable special features for it, follow these steps:

Note:
You can add more than one printer. Repeat these steps for each printer
you want to add.

. Scroll the Drivers list to the last blank field, which is marked by an asterisk.
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Dreers

Diescriplion Salectad  *
EFSOM TW-TZD RecaiplE4
Epson TM3E-N

Epsom THM3E-Y

ORI [legacy)

MCR H1E7

MCRA 7158

Saar DFEI0 (egacy)

Shar TSP143

Sear TSPE13

Sear TSP

Sxar TEPEED

Star TEPTO

Saar TSPTDD NAG

Star TSPTOM (TSPT430)

Sxar TSET430
#
L

Controd Code Enabied Start {%hhhbh. ] End {%hh%hh
% IEHRE 52

% 1E%AD %1B8%0

H1E%45 %18%48

% 1E%EI%I1%31 %1B%6E% 30%30

< [ [&] [ <)<

<

% ®|=(=

Cash drawer

Emphemized peml (b
Expanded {enlangad
i charsctar [rad

Linsderirig

&[] 4] %

S Clcse Help

Select the blank field and type the printer name in the field.
Click Save.

Select your printer in the Drivers list, and select the checkbox for each feature you
want to enable. Your printer may not support all features.

For each enabled feature, select the Start and End code fields, and type the appro-
priate codes in the format shown.

See your printer documentation for the correct codes. Some models may require
only a start code for some features.

Note:

If you select Cash drawer, the receipt printer must be connected to a cash
drawer via an RJ11 connector that signals the cash drawer to open
automatically when a receipt is printed. You can also set a staff client
profile at the system, library, or branch level to open the cash drawer when
a receipt is printed only if the payment was a cash payment. See Set
option to open the cash drawer only for cash fine receipts.
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f. To list the printer for selection in Polaris workforms, select the Selected option.
g. Click Save.

5. To suppress an unused printer from the receipt printer list in Polaris workforms,
clear (uncheck) the Selected checkbox for the printer.

If you change multiple printers, you must click Save after each printer change.
6. Click Close.

Set option to open the cash drawer only for cash fine receipts

The receipt printer must be set up in Polaris Administration at the system level to open
the cash drawer automatically when a receipt is printed. See Set receipt printer control
codes. You can set an additional option at the system, library, or branch level that opens
the cash drawer only when a fine receipt is printed and the payment method is cash,
check, collection agency, or voucher. Fine receipts are still printed for credit card
payments, but the cash drawer does not open.

To set the option to open the cash drawer only when fine receipts are printed for cash
payments:

1. In the Administration Explorer tree view, open the Profiles folder at the system, lib-
rary, or branch level, and select the Staff Client tabbed page in the details view.

2. Double-click Receipts: Cash drawer opens for cash payments only, and select
Yes. The default is No.

Anquisitions [ Serials Fatran Sendces Cataloging PaC FonerPAC
Children's PAC Staff Cliert Mabile FAC Community
e ] e
Profile Value o
ﬂLahels: Lerial label type Serial Sheets
mL abels: Serial print method Batch
BB Library documentation - staff client
IILI:I';'.BI'.". seltings between the Cient and server must .. Yes
mCIn ine documents location InformationPolDocindhtm
mPe*rriisiani: Use Polaris-defined new permission de... Yes
PHPraxy server Setup ...
EARersipt printer rantenl creipg Setip
.
< ¥

If the receipt printer is set up to open the cash drawer automatically when a
payment is made, and the Receipts: Cash drawer opens for cash payments only
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is set to Yes for the organization at which the payment is made, the cash drawer
will open only for the following types of payments:

e Cash

» Check

» Voucher

» Collection Agency

Epson® ReStick™ Printers - Hold and In-Transit Slips

Polaris can export hold pickup slip (“wrapper”) and in-transit slip data to Epson ReStick
printers using the Epson Intelligent Label Service (ILS). This software allows the user to
configure printed receipt formatting (font, orientation, data printed, etc.). It also allows
the library to direct output to one or more specified printers. To support the integration,
Polaris receipt output for these types of slips is converted to ANSI RAW instead of
Unicode RAW, a header is added to the slip, and each data element is labeled for use by
the Epson ILS. (The data labels are not printed.)

Note:

If the option to use the Epson ILS is selected, the Polaris Administration
configuration options for in-transit and hold pick-up slips do not affect the
Epson ReStick printer output. All other receipts are printed according to
the configuration options set in Polaris Administration.

To enable receipt data export to the Epson ILS in Polaris Administration, set the Staff
Client profile Receipts: Support Epson ILS to Yes. The profile is available at the system,
library, branch, and workstation levels. When the profile is set to Yes for the workstation,
only hold pick-up and in-transit slips are printed on the Epson ReStick printer. All other
receipts (such as check-out receipts) are directed to other, non-ReStick printers, and are
printed according to the configuration options set in Polaris Administration (see Setting
Up Printed Receipts). If the profile is set to Yes but a different printer is chosen for the
workstation, all circulation receipts and slips can be printed according to the
configuration options set in Polaris Administration. However, hold and in-transit receipts
will print the headers as they have been configured for Epson ILS, for example, +++---
Hold---+++. See below. The header cannot be edited in Polaris.

Note:
When the profile is set to No, no slips can be printed on the Epson ReStick
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printer. All circulation receipts and slips can be printed on other types of
printers according to the configuration options set in Polaris
Administration. See Setting Up Printed Receipts.

When the profile is set to Yes and a hold wrapper or in-transit slip is printed, all the data
associated with the receipt is sent to the Epson ILS, which configures which data prints,
font, format, and orientation.

Note:
CJK, Arabic and other non-Western characters are not printed correctly.

For hold pickup slips, the following data is exported to the Epson ILS:

Note:
The Epson ILS controls which data is actually printed.

o Header text: +++---HOLD---+++ [cannot be edited]
» Data field labels:

* Name - The patron name, Last, First MI. Referred to as User Name by the Epson
ILS.

e Lib - Lib abbreviation

» Phone - Last 4 digits of patron phone

» Patron barcode - Patron barcode

» Pick-up by - Pickup date. Format: mm/dd/yyyy
 Item barcode - Item barcode

o Title - Item title

For in-transit slips, the following data is exported to the Epson ILS:

Note:
The Epson ILS controls which data is actually printed.

e Header text - +++---IN-TRANSIT+++--- [cannot be edited]

» Data field labels:

» Name - The patron name, Last, First Ml

» Pbarcode - Patron barcode

o LibraryName - Library name. Referred to as Location by some Epson clients.
 LibraryAbbrev - Library abbreviation
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« BranchName - location [lower case is required]

« BranchAbbrev - location [lower case is required]

e From - Library name or abbreviation

» Hold for

o Title

» Material type

» Call number

 Item Barcode

» Assigned Branch
The following options for Polaris receipts do not apply to data exported to the Epson
ILS:

 Trailing blank lines

e Orientation

e Large print
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You can send eReceipts (e-mail and/or text message receipts) to patrons who prefer
either of these options. They can be sent to patrons for check-outs, renewals, and paid
fines from the staff client or Leap; renewals from PAC; check-out and renewals from
Polaris ExpressCheck; and renewals from Polaris Phone Attendant (inbound telephony).
No overnight processing is required, so these receipts are sent within a few moments of
the transaction. All eReceipts are sent in plain text format. One checked out or renewed
item is listed per text message (TXT) receipt to limit the length of the message.

Note:
eReceipts are not sent for offline staff client transactions.

To set up eReceipts to be sent to patrons in email or text message:

» Enable eReceipts and specify their content in Polaris Administration - eReceipts
must be enabled for a patron's branch in order to select the eReceipt option in the
Patron Registration workform.

» Select the eReceipt option on the Patron Registration workform > Addresses view
(also available in Leap) for patrons who prefer to receive eReceipts.

Patron Record Settings for eReceipts

Staff members set the eReceipt option on the Patron Registration workform -
Addresses view to specify the patron’s preference for e-mail receipts, TXT message
receipts, or both (All). The option is available if eReceipts have been enabled for the
patron’s branch.

You can set these options as default selections for normal and express patron
registration. For more information about setting registration default values, see Setting
Patron Registration Required Fields and Defaults and Setting Express Registration
Defaults and Requirements.

If a patron record specifies eReceipts, you can also choose to include the setting in the
optional patron data that is displayed in the header area of the Check Out and Patron

© 2023 Innovative (Part of Clarivate)
Page 187



Patron Services Administration Guide

Status workforms. For more information about selecting data to be displayed in these
header areas, see Setting Up the Check Out Workform.

Leap and eReceipt Settings

When eReceipts are enabled for the branch and the patron receives only eReceipts, an
alert appears in Leap when checking in, checking out or paying fines so that staff know
not to wait for a printed receipt.

When staff enter a fine payment in Leap, the following message appears if the patron
receives only eReceipts: EReceipt submitted for fine payment.

When checking out an item to a patron in Leap, the following message appears if the
patron receives only eReceipts: EReceipt submitted for check out/renewal.

Prompt for eReceipts in Leap

You can set an eReceipt prompt to appear in Leap when checking out items to patrons
whose eReceipt option is set to None in the Patron Record > Notification options. The
prompt also includes an option to enable eReceipts for the patron.

The eReceipt prompt, Would you like to configure this patron to receive an eReceipt for
this and future check-outs? appears in Leap when:

» email or text message receipts have been enabled in the EReceipt options patron
services parameter for the patron's registered branch and the Leap login branch;

» the Prompt for eReceipt configuration in Leap checkbox is selected in the Check-
Out Receipt Options patron services parameter for the Leap login branch;

» and None is selected for the eReceipt option in the Patron Registration > Noti-
fication Settings in Leap.

Fine eReceipts

Patrons receive e-mail or TXT receipts for fine payments if eReceipt options have been
enabled for both the transacting workstation’s branch and the patron’s branch, and the
patron record is set to receive e-mail receipts, TXT receipts, or both.

Note:
EReceipt features do not apply to credit card payments because e-mail
receipts are sent for these payments as a separate process.
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Staff members can print a fine receipt even if the patron receives an eReceipt. The
Tools, Options menu on any workform where staff members can take fine payments
offers a fine receipt option: only if no eReceipt.

When eReceipts are enabled and Fine receipt is checked in the Options dialog box, the
option only if no eReceipt is available. If the option is not checked, printed receipts are
produced in addition to eReceipts for patrons who have opted to receive eReceipts. If
only if no eReceipt is checked, fine receipts are printed only when the patron does not
receive eReceipts.

Note:

The Options dialog box settings affect fine receipt printing only. A patron
who has opted to receive eReceipts will always receive eReceipts for
fines, regardless of these settings. For more information about setting up
workstations for receipt printing, see the Patron Services PDF Guide,
Setting Up Receipt Printing from Workforms.

Waive eReceipts

An eReceipt is sent for waived charges if all the conditions for sending a fine eReceipt
are met, and if the Suppress for waived charges option (Patron Services parameter -
Fine receipt options) is not selected for the workstation’s branch. A receipt for waives is
printed in addition to the eReceipt if all the conditions for printing a fine receipt are met
(see Fine eReceipts) and if the Suppress for waived charges option is not selected for
the workstation branch.

eReceipt Options in Polaris PowerPAC and Mobile PAC

If the patron’s registered branch has enabled eReceipts (see Set up eReceipts), that
organization can also offer the option to receive e-mail receipts, TXT receipts, or both in
patron self-registration or account updates from PAC. To enable eReceipt preference
options in PAC, use the PAC profile Patron eReceipts, available at the system, library, or
branch level.

In the PAC, the patron can then select e-mail receipts, TXT receipts, or both, as enabled
by the registered branch. The patron will receive eReceipts for renewals from PowerPAC
and Mobile PAC if this option has been enabled for the patron’s registered branch (see
Set up eReceipts), and check-out and fine eReceipts if both the check-out branch and
the patron’s branch have enabled eReceipts.

Important:
The eReceipt options are available for patron account updates from PAC
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only if you also allow patrons to update the e-mail address or phone
number from PAC. These settings are available in the PAC profile Patron
access options. For details, see You Saved Receipt Messages.

Editing eReceipt Content in Polaris Language Editor (WebAdmin)

Your settings for the check-out branch determine the content of e-mail receipts and TXT
receipts. For e-mail receipts, the From field is determined by the PAC profile Email
notification: Email address of sender. The subject line, introduction, and footer text can
be modified in Polaris WebAdmin (Language Editor). For TXT receipts, the subject line
and footer text can be modified in Polaris WebAdmin.

Note:

Use the Patron Services parameter Check out receipt options to specify
the optional additional data fields for e-mail receipts and TXT receipts.
See Set up eReceipts.

Polaris WebAdmin includes a Receipts “product.” Select this product to edit the content
of e-mail and TXT receipts.

Langsiage Dpticas

Orgarization: Syetern L0-H1a10 4.7 Clueter Teet Syefem

Language 1 Englizh - Linted States -
Language & Englizh - Unitesd States "
Limait Optiars

Spadhic sining I:

Cirmg conksing:

DOy shaw orstomized sirngs

Load Strirgs

The table lists the string IDs. For more information about using Polaris WebAdmin, see
WebAdmin online Help.

Mnemonic (String

Receipt Type ID) Default Text Context
E-Mail Check-Out RECEIPT_ Checked-out from | Subject
Receipts CHECKOUT_ your library

EMAIL_SUBJECT
RECEIPT_ The following Introduction
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Receipt Type

Mnemonic (String

ID)

CHECKOUT_
EMAIL_INTRO

Default Text

items were
checked out by
you on [DATE]
from [BRANCH]

Context

RENEWAL_EMAIL_
INTRO

[DATE].

RECEIPT_EMAIL_ Please do not Footer
FOOTER reply to this
message.
E-Mail Renewal RECEIPT_ You renewed Subject
Receipts RENEWAL_EMAIL_ | library items
SUBJECT
RECEIPT_ Items renewed on | Introduction

Text Message RECEIPT_ Checked-out from | Subject
Check-Out CHECKOUT_TXT_ | your library
Receipts SUBJECT
RECEIPT_TXT_ Access your library | Footer
FOOTER account for
additional
information.
Text Message RECEIPT_ You renewed Subject
Renewal Receipts | RENEWAL_TXT_ library item
SUBJECT

You Saved Messages in eReceipts

You can add a “you saved” message to check-out and/or renewal eReceipts. The
message helps to remind patrons of the value of library service by displaying how much
it would cost to purchase the items. For details, see You Saved Receipt Messages.
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Logging eReceipts and Reporting Failures

E-mail and TXT receipt messages are logged in the Polaris Transactions database, and
failures are included in the Receipt delivery failure report. To access this report, select
Utilities, Reports and Notices from the Polaris Shortcut bar, and open the

Circulation folder in the Polaris Reports window. For a specified time period and
organizations (sending branches), the report lists the transactions where an e-mail or
TXT receipt failed to be sent for a check-out or renew transaction. For more information,
see Circulation Reports.

Enable eReceipts and specify their content
To enable eReceipts and specify their content:

1. Confirm that the following e-mail prerequisites are set up for the organization:

 In Polaris Administration, set the PAC profile Email notification: Server run-
ning SMTP service for the organization. Use the computer name where the
SMTP service is installed.

» Set up reverse DNS in Active Directory for your network. Reverse DNS is used
to authenticate a sender’s address with the domain. This step helps ensure
your patrons will receive their e-mail receipts. As a security measure, certain
Internet service providers block e-mail to their users if they cannot find the
sending server.

Note:
These settings are also necessary for e-mail notification. See
Delivering Notices By E-mail.

2. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view. The para-
meter is available at the system, library, or branch level.

3. Double-click EReceipt options. The EReceipt Options dialog box opens.

4. Check Enable e-mail receipts, Enable TXT receipts, or both. When at least one
option is selected for the patron’s branch, you can select the eReceipt option in the

Patron Registration workform.

Note:
eReceipts must be enabled for both the patron’s branch and the
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check-out (log-on) branch in order for the patron to receive the
check-out eReceipt.

5. To enable renewal eReceipts from PAC, check Send receipts for renewal from
PAC. For more information about eReceipt options in PAC, see eReceipt Options in

Polaris PowerPAC and Mobile PAC.
6. Click OK.
7. Set the optional content for eReceipts:

Note:
Your settings for the check-out branch determine the content of e-
mail receipts and TXT receipts.

8. Double-click the Patron Services parameter Check out receipt options. The Check-
out Receipt Options dialog box opens. Options checked in the left column apply to
both printed and e-mail receipts. See also: Set check-out receipt options.

9. If you want to include additional content for e-mail receipts, select Include Custom
note from printed receipts or Include summary data in the E-Mail receipts (addi-
tional) list. The custom receipt note is set up on the circulation workstation, from
the Polaris Shortcut bar.

¢ Include custom note from printed receipts: allows you to type a custom
note. On the circulation workstation, select Circulation, Options from the
Polaris Shortcut Bar, and type the custom text in the Circulation Options dia-
log box - Receipt Printer Options tabbed page.

 Include summary data: automatically adds the following patron account
information:

o number of items currently checked out;

o number of open requests (the total number of Hold requests with a
status of Active, Inactive, or Pending, and the number of ILL requests
with a status of Active or Inactive);

o number of items (ILL or Hold) with a status of Held;
° total amount of unpaid charges.

10. Inthe TXT receipts list, check the content options for the TXT receipt. Because
text messages must be brief, the set of content options for TXT receipts is sep-
arate and more limited than the content options for printed and e-mail receipts.
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Note:

Subject, introduction, and footer text for eReceipts can be
customized in Polaris Language Editor (WebAdmin). See Patron
Record Settings for eReceipts.

11. Click OK.

Related Information

» Polaris ExpressCheck eReceipts for check out and renewal - Use the SelfCheck
Unit parameter Polaris ExpressCheck: Options. Check the Enable
eReceipts option. Once this option is checked, the patron will receive eReceipts if
both the patron’s branch and the ExpressCheck workstation’s branch have
enabled eReceipts in the EReceipt options parameter, and an eReceipt option is
set in the patron’s record. The eReceipt is sent when the patron selects Exit in
Polaris ExpressCheck.

» Printed receipts - See Setting Up Printed Receipts.

» Bound-With receipts - See the Patron_Services PDF Guide, Notices, Slips, Receipts
and Other Data Displays.
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You can add a “you saved” message to printed and email check-out/renewal receipts
and the printed Items Out list. The message helps to remind patrons of the value of
library service by displaying how much it would cost to purchase the items. It includes
the total value of the current receipt transactions, the value of the patron's year-to-date
transactions, and the “lifetime” value of all the patron’s transactions.

The value for each item is calculated based on the retail price stored in the item record.
If the item doesn't have a price, you can opt to use the Replacement Fee default value
for that material type. You can also choose to suppress the message if the value is
below a specified dollar amount.

Note:
The You Saved message option does not apply to text message receipts,
and it cannot be activated or suppressed for individual patrons.

« Staff client - When the You Saved message is implemented at the check-out work-
station branch, the value is calculated for all items, regardless of item or patron
branch. The message is included on check-out receipts generated from the staff
client Check Out workform and (if the branch has opted to include renewals in the
calculation) renewals from the Patron Status workform. If the organization has
opted to print the message on the Items Out slip, the message also appears when
the Items Out slip is printed from the Patron Status Items Out list view.

» Leap - When the logged-on user's branch has implemented the You Saved mes-
sage, the message is included on receipts generated from the Leap Check Out
workform (check out or renewal) and from the patron Items Out view (renewal).

» Polaris PowerPAC and Mobile PAC - Settings for the patron’s registered branch
control whether the You Saved message appears on email receipts for items
renewed from PAC. To enable the message on email receipts for items renewed
from PAC, check Send receipts for renewal from PAC in the Patron Services para-
meter EReceipt options, then enable You Saved receipt messages (see Set up You
Saved receipt messages).
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» Polaris ExpressCheck - When the You Saved message is implemented at the
ExpressCheck workstation's parent branch, the value is calculated for all items,
regardless of item or patron branch. If the ExpressCheck station is configured to
print one receipt per item (Parameters > SelfCheck unit > Polaris ExpressCheck
Options), then only one item will be included in the receipt tally.

» SIP Self-Check Units - You can include the You Saved message on printer mes-
sages, screen messages, or both. The message is added to the existing check-out
and renewal messages (if you have opted to include the message for renewals).
The system uses the settings of the organization associated with the self-check
unit's SIP Service Port.

See also:

o Customizing the You Saved Message

Year-To-Date and Lifetime Savings in the Patron Record

Processing the Year-to-Date Amount

Set up You Saved receipt messages

Patron Services PDF Guide, Set SIP self-check parameters topic

Customizing the You Saved Message

The default You saved message is You just saved [Value] by using your library. You
have saved [YTDValue] this past year and [LifetimeValue] since you began using the
library! Use Polaris Language Editor (WebAdmin) to customize the You Saved message.
Select the Receipts “product.” The message mnemonic is RECEIPT_YOUSAVED. To
include monetary values, do not edit the text in backets. The message is truncated to
255 characters. For more information about editing messages, see WebAdmin online
help.

Year-To-Date and Lifetime Savings in the Patron Record

Year-to-date and lifetime savings values are available in the Polaris staff client patron
record properties sheet. In the staff client, select the Properties icon or press F8 on the
Patron Registration or Patron Status workform to view the patron record properties
sheet.

In Leap, year-to-date and lifetime savings values are available in the Misc. Info section
of the patron record.
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Processing the Year-to-Date Amount

Previous year-to-date values are saved in the PrevYearYouSavedAmount table, which is
populated when the circulation year-end rollover job runs. Table columns include
PatronlID (int) and YTDYouSavedAmount (money). The Circ_YearEndCircCountRollover
job script rolls over the new YTDYouSavedAmount field from the patron record into the
PrevYearYouSavedAmount table and then zeroes out the YTDYouSavedAmount value in
the patron record.

Set up You Saved receipt messages

To set up You Saved receipt messages:

1.

In the Administration Explorer tree view, open the Parameters folder for the organ-
ization (system, library, or branch), and click the Patron Services tab in the details
view.

. Double-click You Saved Receipt Options. The You Saved Receipt Options dialog

box opens.

. Select Include message on printed and e-mail receipts to add the You Saved mes-

sage to these checkout receipts.

Select Include message on Items Out slip to add the You Saved message to the
Items Out list (printed from the Patron Status workform and from Leap patron
ltems Out view).

(System level only) Select Use default replacement fee when item price is unavail-
able to use this value for items with no price in the item record. (Default replace-
ment fees are set with the Patron Services parameter Replacement fee options.) If
you leave this option unchecked and the item record does not include a price, the
item is not included in the You Saved calculation.

(System level lonly) Select Include renewals in total value to include the value of
renewed items in the You Saved calculation.

. If you want to set a minimum You Saved value to trigger the You Saved message,

enter the value in the Minimum total value to print box. If the value is below the
minimum setting or the sum is 0, no message appears. The default value is $0.01;
in this case, the receipt includes the You Saved message regardless of the cal-
culated You Saved amount.

Click OK.
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Related Information

» You Saved message overview - You Saved Receipt Messages

» You Saved message for SIP self-check receipts - Set SIP self-check parameters
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Item Record Circulation Settings

Circulation settings for item records are controlled by a Polaris Administration policy
table, database table, and patron services parameters. The Material Types policy table
defines standard descriptions and the banner text displayed in Leap for specific items
held by the library; the Circulation Statuses database table defines standard labels for
item circulation statuses; the Shelving status options parameter controls an option to
display a temporary shelving status; and the Last use patron display parameter controls
whether to display a link to the last patron who checked out the item.

In addition, if your library uses NCIP, you should map item material types to the NCIP
medium types defined by the NCIP standard. Search Polaris help for "Mapping NCIP
Data to Polaris Data."

For more information about items that can float from one branch to another, see Setting
Up Floating Collections.

See also:

o Defining Material Types
» Viewing Circulation Statuses and Editing Descriptions

» Setting Shelving Status

» Displaying an Iltem’s Last Borrower
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Names for the various material types held by the library are defined in the Material
Types policy table. Material types are key elements in determining loan periods, lending
limit blocks, and hold policies, and in generating statistics. They are displayed in the
following locations:

« In the Material type list box on the Item Record workform, the Serial Holdings
Record workform, the Selection List Line Iltem workform, the Purchase Order Line
I[tem workform, and the Invoice Line item workform

 Inthe PAC availability information for each item associated with a title
» As search limiting options in the staff client Find Tool and the PAC

The same entries are displayed for every organization level at which the Material Types
table is opened. Material types can be set from the system, library, and branch levels,
but additions and changes are applied to all organizations. You cannot delete a material
type from the table in Polaris Administration. The system administrator can change the
Material Types table using the Query Analyzer in SQL Server.

The Material Types table is displayed from the Administration Explorer only. You cannot
access the Material Types table from an organization workform.

Note:

These System Administration permissions are required to modify the
Material Types policy table: Access administration: Allow, Access tables:
Allow, Modify material types table: Allow.

See: Add a material type entry.

Add a material type entry
To add a material type to the Material Types policy table:

Important:
The new material type is available to all organizations.
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1. Inthe Administration Explorer tree view, open the Policy Tables folder for the

organization, and select Material Types.

Tip:

To see the material type code, expand the first column by dragging the

column header separator to the right.

The Material Types table appears in the details view.

Material Types

.. Description

& Book

& MNew / Popular Book
o Video

&% Children's Video
a4 Audiobook

é Music

& Pericdical

é Rental

é Software

& Kit - Audiovisual
& Kit - Realia

,& Equipment

ah Art

& Picture, Photo

& Kellie Rental Score
& Kellie Rental Manuscript
&b Kellie R-Rated Realia
&% Vertical File Material
&h Map

&% Book and CD

é Museum Pass

é Test Material Type 1

é eBook

2. Click — to add a material type.

The Insert Material Types dialog box appears.

Insert : Material Types

Description ||

Cancel Help

3. Type the text describing the material type in the Description box.
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This text will be displayed in the staff client and in PAC.

4. Click OK on the dialog box. The new entry is added to the table, and the status bar
indicates the modification is pending.

5. Select File > Save.

The status bar indicates the record is saved.

Related Information

* Modify a table entry - Select the existing material type entry and click )
Changes affect all organizations and records using the original entry.

» Material type for quick-circ items - Using Polaris Quick-Circ, you can circulate
items that are not intended for full cataloging and generate circulation statistics
for these items. Your policy may be to use any available and appropriate material
type for quick-circ items, or you can set up a material type specifically for this use.
See Add a not-supplied reasons entry. To set a default material type for quick-circ
item records, double-click the Patron Services parameter Quick-circ: Material
type, and select a material type from the list. For more information about creating
and using quick-circ items, see the Patron Services PDF Guide, Circulating Ephem-
eral Items.
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One common set of circulation statuses is used in item transactions from any branch in
the system. The Circulation Statuses database table, available only from the
Administration Explorer, identifies the standard names for item circulation statuses.

Although the circulation status entries are owned by the system level, you can view the
table and modify the status descriptions from any level. If your library uses the Polaris
Web application, Leap, you can also define circulation status text to appear on a banner
on the bottom of the book jacket image on the Item Record workform in Leap.

The Circulation Statuses table is set up during Polaris implementation, conversion, and
site installation. All organizations in a Polaris installation must agree on the circulation
statuses to use. You can view circulation status names, edit descriptions, and define
banner text for Leap, but you cannot add or delete entries.

Note:
These System Administration permissions are required to view this table:
Access administration: Allow, Access tables: Allow.

Circulation statuses are displayed in the following locations in the Polaris staff client:

¢ In the Circulation status box on the Item Record workform

» As selections in the For and Limit by boxes on the Polaris Find Tool when you
search for items

 In the PAC availability information for each item associated with a title, if you
choose to display detailed item statuses (see the Public Access Administration
PDF Guide, Set up the local/system item availability display ).

Default Circulation Statuses
The default circulation statuses are:

e In-The item is on the shelf and available for circulation.
e Qut - The item has been checked out and is in circulation.
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Held - The item was requested by a patron while it was in circulation. When the
item returned it was “trapped for hold” and set aside for the requestor. The item
status is Held until the requestor retrieves the item for check-out.

Transferred - The item was trapped for a hold for a patron from another library,
and has been shipped to that library for pickup. The item will remain Transferred
until received at the pickup library, where it will become Held. Transferred items
may be said to be out-bound.

In-Transit - In-transit items are items that have circulated at a remote branch and
have been sent to the assigned branch. They may be said to be in-bound. When
received at the Assigned branch and checked in, the item will become In.

Claim Returned - Polaris shows that an item is out, but the patron claims that the
item was returned. The staff member used the Claim function in Patron Status to
change the item circulation status from Out to Claim Returned. The status will
change to In if the item is recovered at circulation.

Claim Never Had - Polaris shows that an item is out, but the patron claims that she
never had the item. The staff member used the Claim function in Patron Status to
change the item circulation status from Out to Claim Never Had. The status will
change to In if the item is recovered at circulation.

Claim Missing Parts - When staff members use the Special Item Check-in dialog
box to check in multi-part items for which a part or parts are missing, they can
update the items to a status of Claim Missing Parts. This blocks the item from
being circulated; moves the item to the Claims view of the Patron Status work-
form; and generates a notice to the patron.

Lost - The item was checked out and the patron has informed the library that she
lost the item. The staff member changes the status from Out to Lost using the
Lost function in Patron Status. Or, the patron may be billed for the item if it has
been long overdue, at which point the librarian may declare the item lost. The
status will change to In if the item is recovered at circulation.

Out-ILL - Intended to be used in conjunction with a third-party ILL application, for
example when using NCIP, to indicate the item has checked out to a remote lib-
rary.

Returned ILL - Intended to be used in conjunction with a third-party ILL application,
for example when using NCIP, to indicate an item out to a remote branch has been
returned by that branch.

Non-Circulating - The item does not circulate; the Non-Circulating option is
checked in the item record.
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Missing - An inventory status indicating that the item is not on the shelf as expec-
ted. Missing is distinguished from Lost in that Lost indicates that the item was in
fact checked out and did not return. Missing indicates that, to the extent the library
can determine, the item has not circulated but cannot be found.

Shelving - A display status for items that are In but not yet returned to the shelf for
circulation. The library defines how long the Shelving status is displayed for an
item that is checked in.

Withdrawn - The item has been removed from the circulating collection. It is not
available for check-out or request.

Bindery - The item has been removed from the collection temporarily and sent to
the bindery.

In Repair - The item has been removed from the collection temporarily for repair.

Unavailable - A miscellaneous status used to indicate that the item is not available
for circulation. No specific reason is associated with the status and there are no
links to any program functions.

In Process - The item has recently been received and has not yet completed pro-
cessing. The status can be assigned automatically at item creation within Acquis-
itions.

On-Order - The material has been ordered through Acquisitions and item records
created in anticipation of receipt. The status can be assigned automatically at
item creation within Acquisitions.

Routed - If a routed serial issue is linked to an item record, the item’s circulation
status is Routed. Attempts to check out a routed item produce an error message.
Check the item in to change its circulation status from Routed to In, and then
check it out.

EContent External Loan -Updates the eContent item record when a Polaris library
loans an eContent title to a patron whose record is not in the Polaris database.

The check-outs are from the vendor's application and the check-ins are from the
patron view of the patron account or from the vendor's application. Only the APIs
can apply the eContent external loan circulation status and only to integrated eCon-
tent items.

See also: View circulation status names, edit descriptions, and add Leap banner
text
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View circulation status names, edit descriptions, and add Leap banner text

Circulation statuses are defined at the System level and cannot be modified. However, if
you have the required permissions, you can modify the description and/or the
circulation status that appears at the bottom of the book jacket image on the Item
Record workform in Leap. For more information on the Item Record workform in Leap,
see the Leap help.

To view the standard names for item circulation statuses, edit descriptions, and add
Leap Item Record workform banner text:

Note:

You can modify the description for any circulation status, and you can use
the same description for more than one status, but be cautious in
applying the same description to multiple circulation statuses, since this
may confuse both staff and patrons.

1. Inthe Administration Explorer tree view, open the Database Tables folder for the
organization, and select Circulation Statuses.

The Circulation Statuses table is displayed in the details view.
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Administration Explorer - System - QA-HOTH 7.4 - Polaris - O X
File Edit Help

OD-@-HX & 9
[lCircuIatjon Statuses

x|t +'m|Y

.. Description Name Banner Text a

% Out Out Out

g Out-ILL Out-ILL Out-ILL

& Held Held Held

% Transferred Transferred Transferred

% In-Transit In-Transit In-Transit

% Lost Lost Lost

% Claim Returned Claim Returned Claimed

% Claim Never Had Claim Never Had Claimed

% Missing Missing Missing

% Withdrawn Withdrawn Withdrawn

% Bindery Bindery Bindery

% Ordered On-Order On-Order

% In-Repair In-Repair In-Repair

% In-Process In-Process In-Process

% Unavailable Unavailable Unavailable

E‘% Returned-ILL Returned-ILL Returned-ILL R
For Help, press F1 22 row(s) ?g emil

2. Double-click the circulation status entry or click [ -

The Modify: Iltem Status dialog box appears.
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Modify : Item Statuses - 10

Description: |Missing |
Mame: Missing
Banner Text |Missing |

Cancel Help

3. Type the new description in the Description box. Modify the description so that it
is understandable to everyone, including patrons. The modification affects only
the description that is displayed; it remains associated with the underlying
circulation status that appears in the Name box.

Note:

The non-circulating item status applies to those items where Non-
circulating is checked in the item record. When you modify the
description for this status, your description is displayed in the PAC
for these items, but the description is not available as a Find Tool
search filter or an option for bulk change. The actual status is Non-
circulating.

4. If your library uses Leap and you want to display the circulation status on the
bottom of the bookjacket image on the Item Record workform, type the text in the
Banner Text box.

The example below shows the banner text in the Leap Item Record workform.
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Item Record ©

THE WIND IN The wind in the willows
THE WILLOWS
e el k. By Grahame, Kenneth, 1850-1932.
Barcode: 0000100304534

Call number: J Fict Gra

Collection: Children's Fiction

Shelf location: None

Owning branch: Lake Pleasant

5. Click OK.

Related Information

» Shelving status - When an item is returned to its assigned branch and checked in,
the item’s circulation status becomes In even though the item may not be returned
immediately to the shelf. For each material type, you can set a period of time dur-
ing which the checked-in item’s In status is displayed as Shelving (or another
appropriate description). See Setting Shelving Status.

» Non-circulating items - See Setting Up Non-Circulating Items.

» Suppressing from PAC by circulation status - You can suppress items with specific
circulation statuses from the PAC availability display. See the Public Access
Administraion PDF Guide, Suppressing Items from Search Results.

« Circulation statuses and how they occur - See Default Circulation Statuses.
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When an item is returned to its assigned branch and checked in, the item'’s circulation
status becomes In even though the item may not be immediately returned to the shelf.
This can be confusing for a patron who finds the item in PAC, notes that the item’s
status is In, but cannot find it on the shelf. To inform the patron that the item is not yet
returned to the shelf, you can set a period of time for each material type during which
the item’s status is displayed as "Shelving" (or another appropriate description).

For the time period you set, patrons see the shelving status description for the item in
the PAC. In the staff client, the shelving status description is displayed in Find Tool
search results, the PAC preview in the bibliographic record, and the list of linked item
records available from the bibliographic record or the item record. You can also limit
Find Tool item searches by shelving status. For items checked in offline, when the
offline transactions are uploaded, the shelving status display is calculated according to
the date/time of the check-in recorded in the upload file.

When you enable the shelving status option, the shelving description is displayed only
when an item is checked in during a circulation process and its circulation status
changes to In. The option is not used when an item is created with a status of In or
when the status of multiple items is changed to In through bulk change.

Note:

If you use Polaris Serials, part of your serials processing workflow may be
to create items with a status of In when a serial issue is checked in. To
use the shelving status description with these items, set the status to In
Process or another status other than In, then check in the item as a
circulation process—using Circulation > Check In or selecting Tools >
Check In from the item record workform.

Use the Patron Services parameter Shelving status options to enable this option and to
control how long the system displays the shelving status description for each material
type. You can set the shelving status period at the system, library, or branch level, but
you can only set the shelving status description text at the system level so that the
description is consistent in PAC search results. When an item is checked in, the system
uses the shelving status settings for the transacting branch.
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Note:

» For more information about how Polaris calculates and applies the
shelving status period, see Understanding the Shelving Status
Period.

« If you have the shelving status option activated for a branch, then
turn it off, the status of items currently in “shelving” changes to In.
This change may take up to 10 minutes.

See also:

o Set Shelving Status Options

» Understanding the Shelving Status Period

Set Shelving Status Options

Note:

For more information about how Polaris calculates the shelving status
period and then applies and removes the shelving status, see
Understanding the Shelving Status Period.

To set shelving status options

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Shelving status options to display the Shelving Status Options dialog
box.

3. Select Enable shelving status. The other options become available.
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Shelving Status Options [COB] (inherited from [QA-Poelaris]) e

Enable shelving status

Display text: = Shelving

Time to display
0 : hours Set Time
Material Type Time To Display (HH:MM) ™
Art 00:00
Audiobook 10:00
Book 10:00
Book and CD 00:00
Children’s Video 30:00
eBook 00:00
Equipment 00:00 W

If an item is re-scanned...

(®) Clock is reset and the shelving status will expire at the new time
() Shelving status will expire at the time already set

() Circulation status will display as In

Cancel Help

. (System level only) Specify the status text to display for an item in the PAC and the
staff client Find Tool when an item is checked in and the status changes to "In".
The default text is "Shelving". Use this text or specify any description that will
make sense to your patrons, such as "Sorting" or "Recent Return".

. Select the material type or types for which you want to set the time period.

. Inthe Time boxes, specify the shelving status period for the selected material type
(s). Select hours or minutes, and type or select the number of hours or minutes.

. Select Set Time.

The number of hours or minutes you specified is listed for the selected material
type or types.

. Select an option to specify what should happen when an item is checked in, the
status changes to "In", and the item is checked in again (circulation status goes
from "In" to "In" before the shelving status time period has expired):

» Clock is reset - The specified time period to display the shelving status
description starts again, as if the item were being checked in the first time.
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» Shelving status will expire at the time already set - The clock is not reset.
The shelving status description will expire at the end of the original period.

« Circulation status will display as In - The shelving status description will no
longer be displayed. In the PAC and staff client Find Tool, the circulation
status will be displayed as "In".

9. Select OK to save your settings.
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Understanding the Shelving Status Period

The following sections explain how Polaris calculates the shelving status period and
then applies and removes the shelving status after an item is checked in:

e Shelving Status Period and Library Open Hours

e Shelving Status and the Item Shelving Status SQL Job

Shelving Status Period and Library Open Hours

The shelving status period is calculated based on the hours the library is open. For
example, if the shelving status period is set to 48 hours, the shelving status remains in
effect for 48 open hours after the item is checked in (not 48 continuous hours). Set the
shelving period based solely on the average time it takes to shelve items; program
calculations will take into account the library’s schedule.

Days closed (hours of operation) and dates closed are taken into account. For proper
calculation, be sure hours of operation are set up for your branch. See the Polaris
Administration Guide, "Registering a Branch."

The shelving status period is recalculated when items are checked in close to the
library's closing time:

« If the period is less than 24 hours, and the item is checked in less than three hours
before closing time, the shelving status expiration time is recalculated.

Example:

The shelving status period is six hours. The item is checked in one
hour before the library closes. The shelving status period begins at
opening time on the next open day and lasts for six hours.

« If the period is less than 24 hours, and the item is checked in three hours or more
before closing time, the shelving status expiration time is not recalculated.

Example:

The shelving status period is six hours. The item is checked in five
hours before the library closes. The shelving status period is applied
using the five hours today and one hour tomorrow.
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Shelving Status and the Item Shelving Status SQL Job

The Item Shelving Status SQL job checks for items with a status of Shelving and
updates the status to In once the shelving status period has elapsed.

The job runs at an interval that is determined by the settings configured on the Shelving
Status Options dialog box. The job runs at an interval that is half as long as the shortest
shelving period configured (for any branch or material type). For example, if the shortest
shelving period is eight hours, the Item Shelving Status job runs every four hours.

Note:

« Since the Item Shelving Status job runs at defined intervals, an
item's status could change from Shelving to In at a time that does
not match the shelving status period to the minute.

* Running the Item Shelving Status job uses system resources. Be
sure to set realistic shelving status periods -- 12 hours rather than
12 minutes - when you configure shelving status options. Setting
periods less than nine minutes can adversely affect circulation
workflows.

For more information about the Item Shelving Status job, see the Administration Guide,
"Polaris SQL Jobs Reference."

Displaying an Item’s Last Borrower

Use the Patron Services parameter Last use patron display to enable a link from the
item record to the Patron Status workform for the item’s last borrower, or to suppress
the link. This parameter also controls whether the patron’s barcode is displayed in the
Item Record workform. This parameter can be set on the system, library, or branch level.
The setting for the log-on branch controls whether the link is available.
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To enable the previous borrower link in item records as displayed for the staff member’s
log-on branch:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Last use patron display, and select Yes.

3. Select File > Save.

You can limit the number of days that the last borrower's information is kept in the item
record. In the Administration Explorer tree view, select Parameters > Patron Services:

» Last use patron: Delete: Determines if the last borrower's information is kept in
item records. The default value is Yes.

» Last use patron: Number of days to keep: Sets the number of days the last bor-
rower's information is kept. The default value is 0.
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Automatic Process for Lost, Missing, Withdrawn Items

Libraries can set the patron services parameters, Lost item transition and Missing item
transition, to automatically update the circulation status of lost or missing items based
on a specified period of time. When the Lost item transition or Missing item transition
processing has been enabled, the Lost Missing Withdrawn Processing SQL job identifies
items that meet the criteria specified in the applicable parameter and updates the items
as follows:

» Lost items transition to either Missing or Withdrawn
» Missing items transition to Withdrawn

Note:

The first time the job runs, processing may take some time because all the item records
that have retained a Lost status for longer than specified in the Lost item transition
parameter, and all the items that have retained a Missing status for longer than
specified in the Missing item transition parameter are included in the processing. When
determining if a particular item should be updated automatically, the day on which the
jobis runis not included.

See also:

e Setting Public Access Profiles and Parameters

e Setting Public Access Profiles and Parameters

Set up lost item transition to missing or withdrawn

Note:

Libraries in a consortium will need to consider whether to implement the
automatic transition of Lost items because the items will be assigned the
new status without regard to Lost item recovery settings for the
Governing library.

To enable lost item transition processing:

1. In Polaris Administration, select the library organization (system, library, or
branch), Parameters, Patron Services. To see the patron services parameters list,
click the appropriate level- System, Library, Branch.

2. Select Lost item transition in the list of parameters.
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The Lost item transition dialog box opens. The Do not change status option is
selected by default.

. Select Missing or Withdrawn.

Specify the time period after which Lost items will be updated to either Missing or
Withdrawn by selecting a number and Months or Years.

Recommendation:

The transition period set by the Assigned Branch should be longer than
any of the lost-and-paid recovery periods set within the library system.
This reduces the likelihood of an item being recovered after it has
received a Withdrawn status.

If you want to charge accruing overdues to the patron’s account, select Charge
accruing overdues.

. Select OK.

Lost item transition processing

When an item transitions from Lost, the following updates are made to the item record:

The circulation status changes from Lost to Missing or Withdrawn.

The status reflects the date and time of the change.

The item is removed from the Patron Status workform, Claims view.

If the item is lost and not paid, the charge remains on the patron’s account.

If the item is lost and paid, no lost-item-recovery options, such as crediting the pat-
ron’s account, are applied.

If Charge accruing overdues is selected, the charges are added to the patron
account.

The item record history displays: Circulation status modified via Lost Item Trans-
ition processing Automatic status change.

Set up missing item transition to withdrawn

To enable missing item transition processing:
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1. In Polaris Administration, select the library organization (system, library, or
branch), Parameters, Patron Services.To see the patron services parameters list,
click the appropriate level- System, Library, Branch.

Select Missing item transition in the list of parameters.
The Missing item transition dialog box opens.
Select Move missing items to withdrawn.

Specify the time period after which Missing items will be updated to Withdrawn by
selecting a number and Months or Years.

6. Select OK.

a N

Missing item transition processing

When an item transitions from Missing to Withdrawn, the following updates are made to
the item record:

The circulation status changes from Missing or Withdrawn.

The status reflects the date and time of the change.

The item record history displays: Circulation status modified via Missing Item
Transition processing Automatic status change.

Other item data, including the last borrower, remain.
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Automatic Processes During Import

When records are imported, they are processed according to settings in the import
profile and in Polaris Administration. Some processing takes place before any records
are created or updated, and other processing occurs when the data in the imported
records are used to create or update records. This section covers the automatic
processing you can choose to initiate in the import profile settings.

This topic contains the following sections:

 MARC Records Validated
 Authority Control Performed

o Records Checked for Duplicates

» Specific MARC Tags Removed from Incoming Bibs

* Incoming Bibs Protected from Being Overlaid
» Bib Tags Marked to Prevent Creation/Updates of Iltems
» Authority Records Deleted

e |tem Records Created from Embedded Holdings Tags

» Duplicate Records Overlaid

e Tags Retained from Duplicate Records

e Bibliographic Overlay Based on Encoding Level

» Specific MARC Tags Removed from Incoming Bibs

« Authority Record Overlay Based on Cataloging Source

MARC Records Validated

If validation is selected in the import profile, the records are validated according to the
following Polaris Administration Cataloging profiles: MARC validation:

Bibliographic and MARC validation: Authority. However, if the incoming records contain
indicators or subfields with data that cannot be validated, the data is replaced with the
following defaults: Indicators default to ' ' and subfields default to '?". For more
information, see the Cataloging Administration PDF Guide, Administering MARC
Validation and Display.
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Authority Control Performed

If the options to Perform authority control and Automatically create new authority
record; save bibliographic record as final are selected in the Bibliographic Records tab
of the import profile, the system searches for an existing authority record for the
heading. If no matching authority record is found in the local database, an authority
record is created automatically and saved to the database. If your library has a
subscription to a remote database of authority records, the remote database is
automatically searched when no matching authority record is found. The new authority
record is saved in the database and linked to the new bibliographic records. Search
Polaris help for "Set import options for authority records."

Records Checked for Duplicates

If duplicate detection is selected in the profile, duplicates are identified according to the
rules in the following Polaris Administration database tables: Bibliographic
Deduplicaton or Authority Deduplication. For more information, see the Cataloging
Administration Guide, "Change bibliographic or authority deduplication tables." You can
also select the option Use profile defined duplicate detection rules in the import profile
and select the rules to apply.

Specific MARC Tags Removed from Incoming Bibs

If the import profile is set up to automatically remove tags from incoming bibliographic
records, the tags are removed from the records before they are saved in the Polaris
database. Search Polaris help for "Set import options for bibliographic records."

Incoming Bibs Protected from Being Overlaid

If the import profile is set up to check the Do not overlay box on the incoming records,
they are saved as protected records that cannot be overlaid. Search Polaris help for "Set
import options for bibliographic records."
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Bib Tags Marked to Prevent Creation/Updates of Items

If you are using an import profile that is set to create item records from embedded
holdings tags, an automatic process first checks the bibliographic records for the
presence of pre-existing holdings tags with the same tag number specified in the import
profile. If pre-existing tags are found that match the retained tags under Keep MARC
tags in the import profile, and these tags do not already have a $9 subfield, then a
system-supplied $9 with the text Tag retained from duplicate overlay is inserted into
the tag. Pre-existing embedded holdings tags that do not already have a $9 subfield are
marked automatically without a Polaris Administration parameter.

When embedded holdings tags are used to create new items or to update on-order
items to shelf-ready items, a $9 with the text Item generated is inserted into the tag if
the Polaris Administration Cataloging parameter MARC embedded holdings tags as
processed is set to Yes. During the import process, item records are not created or
updated if the embedded holdings tags are marked as follows:

 $89 Tag retained from duplicate overlaymmm dd yyyy hh:mm[AM/PM]
Or
+ $9 Item generated mmm dd yyyy hh:mm[AM/PM]

Your Polaris Administrator can use a utility to automatically scan for specific tags
marked with $9 and remove them. See the Cataloging Administration PDF Guide, Setting
Utility to Delete Bib Tags Marked with Subfield 9.

Authority Records Deleted

If the incoming authority record status (Leader/05) is d, s, or x, the following deletion
processing occurs during import:

« If the incoming authority record status is d (deleted), the following processing
occurs:

« All bibliographic record links to and from the existing authority record are dis-
connected.

« If any authority record has the existing authority record 1xx field as a 4xx field, the
cross-reference is logged in the import report.

« All authority record links to the existing authority record are disconnected.
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The existing authority record is replaced by the incoming record.
The deleted record is logged in the import report.

If the incoming authority record status (Leader/05) is s (deleted; heading split into
two or more headings), the following processing occurs:

All bibliographic and authority record links to and from the existing authority
record are disconnected.

All disconnected links are logged in the import report.
The existing authority record is replaced by the incoming record.
The deleted record is logged in the import report.

If the incoming authority record status (Leader/05) is x (deleted; heading replaced
by another heading), the following processing occurs:

All bibliographic and authority record links to and from the existing authority
record are disconnected.

The existing authority record is replaced by the incoming record.
The deleted record is logged in the import report.

Item Records Created from Embedded Holdings Tags

When you import bibliographic records using an import profile that is set to build item
records from embedded holdings tags, the items are created automatically based on the
holdings tag number and MARC subfield mapping specified on the Item Records tab.
This table shows the default settings, requirements, and data entry conventions for item
record creation from data in the 852 tag in the Polaris default (with item creation)
profile. The data entry conventions apply to all profiles.

Polaris Item
Record Field

Required

Data Entry Con-
ventions

Assigned Sa Yes Must match a branch

(branch) ID or abbreviation. 15
characters max.

Collection Sb No Must match a

collection ID or
abbreviation. 15
characters max.
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Polaris Item . . Data Entry Con-
Record Field =i eI ventions
Barcode Sp No 20 characters max.
Call Number Sk No 60 characters max.
Prefix
Call Number Sm No 60 characters max.
Suffix
Circ Status N/A No ID or description. 80

characters max.
Certain circ statuses
are not allowed in
new item records, for
example Lost. If the
ID or description in
the circ status is not
allowed, the circ
status is taken from
the template or from
system defaults for
item records.

Classification Sh No 60 characters max.
Number

Copy Number St No 60 characters max.
Cutter Number Si No 60 characters max.
Display in PAC S4 Yes 0=No, 1=VYes
Fine code Sr Yes FineCodelD (ID or

description). 80
characters max.

Free Text Block N/A No 255 characters max.
Funding Source $1 No 50 characters max.
Holdable S5 Yes 0=No, 1=VYes
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Polaris Item
Record Field

Subfield

Required

Data Entry Con-
ventions

Library Assigned | N/A No ID or description. 80

Block characters max.

Loan Period Su Yes LoanPeriodCodelD,

Code ID, or description. 80
characters max.

Loanable Outside | $7 Yes 0=No, 1=VYes

System

Material Type Sw Yes MaterialTypelD, ID, or
description. 80
characters max.

Name of Piece N/A No 255 characters max.

Non Circulating N/A No 0=No, 1=Yes

Non-Public Note Sx No 255 characters max.

Owner (branch) So Yes Must match a branch
ID or abbreviation. 15
characters max.

Physical Sq No 255 characters max.

Condition

POLI-Segment ID | N/A No Number

Price S0 No Monetary value
(Format: ##.## No 'S'
should be in the
subfield. Include a
decimal where
appropriate.)

Public Note Sz No 255 characters max.

Renewal Limit Sy Yes 0-99

Shelf Location Sc No Must match shelf
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Polaris Item
Record Field

Subfield

Required

Data Entry Con-
ventions

location ID or
description. 80
characters max.

Shelving Scheme

Si

Yes

0=No information,

2=Library of
Congress

3=Dewey Decimal

4=National Library of
Medicine

5=Superintendent of
Documents

6=Shelving Control
Number

7=Title
8=Shelved Separately
9=0ther

Statistical Code

$d

No

ID or description. 80
characters max

Temporary Shelf
Location

Sl

No

25 characters

Vol (volume)

Sv

No

60 characters max.

Duplicate Records Overlaid

If the import profile is set to perform duplicate detection, it can also specify how
duplicate records are handled. For information regarding the process that compares the
encoding level of duplicate bibliographic records, see Bibliographic Overlay Based on
Encoding Level. For information regarding the process that compares the cataloging
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source of duplicate authority records, see Authority Record Overlay Based on Cataloging

Source.

Tags Retained from Duplicate Records

The Bibliographic Tags to Retain/Delete policy table is used to identify tags in
bibliographic records to retain from duplicate records that are overlaid. The Authority
Overlay Retention policy table is used to identify tags in authority records to retain from
duplicate records that are overlaid.

Note:

The Bibliographic Tags to Retain/Delete policy table can also be used to
identify tags to delete from incoming records whether they are duplicates
or not.

For more information on these tables, see the Cataloging Administration Guide, "Specify
Tags to Retain from Overlaid Bibs" and "Specify Tags to Retain from Overlaid Authority
Records."

For bibliographic records, you can also select the option Profile-defined overlay
retention tags in the import profile and select additional bibliographic tags to retain. See
Set import options for bibliographic records.

Bibliographic Overlay Based on Encoding Level

If the import profile is set to compare the encoding levels of duplicate records, the value
in Leader position 17 is checked.

Note:
Double-click on the Leader in the MARC21 view of the Bibliographic
Record workform to see the encoding levels in Leader position 17:

space - Full level

1 - Full level, material not examined

2 - Less than full level, material not examined
3 - Abbreviated level

4 - Core level

5 - Partial (preliminary) level
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7 - Minimal level

8 - Prepublication level

E - System-identified MARC error in batchloaded record
| - Full-level input by OCLC participants

J - Deleted record

K - Less-than-full input by OCLC participants

L - Full-level input added from a batch process

M - Less-than-full added from a batch process

u - Unknown

z - Not applicable

The following table shows the values in the incoming record in Leader position 17 and
the values in the existing record that allow or disallow an overlay. If the encoding levels
are equal, the records are processed according to the setting in the import profile.
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
Incoming LDR/17 Value Can Overlay Cannot Overlay
3 3 space
5 1
8 2
u 4
z 7
E I
J
K
L
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
4 3 space
4 1
5 7
8 I
u J
z K
E L
M
Incoming LDR/17 Value Can Overlay Cannot Overlay

© 2023 Innovative (Part of Clarivate)
Page 231



Patron Services Administration Guide

Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
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Authority Record Overlay Based on Cataloging Source

If the option Merge duplicate records is selected when importing authority records, the
040 Sa of the incoming record is checked against the entries in the following
Administration policy table: Authority Record Import: Preferred Cataloging Source. If
the (040 Sa) code in the incoming record matches an entry in the table, the preference
order of the code is checked. The incoming record overlays the database record if it has
a higher level of preference than the code in the database record.

Note:

For information on setting up this policy table, see the Cataloging
Administration Guide, "Specify preferred cataloging sources for authority
records."

1. The original cataloging agency of the incoming record (tag 040 Sa) is matched to
entries in the Authority Record Import: Preferred Cataloging Source policy table in
Polaris Administration.
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Preferred Cataloging
Source Table Entries for
Importing Library

Incoming Record Tag

040 $a Import Processing Status

Valid for import

Has entries Matches a table entry .

processing

Invalid record is logged
Has entries Does not match a table in the import report, but

entry is not added to the

catalog

Invalid record is logged
Has entries No tag 040 in the import report, but

is not added to the
catalog

Incoming record is
added to catalog as
provisional. Logged in
No entries No tag 040 import report. Added to
provisional record set if
specified. Existing
record is not changed.

Has original cataloging Valid for import

No entries : . .
source information processing

2. If the imported authority record is from a preferred cataloging agency, the ranking
of the agency is compared with the agency ranking of the existing record.
The ranking of preferred cataloging agencies is determined by the agency'’s entry
position in the Authority Record Import: Preferred Cataloging Source policy table in
Polaris Administration.

Incoming Record Original Cata- Processing Done for Incoming

loging Agency Preference Record

Higher than the agency for the | Processed according to value
existing record in record status (Leader/05)
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Incoming Record Original Cata- Processing Done for Incoming

loging Agency Preference Record
Equal to the agency for the Processed according to value
existing record in record status (Leader/05)

Existing record does not have Processed according to value
a cataloging agency specified in record status (Leader/05)

Entry logged in import report.
Incoming record is not added
to catalog.

Lower than the agency for the
existing record

3. If the imported record has a higher or equal source preference than the existing
record, the duplicate records are processed based on the record status (Lead-
er/05) of the incoming record.

« If the incoming record has a record status of n (new), ¢ (corrected or
revised), or a (increase in encoding level), Polaris does new or update pro-
cessing.

« If the incoming record has a record status of d (deleted), s (deleted with
heading split), or x (deleted with heading replaced), Polaris does deletion pro-
cessing.

© 2023 Innovative (Part of Clarivate)
Page 243



Patron Services Administration Guide

Enable the auto-renew process

To enable automatic renewal of items:

1.

In Polaris Administration, select the library organization (system, library, or
branch), Parameters, Patron Services.

Select Renewal: Auto-renew, and select Yes.

Automatic renewals are completed as part of the Notices Processing SQL job.
When the job runs, it automatically renews eligible items for which the item's
assigned branch has the Renewal: Auto-renew parameter set to Yes. A patron's
items will be auto-renewed based on the number of days specified in the Notice
options, Reminders setting for the patron's registered branch.

See also: Setting Public Access Profiles and Parameters
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Governing Library for Circulation Transactions

The system-level Patron Services parameter Consortium Circulation establishes which
library’s settings govern certain aspects of check-out and renewal transactions: the
patron’s branch, the transacting branch, or the item’s assigned branch. An additional
setting for lost item recovery governs which library’s settings determine how charges
are processed when a lost item is recovered at check in. The governing library settings
are particularly useful for setting uniform processing rules in consortia whose members
may have widely differing individual policies.

You can set the governing library for due date calculation, loan and request limits, fine
calculation, and lost item recovery.

The following transactions are affected:

» Due date calculation - Check-out and renewal from the staff client; renewal from
PAC; check-out and renewal from Polaris ExpressCheck; renewal by telephone
(Polaris Phone Attendant). A renewal uses the settings for the governing library of
the check-out transaction.

» Loan and request limits - Check-out and renewal from the staff client, including
renewal from the patron account; renewal from PAC; check-out and renewal from
Polaris ExpressCheck; renewal by telephone (Polaris Phone Attendant); offline
upload. A renewal uses the settings for the governing library of the check-out trans-
action.

 Fine calculations - Check-out and renewal from the staff client, including renewal
from the patron account; renewal from PAC; check-out and renewal from Polaris
ExpressCheck; renewal by telephone (Polaris Phone Attendant); offline upload;
check in from the item record; lost item charge options. A renewal uses the set-
tings for the governing library of the check-out transaction.

 Lost item recovery - Check-in transactions from the Check In workform (Normal
and Bulk modes), the Item Record workform, the Find Tool results list, and the Pat-
ron Status workform. For offline check in, the settings are checked and the appro-
priate charges are calculated when the offline transactions are uploaded.

Governing library settings do not affect reserve item records, which always circulate
according to the reserve item'’s assigned branch, or offline check-out and renewal.
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See: Set the governing library for circ transactions.

Set the governing library for circ transactions

Note:
The parameters for the governing library are at the System level only.

To set the governing library for circulation transactions:

Important:
Your settings for this parameter apply to all organizations.

1. Inthe Administration Explorer tree view, open the Parameters folder for the sys-
tem, and click the Patron Services tab to display the Patron Services parameters
in the details view.

2. Double-click Consortium Circulation.

The Consortium circulation dialog box appears.

Consortium circulation x

Governing library for

Due date calculation: Use item assigned branch Fine calculation: Use patron branch ~

Patron blocks: Use transacting branch e Lost item recovery: Use lending branch e

3. In the Due date calculation box, select one of the following options to specify the
governing library for due date calculation:
 Use item assigned branch (default)
» Use patron branch
» Use transacting branch
The due date calculation selection specifies which branch’s settings in the Loan

Periods policy table and the Patron Services parameter End-of-term due date
options are used when the due date is calculated at circulation. Exceptions:
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At circulation, an end-of-term due date setting overrides a special loan period if the
governing library is the item’s assigned branch or the patron’s branch. But if the
governing library is the transacting branch, the special loan period overrides the
end-of-term due date setting.

The system always uses the Hours of operation (closed days) parameter settings
and Dates Closed policy table of the transacting branch when calculating the due
date.

The system checks the governing library’s Loan Periods policy table to determine
if an item is an hourly loan. If so, the system then uses the Hours of operation and
Overnight loan period parameter settings of the transacting branch.

The Patron Services parameters Overdues: Clear fine if recovered at check-
out and Overdues: Clear fine if recovered at renewal are set at the system level,
so the same settings for these parameters apply to all organizations in the sys-
tem.

In the Patron blocks box, select one of the following options to specify the gov-
erning library for patron blocks (loan and request limits):

Use patron branch (default)

Use transacting branch

This selection specifies which branch’s settings in the Patron/Material Type Loan
Limit Blocks policy table are used at check-out and renewal. This table also limits
the total numbers of hold and ILL requests, and the number of hold requests

allowed for specific material types. For these request limits, the “transacting
branch” is the pick-up branch for the request.

Exceptions:

This setting affects only the Patron/Material Type Loan Limit Blocks policy table. It
does not affect any other types of blocks, such as free-text blocks, library-
assigned blocks, collection agency blocks, verify borrower blocks, patron record
expiration blocks, or address check blocks.

This setting does not affect the block on an item designated as non-circulating.

In the Fine calculation box, select one of the following options to specify the gov-
erning library for fine calculation:

Use item assigned branch (default)
Use patron branch
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 Use transacting branch (usually the check-in branch)

¢ Use lending branch
The fine calculation selection specifies which branch’s settings in the following
Polaris Administration controls are used when a fine is calculated at circulation:
Fines policy table, including grace units; Dates Closed policy table; the Patron

Services parameter Days not fineable; the Patron services parameter Lost item
charge options.

Exception: This setting does not affect the Patron Services parameter Free days.
The system always uses the Free days setting of the transacting branch.

6. Inthe Lost item recovery box, select one of the following options to specify the
governing library for lost item recovery:

 Use transacting branch (default - usually the check-in branch)
» Use lending branch

The lost item recovery selection specifies which branch’s settings in the Patron
Services parameter Lost item recovery are used when a lost item is recovered at
check-in.

7. Click OK on the dialog box.
8. Select File > Save.
Related Information

» Loan and request limit blocks - See Defining Loan and Request Limit Blocks.

e Overdue fines - See Setting Fine Amounts.

» Lost item charge processing and recovery - See Overdue Fines on Lost Items and
Setting Lost Item Recovery Defaults.
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Due date calculation is based on settings in both the patron record and item record, as
well as the policies and schedule of the lending library. Polaris Administration tables
define patron codes and item loan period codes, and determine the relationships
between them. At check-out, the system links the item and patron records and
determines which settings to use when calculating the due date.

Patron codes and item loan period codes are shared by all libraries to facilitate lending
and receiving items anywhere in the system. However, each branch in the system can
establish different policies concerning loan durations for specific patron and item code
combinations.

Important:

You set which branch’s policies are used in due date calculation with the
system-level Patron Services parameter Consortium Circulation. See: the
Public Access Administration Guide, Governing Library for Circulation
Transactions topic.

The settings used to calculate due dates are established when Polaris is first installed,
but you can change them when a library or branch is added to the system, or when
lending policies change. After you set up the criteria that affect due dates, you can set
up fines for overdue items. See Defining Fines and Fees.

See also:

e Calculating Due Dates

e Defining Loan Period Codes

e Defining Loan Period Durations

e Setting End-of-Term Due Dates

Calculating Due Dates

When a patron checks out or renews an item, the due date is calculated based on the
following:
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» The patron code and item loan period relationship established by the governing lib-
rary for the transaction (by default the item’s assigned branch), and

» The closed dates and hours of operation of the lending library.

The patron code is stored in the patron record, while the loan period code is stored in
the item record. The Loan Periods policy table associates the patron code and loan
period code to determine the loan period for an item assigned to a particular branch.

All daily and weekly loans are due at 11:59 PM on the due date. For information on items
with a loan period set in hours or minutes, see Hourly Loans.

Note:

For daily and weekly loans, overdue fine calculation does not begin until
the end of the day. For hourly loans, fines are calculated according to the
exact time due. See Calculating Overdue Fines.

The following factors affect how Polaris calculates due dates:

e Undefined and Standard Loan Periods

Closed Dates and Days

Hourly Loans
Non-Circulating Items

Renewal Parameter Settings

Undefined and Standard Loan Periods

If a relationship between the patron code and loan period code cannot be found in the
Loan Periods policy table, Polaris uses the setting in the Patron Services parameter
Undefined loan period, which is set at the system level. The default value is 14 days.
This value is also used to automatically add an entry to the table if a new branch or
patron code is added.

Note:

If a loan period cannot be found in any table or parameter, a message at
check-out indicates that the loan period cannot be calculated. In this case,
circulation staff can allow the system to use the undefined loan period
setting, or they can set the item’s loan period manually, by opening the
Special Loan dialog from the Check Out workform.

For offline circulation, the system always uses the workstation branch’s setting for the
Patron Services parameter Standard loan period to calculate the due date. This is
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because there is no access to the database during offline circulation. However, the
Loaning Branch recorded in the transaction and in the item record is the logged-on
user’'s branch. This allows libraries to gather statistics for different bookmobile stops
based on user log-on, while maintaining a consistent loan period for the bookmobile (the
workstation branch).

Closed Dates and Days

The lending library’s closed dates and closed days are used in the due date calculation.
If the due date is defined as closed in the Dates Closed policy table (for example,
January 1), the due date moves to the next open date. See the Polaris Administration
Guide, Identifying Dates Closed. If the Patron Services parameter Hours of

Operation designates the day of the week as a closed day for the branch (for example,
Sunday), the due date moves to the next open day.

Hourly Loans

For hourly loan due dates and times, Polaris checks these additional Patron Services
parameters for the lending library: Hours of operation (for hours and closed days) and
Overnight loan period. If the item is due after the lending library closes, one of the
following events occurs:

« |f the Overnight loan period parameter is set to permit automatic overnight loans,
the due date is set to the next day the library is open. The due time is set to the lib-
rary’s opening time, plus any additional time specified by the library.

« If the Overnight loan period parameter is set to not permit automatic overnight
loans, one of the following events occurs:

« If the loan period is less than 24 hours, the transaction is blocked. If you override
the block, the due date is set to the next day the library is open, and the due time is
set to the library’s opening time, plus any additional time specified by the library. If
you do not override the block, the item is due at the lending library’s closing time
on the current day.

Example:

An item is checked out on Thursday at 4:00 P.M. for a six-hour loan
period. The lending library closes at 8:00 P.M. and opens on Friday at
10:00 A.M. If automatic overnight loans are permitted plus two additional
hours, the item is due on Friday at 12:00 noon. If automatic overnight
loans are not permitted, the transaction is blocked. If you override the

© 2023 Innovative (Part of Clarivate)
Page 251



Patron Services Administration Guide

block, the item is due on Friday at 12:00 noon. If you do not override the
block, the item is due when the library closes on Thursday at 8:00 P.M.

« If the loan period is 24 hours or more, the transaction is not blocked because the
overnight loan setting is irrelevant.

You can set the Overnight loan period parameter at the System, Library, or Branch level.

Non-Circulating Items
You can designate certain items as non-circulating in two ways:

» To make a specific item non-circulating for all patrons, select the Non-
circulating checkbox on the Item Record workform - Circulation view. An advant-
age of this method is that patrons can see that an item is non-circulating in their
PAC search results. You can set a special PAC description for these items. See
View circulation status names and edit descriptions.

» To make some items non-circulating for certain patron codes only, create a non-cir-
culating loan period code. See Add a loan period code. Then assign the loan period
code to the appropriate patron codes, and specify a Units value of 0 for each
restricted patron code. See Add a loan period.

When a patron attempts to check out a non-circulating item, a block appears. If the
circulation staff member overrides the block, and the item itself is non-circulating,
Polaris assigns a loan period according to the loan period code in the item record. If the
circulation staff member overrides the block, and the item is non-circulating for
specified patron codes, Polaris assigns a loan period of one time unit as defined in the
Loan Periods table.

Renewal Parameter Settings

The Renewal: Calculate based on due date parameter determines how Polaris
calculates due dates for renewals. You can set this parameter at the System level in
Polaris Administration (staff client) by going to Parameters > Patron Services.

To calculate the due date for renewals by adding the

Set the parameter to

loan period to

Today's date No

The due date Yes
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Notes:

» By default, the parameter is set to No.

» This parameter does not apply to automatic renewals. Due dates for
auto-renewals are calculated by adding the loan period to the due
date. For information about auto-renewals, see Automatic Renewal
Process.

For more information about Patron Services parameters, see Patron Services
Parameters Reference.
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Defining Loan Period Codes

The Loan Period Codes policy table sets the loan period codes for an organization.
These codes are the names assigned to the various loan periods established by each
organization. They are used in combination with patron codes to calculate due dates
and fine amounts. The loan period codes are displayed as selections in the Loan
Periods policy table, Fines policy table, and Loan period code box on the Item Record
workform.

The Loan Period Codes policy table can be displayed on an organization workform or
with the Administration Explorer. Loan period codes can be added from the system,
library, and branch levels, but they are then available to all organizations. You cannot
delete loan period code entries in Polaris Administration, but the system administrator
can change the Loan Period Codes table using the Query Analyzer in SQL Server.

Note:

These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify loan
period codes table: Allow.

See: Add a loan period code.

Add a loan period code
To add a loan period code to the Loan Period Codes policy table:

1. Inthe Administration Explorer tree view, open the Policy Tables folder for the
organization, and select Loan Period Codes. The Loan Period Codes table is dis-
played in the details view.
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2. Click to display the Insert Loan Period Codes dialog box.
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3. Type the name describing the loan period in the Description box.

Note:
Loan period codes can be numbers, abbreviations, or full descriptions.

4. Click OK on the dialog box. The Loan Period Codes policy table appears with the
new loan period name. The status bar indicates that the modification is pending.

5. Select File > Save to save your changes. The status bar indicates that the record is
saved. The new loan period code appears in the policy table for every organization
in the system.

Related Information

* Modify a table entry - Select an entry, click , and change the description. You
should limit your changes to correcting spelling or using a different choice of
words for the same loan period code.

Important:
Any changes to an existing loan period code are immediately applied to all
records using the original code.
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» Set up loan period durations - See Defining Loan Period Durations. Default loan
period durations are set with the Patron Services parameter Fine and Loan period
defaults.
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A loan period specifies how long an item can be checked out, based on the loan period
code assigned to the item and the patron code of the person checking out the item. You
can specify a different time period for each combination of loan period code and patron
code. You can have only one loan period for a specific loan period code/patron code
combination in each branch.

Loan periods are defined by entries in the Loan Periods policy table, which can be
displayed on an organization workform or with the Administration Explorer. Loan
periods can be set from the system, library, and branch levels. However, entries are
assigned to specific branches, and you specify loan periods for each branch. Your
setting for governing library determines which branch’s settings are used in calculating
the loan period. The default is the item'’s assigned branch.

When the table is opened at the system level, you can view, add, or change entries for
any branch. At the library level, you can view, add, or change entries for the branches
associated with the library. At the branch level, you can view, add, or change entries for
the selected branch. You cannot delete loan period entries in Polaris Administration.
The system administrator can change the Loan Periods table using the Query Analyzer
in SQL Server.

Note:

The following System Administration permissions are required to modify
this table: Access administration: Allow, Access tables: Allow, Modify
loan periods table: Allow.

See: Add a loan period

Add a loan period
To add a loan period in the Loan Periods policy table:
Note:

You must set up the Loan Period Codes policy table (see Defining Loan
Period Codes) and Patron Code policy table (see Defining Patron Codes)
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before you do this procedure. Default loan period values are set with the
Patron Services parameter Fine and Loan period defaults, and the default
value is used when you add a new loan period code until you change it.

1. Inthe Administration Explorer tree view, open the Policy Tables folder for the
organization, and select Loan Periods. The Loan Periods table is displayed in the
details view.

Note:

To better manage memory, a program-defined row limit determines
whether this table can be opened at a specific organizational level. For
example, if the table is opened at the system level and would require more
than the limit (comprising entries from all branches) to be loaded, you will
see a message advising you to open the table at a lower organizational
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2. ClicklL2 to display the Insert Loan Periods dialog box.
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3. Select the branch for which you are assigning the loan period in the Organization
list.

Note:
If the Loan Periods policy table is opened at the branch level, only the
branch name is displayed in the Organization list.

4. Select the patron code for the loan period in the Patron Code box.

5. Select an entry in the Loan Period Code box to associate with the patron code
shown in the Patron Code box.

Note:
The options available in the Load Period Code box depend on the
organization you selected. See Defining Loan Period Codes.

6. Select one of the following loan duration units in the Time Unit box:

e Days
e Hours
e Minutes

7. Type the number of time units allowed for this loan period in the Units box.

Note:
To set up a non-circulating loan period code, type 0 in the Units box.

8. Click OK in the dialog box. The Loan Periods policy table appears with the new
loan period entry. The status bar indicates that the modification is pending.

9. Select File > Save to save your changes. The status bar indicates that the record is
saved.

Related Information

’ Modify a table entry - Select the entry and click .You can change the loan
period code and duration in an entry; the assigned library and patron code cannot
be changed in an existing loan period.

» Set recurring or specific due dates by patron code only - See Setting End-of-Term
Due Dates.
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» Undefined loan period - You can set a default value to use at check-out when a spe-
cific patron code/loan period code combination does not exist in the Loan Periods
table. See Undefined and Standard Loan Periods.

» Lending library schedule - Due date calculation takes into account the closed
dates, closed days, and hours of operation for the lending library. See Closed
Dates and Days.

» Hourly loans - The Patron Services parameter Overnight loan period affects the
date and time due for hourly loan items. See Hourly Loans.
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Setting End-of-Term Due Dates

To prevent items from circulating after a specific or recurring date, regardless of the
item’s loan period, your library can set an end-of-term (EOT) due date. Academic
libraries and public libraries that work with schools may use this feature to make sure
that no items are due after the last day of a term. Libraries may also use an EOT date to
gather all circulating material by a certain date for inventory or another special purpose.
You can include or exempt specific patron codes from a selected EOT date.

The staff client and Leap check system administration for end-of-term due date
settings.

End-of-term dates affect circulation transactions in the following ways:

« If you attempt to check out or renew an item with a due date after the next EOT
date, the item is assigned the EOT date. However, if a patron with an exempted pat-
ron code (such as a faculty member) is checking out the item, the due date can be
after the EOT date.

» To override an EOT date for an item, you can assign a special loan period at check-
out or renewal. See the Patron Services PDF Guide, Assign a special loan period.

» By default, Polaris uses the EOT date of the item’s assigned branch, not the EOT of
the check-out branch. You can set a different governing library for the calculation.
See the PAC Customization PDF Guide, Governing Library for Circulation Trans-
actions.

You set EOT dates with the Patron Services parameter End-of-term due date options,
which is available at the system, library, and branch levels.

See: Set an End-of-Term Due Date

Set an End-of-Term Due Date
To set an end-of-term due date:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the Patron Services tab in the details view.
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Important:

Although you can set EOT dates at any organizational level, settings made
at higher levels do not display at the branch level but may nevertheless
override branch-level settings. To avoid this issue, set all EOT dates at the
branch level, especially if different organizations need different dates.

. Double-click the parameter End-of-term due date options to display the End-of-
Term Due Date Options dialog box.

. Click New. The End-of-Term Due Date dialog box appears.

. Choose one of the following options to set the EOT date:

» To set one numeric date, click Specific date, and select the date from the cal-
endar in the Specific date box.

Example:
Friday, December 16, 2011

» To set the date by day of the month, click The and select a value in
each of the three boxes (order, day, and month).

Example:
The third Friday of December

. If you want the date to be a recurring date, select the Recurring date checkbox,
and choose one of the following options:

» To stop the EOT date from functioning after a specific number of occur-
rences, click End after and type the number in the occurrences box.

» To stop the EOT date from functioning after a specific year, click End after
year and type the year in the box.

» To keep the EOT date functioning indefinitely, click Never end.

. Click OK. The End-of-Term Due Date Options dialog box appears. The EOT date is
listed in the left panel of the dialog box.

. To prevent the EOT date from applying to specific patron codes, select the EOT
date and do one of the following:

» To exclude certain patron codes from all EOT dates, in the Patron codes to
exclude list, select the checkbox next to each patron code for which EOT
dates should not apply.
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» To exclude certain patron codes from the selected EOT date only, select the
Separate exclusions checkbox, then select the checkbox next to each patron
code to exclude.

Repeat steps 3-7 for each EOT date you want to create.
Click Save.

The Administration Explorer appears.

Select File > Save to save your changes.

Related Information

Edit an end-of-term due date - On the End-of-Term Due Date Options dialog box,
select an EOT date in the list, and select one of the following options:

To change the date and recurrence information, click Edit. The End-of-Term Due
Date dialog box appears. Make any changes, and click OK.

To change the patron codes excluded from the selected EOT date, select the
Separate exclusions checkbox, and select or clear the checkboxes next to the pat-
ron codes.

To change the patron codes excluded from all EOT dates, clear the Separate exclu-
sions checkbox, and select or clear the checkboxes next to the patron codes.

Delete an end-of-term due date - On the End-of-Term Due Date Options dialog box,
select the EOT date in the list, and click Delete. The EOT date is cleared from the
list.

Display a message at circulation - When a normal due date is shortened due to an
End-of-Term date setting, you can set Polaris to display a message. Set the Patron
Services parameter Due date truncated: Prompt to Yes at the system, library, or
branch level.
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Defining Fines and Fees

Administration tables and parameters, combined with settings in the item and patron
records, control how fines are calculated. The Administration settings are established
when Polaris is first installed, but you can change them when a library or branch is
added to the system, or when lending policies change.

Polaris Administration tables define patron codes and item fine codes, and determine
the relationship between them. Patron codes and fine codes are shared by all libraries to
make circulation consistent throughout the system. However, each branch in the system
can establish different policies concerning fines for specific combinations of patron and
item fine codes.

If an item is overdue at check in, the fine is automatically calculated based on these
settings and posted to the patron’s account. You can also set Polaris to waive fines
automatically for items recovered at check out or renewal.

Important:
You set which branch’s policies are used in fine calculation with the
system-level Patron Services parameter Consortium Circulation.

Note:
Set the criteria that determine due dates before you set up fines.

The library may also define fees that are unrelated to fines. For example, you can charge
patrons for hold requests, equipment rental, damaged or lost items, and checkout and
renewal for certain types of items. You can charge a tax rate on those fees.

In Polaris Administration, you can set up the default fees, fee descriptions, and tax rates
at the system level. At the branch level, you can determine which fee reasons are
available to staff. You can also set up default replacement and processing fee amounts
for items the library does not expect to recover, and how to handle overdue charges on
lost items. You can use additional settings to control how the system processes the
charges associated with lost items when the items are recovered at circulation.

If your library's policy limits the amount that can be accrued for overdue fines, you can
use a system-level parameter to specify a limit on the overdue fine balance. If you set an
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overdue fine limit, then the overdue fine balance in all patron accounts never exceeds
this limit.

See also:

e Calculating Overdue Fines

o Setting Fine Codes

e Setting Fine Amounts

» Defining Fee Descriptions

o Setting Tax Rates

o Setting Replacement Fee Defaults

e Overdue Fines on Lost Items

o Setting Lost Item Recovery Defaults

e Charging for Checkout and Renewal

e Setting a Maximum Overdue Fine Balance Limit
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Calculating Overdue Fines

Overdue fines are calculated when the item is checked in and the check-in date/time is
past the due date/time. Ordinarily, for daily and weekly loans, a fine is calculated if an
item is returned the day following the due date. The patron has until the end of the due
date to return the book, even if the check-out time was early in the day. For hourly loans,
a fine is calculated according to the exact time due. The Fines policy table associates
patron codes with fine codes to determine the fine for the overdue item (see Setting
Fine Amounts).

Note:

If no fine can be determined in the Fines table, a message at check-in
indicates that the fine cannot be calculated. The check-in clerk can set a
fine manually, using the Overdue Amount box on the Resolve Billed Item
dialog box, or by adding an entry in the Patron Status workform - Account
view for the patron.

Fine calculations are also affected by dates closed, days designated as not fineable,
free days, and grace periods.

Dates Closed

For each organization, the Dates Closed policy table defines specific closed dates that
fall when the organization might otherwise be open. For more information, see the
Polaris Administration PDF Guide, Identifying Dates Closed. You specify which branch’s
entries in this table are used in fine calculation with the system-level Patron Services
parameter Consortium Circulation. For details, see Defining Fines and Fees.

Example:

A library designates January 1 as a closed date. If an item is returned to
that library on January 2, 2017, fines are not charged for January 1, based
by default on the setting for the receiving branch (and regardless of the
setting for the item'’s assigned branch).

Important:
The system uses dates defined at the system or library level if none are
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defined for the governing branch. For consistent results, you may want to
leave the Dates Closed policy table empty at the system and library levels
and set dates only at the branch level, or set the same dates at the
system, library, and branch levels.

Days Not Fineable

You can designate specific days of the week as not fineable with the Patron Services
parameter Days not fineable. You can set this parameter at the system, library, or
branch level. You specify which branch'’s setting for this parameter is used in fine
calculation with the system-level Patron Services parameter Consortium Circulation
(see Defining Fines and Fees).

Example:

A library designates Sunday as a “day not fineable” because the library is
closed. If an item is due on Saturday and returned at the branch on
Monday, fines are not charged for Sunday, based by default on the setting
for the receiving branch (and regardless of the setting for the item’s
assigned branch). No Sunday is calculated in a fine. For a book seven
days overdue, the fine is calculated for six days because Sunday is not
counted. For a book 14 days overdue, the fine is calculated for 12 days.

Important:

The system uses days defined at the system or library level if none are
defined for the governing branch. For consistent results, you may want to
leave the Days not fineable parameter set to None at the system and
library levels and set days only at the branch level, or set the same days at
the system, library, and branch levels.

Free Days

Free days are omitted from the overdue fine calculation during normal, bulk, or offline
check in, and are typically set to cover unexpected closings. Libraries that allow items to
be returned to non-Polaris libraries may find this feature especially useful; using the Free
Days calendar control, staff can pick the date the item was returned at the non-Polaris
library and the correct number of Free Days is automatically applied. The following
Patron Services parameters control free days; you can set them at the system, library,
and branch levels:
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Note:

The governing library for fine calculation setting does not affect the free
days parameters. The system always uses the free days settings of the
receiving branch.

» Free days (normal) - Determines the default number of free days for normal check
in. Staff members with the appropriate permission can change the setting at nor-
mal check in (Check In workform - Normal view) using the Free days box or cal-
endar on the workform. The new setting applies to the current check-in session.

 Free days (bulk) - Determines the number of default days for bulk and offline
check-in. This setting also applies to check in or renewal from the Patron Status
workform - Items out view, the item record, Find Tool, and during check out when
an item already checked out to one patron is checked out to another. Staff mem-
bers with the appropriate permission can change the setting at bulk check in
(Check In workform - Bulk view) and when uploading offline transaction files (Book-
mobile workform) through the Free days box or calendar on these workforms. The
new setting applies to the current check in or offline upload session, and does not
affect check in from any other workform or the Find Tool.

When an item is billed and declared lost, no free days are applied to the overdue fine
calculation.

A check-in transaction subtype indicates how many free days were applied when the
item was checked in. Also, if the patron was charged overdue fines when the item was
checked in, the Properties dialog box for the charge in the patron account shows how
many free days were applied and the amount that was deducted for the free days. To
open the dialog box, right-click the charge in the Patron Status workform - Account view.

Grace Periods

A grace period allows a patron to return an item just a little late without incurring a fine.
The item is still marked as overdue in the patron record. Grace periods are set in
association with specific patron code/item fine code combinations in the Fines policy
table. For more information, see Setting Fine Amounts. A grace period differs from free
days in that free days are omitted from the overdue fine calculation no matter when the
item is checked in, whereas if an item is checked in after a grace period, the fine is
calculated from the day or hour after the item due time.

Example:
If an item is checked out at 10:12 A.M. on Monday and circulates for a
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week, it becomes overdue at 12:00 A.M. on Tuesday (one minute after
11:59 P.M. on Monday). There is one grace day. Due to the grace period,
the patron is not charged an overdue fine if the item is returned on or
before 11:59 P.M. on Tuesday. If the item is returned after 11:59 P.M. on
Tuesday, the patron is charged for one day overdue.

You can optionally include closed days and dates in your system'’s grace period
calculations. Set the system-level Patron Services parameter Overdues: Add closed
days/dates to grace days to Yes to include these in the calculation. The default setting
is No.

If you set the option to Yes, and the grace period includes one or more “days closed” as
defined in the Patron Services parameter Hours of Operation or “closed dates” as
defined in the Dates Closed policy table according to the governing library for fine
calculation, the grace period will be extended by the number of closed days or dates. For
example, if the number of grace days is 2 and if Sunday is a closed day, no fine will be
assessed if the item is due on Friday and returned on Monday. But if Overdues: Add
closed days/dates to grace days is set to No (the default value), only the two grace
days, Saturday and Sunday, would be considered, and the fine would be assessed if
returned on Monday.

Important:

The Free Days setting and the calculation of the actual fine amount are
not affected by setting Overdues: Add closed days/dates to grace

days to Yes. The grace period exempts the patron from the fine, but if
grace days are exceeded, the fine is calculated as if there were no grace
period.

Waiving Fines Automatically at Circulation

Two system-level Patron Services parameters control whether fines are waived
automatically when items are recovered at circulation. To automatically waive the fine if
an overdue item is found during check-out, set Overdues: Clear fine if recovered at
check-out to Yes. To automatically waive the fine if the patron is renewing an overdue
item, set Overdues: Clear fine if recovered at renewal to Yes. Both parameters are set
to No by default. (These settings also apply to SIP self-check units.)
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Note:
Separate settings control how overdue fines for lost items are handled.
See Overdue Fines on Lost Items.

Charging Fines Automatically at Check In

The Patron Services parameter Check in: auto-charge fine from item work form and
find tool context menu, controls whether overdue fines are automatically charged to the
patron account when overdue items are checked in from the ltem workform, the Find
Tool context menu, or the Patron Status workform - Items Out view. The parameter is
available at the system, library, and branch levels and is set to Yes by default.

When the parameter is set to Yes and an overdue item is checked in, the fine is
automatically charged to the patron account. If the overdue item can fill an active hold
request, the hold request message appears and the staff member takes action on the
hold request message. (When the parameter is set to Yes and a billed item is checked
in, the Resolve lost/billed item dialog box appears, the staff member resolves the billed
charges, and the item is checked in. If the billed item can fill a request, the hold request
message appears before the Resolve lost/billed item dialog box. The staff member
takes action on the hold request message first.)

If the parameter is set to No, the Check In - Fine dialog box appears when the item is
overdue, and the staff member resolves the fine accordingly. However, if the item can fill
a hold request, the hold request message always appears first.

Fines for Claimed Items

A system-level Patron Services parameter controls whether fines are charged if an
overdue item with a status of Claimed Returned or Claimed Never Had is checked in or
checked out. To automatically waive overdue fines for these items at circulation, set
Overdues: Charge fines for claimed items to No. This setting waives fines for overdue
claimed items found at renewal, normal and offline check in and check out, and Polaris
ExpressCheck check out. The parameter is set to Yes by default.

Setting a Maximum Overdue Fine Balance

If your library policy is that overdue fines cannot accrue over a certain dollar amount in
the patron overdue fine balance, you can set a limit. See: Setting a Maximum Overdue
Fine Balance Limit.
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Fine codes represent the various fine policies used in combination with patron codes to
determine fine amounts. Fine codes are displayed as selections in the Fines policy table
and the Fine code box on the Item Record workform.

Fine codes are defined as entries in the Fine Codes policy table, which can be displayed
on an organization workform or with the Administration Explorer. Fine codes can be
added from the system, library, and branch organization levels, but they are then
available to all organizations. You cannot delete fine code entries in Polaris
Administration, but the system administrator can change the Fine Codes table using the
Query Analyzer in SQL Server.

Note:

These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify fine
codes table: Allow.

See also: Add a fine code

Add a fine code
To add a fine code in the Fine Codes policy table:

1. Inthe Administration Explorer, open the Policy Tables folder for the organization,
and select Fine Codes. The Fine Codes table is displayed in the details view.

2. Click to display the Insert Fine Codes dialog box.

Insert: Fine Codes

3. Type text describing the fine code in the Description box.
4. Click OK on the dialog box. The Fine Codes policy table appears with the new fine
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code name. The status bar indicates that the modification is pending.
5. Select File > Save to save your changes.

The status bar indicates that the record is saved. The new fine code is available to
all organizations and appears in the Fines table. See Setting Fine Amounts. Default
fine amounts, maximum fine amounts, and grace periods for new fine codes are
set with the Patron Services parameter Fine and Loan period defaults.

Related Information

Modify a table entry - Select the entry, click , and change the description.

......

Important:
Any changes to an existing fine code are immediately applied to all
records using the original code.
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Fine amounts are set based on the patron code of the person being charged and the fine
code assigned to the item. You can specify a different fine amount for each
combination of patron code and fine code, as well as a maximum fine and a grace
period for each combination (see Grace Periods).

Since fine amounts are defined using patron codes, fine codes, and loan periods, you
must set up the Patron Codes, Fine Codes, and Loan Periods policy tables before you
can define fine amounts. See: Defining Patron Codes, Defining Loan Period Durations,
and Setting Fine Codes.

Fine amounts are set with entries in the Fines policy table, which can be displayed on an
organization workform or with the Administration Explorer. Fines can be set from the
system, library, and branch levels. However, entries are assigned to specific branches,
and you specify fines for each branch in Polaris. You specify which branch’s entries in
this table are used in fine calculation with the system-level Patron Services parameter
Consortium Circulation. See: Defining Fines and Fees.

When you open the table at the system level, you can view, add, or change entries for
any branch. At the library level, you can view, add, or change entries for the branches
associated with the library. At the branch level, you can view, add, or change entries for
the selected branch. You cannot delete fine entries in Polaris Administration. The
system administrator can change the Fines table using the Query Analyzer in SQL
Server.

Note:

These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify fines
table: Allow.

See also: Add a fine amount

Add a fine amount

To add a fine amount to the Fines policy table:
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Note:

The default fine amount, default maximum fine, and default grace period
are set with the Patron Services parameter Fine and Loan period defaults,
and when you add a new fine code the default value is used until you
change it. If for some reason a fine amount cannot be calculated, the
setting for the system-level parameter Undefined Fine Amount is used.
This setting is also used automatically when a new organization or patron
code is added to the table.

1. Inthe Administration Explorer, open the Policy Tables folder for the organization,
and select Fines. The Fines table is displayed.

Note:

To better manage memory, a program-defined row limit determines
whether this table can be opened at a specific organizational level. For
example, if the table is opened at the system level and would require more
than the limit (comprising entries from all branches) to be loaded, you will
see a message advising you to open the table at a lower organizational
level.

2. Click to display the Insert Fines dialog box.

3. Select the organization for which you are assigning the fine in the Organization
box.

Note:
If the Fines policy table is opened at the branch level, only the branch
name is displayed in the Organization list.

4. Select the patron code for the fine amount in the Patron Code box.

5. Select a fine name in the Fine Code box to associate with the patron code shown
in the Patron Code box. The options available in the Fine Code box depend on the
organization you selected. See Setting Fine Codes.

Note:

If a relationship between the patron code and fine code cannot be found
in the Fine Code policy table, Polaris uses the setting in the Patron
Services parameter Undefined fine amount, which is set at the system
level. The default value is $5.00. This value is also used to automatically
populate the table if a new branch or patron code is added.
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6. Inthe Amount box, type the amount of money to fine for a single loan period unit
for the item.

Example:
The loan period unit for a certain type of item is daily. To set up a fine of
10 cents per day, type $0.10 in the Amount box.

Loan period units are defined in the Loan Period policy table. See Defining Loan
Period Durations. Polaris uses the loan period unit for which an item was charged
and the value you put in the Amount box to calculate the fine.

7. Inthe Maximum Fine box, type the total amount that can be fined for items asso-
ciated with this fine description and charged to the selected patron code.

8. Inthe Grace Units box, type the number of loan period units allowed for an over-
due item before Polaris begins calculating a fine.

Note:

The actual time specified by the Grace Units setting depends on the loan
period unit used when the item was checked out. For example, if the item
is checked out for 14 days and the grace unit is 1, then the grace period is
one day. Any items returned the day after they were due are not charged
an overdue fine. A grace period of 0 means that items must be returned
by the end of the date they are due. Otherwise, overdue charges apply.
Loan period units are defined in the Loan Period policy table.

9. Click OK in the dialog box. The Fines policy table appears with the new fine name.
The status bar indicates that the modification is pending.

10. Select File > Save to save your changes. The status bar indicates that the record is
saved.

Related Information

Modify a table entry - Select the entry and click . You can change the amount

. iali

of the fine, maximum chargeable fine, and the grace period for an existing fine
entry.

» Days not fineable - The Patron Services parameter Days not fineable affects fine
calculation. See Days Not Fineable.
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» Free days - Patron Services parameters related to free days also affect fine cal-
culation. See Free Days.

» Fees - The library may charge patrons for reasons unrelated to fines for overdue
materials. For more information, see Defining Fee Descriptions.
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Defining Fee Descriptions and Tax Rates

Fees are charges that are unrelated to overdue fines. Examples of fees include patron
registration charges or the price of a pair of headphones. Tax rates are for libraries that
charge a Goods and Services Tax (GST). Using the Fee Descriptions policy table, you

can:

» Enter fee descriptions so library staff can select them from a predefined list.

» Set a default amount for each fee description.

» Set a tax rate for each fee description.

Entries in this policy table appear as selections on workform views and dialog boxes
where you handle patron charges, such as the Reason list from which you can select a
fee reason when adding a charge to a patron's account. Entries also appear in Leap.

2HES X P33 & [0 @

Acct charges:
Acct credit:
Items out:
Total overdue:
Claims Lost:

Barcode: | 1229195408668

§52.00
$0.00
1}

[t}

Name:

Patron code:
Registered branch:
Expiration date:
Registration date:

Nasir Aziz

Regular ~
Red Rock Library

7/31/2017

7/31/2014

Items held: Charge
Total holds/ILL:
Amount: 0,00 Reason:
Account Check Out Charge
Assodated item: Borrow By Mail Charge
Patron Registration Fee
Notes: Polaris Fusion Purchase
Date (for internal use) Credit Card Processing Charge rganization  Note
Processing Charge
4/26/2017 1:4... Cverpayment ommunity ..
4/26/2017 134.., Credit Refund led RackL...
[]send a bil oK Hald Request
Collection Agency
Replacement Cost
Overdue Item
Case [ Cover
Copy [ Print
Damage
ILL
Manual Fine
New Card
Phone ( Fax
Postage
Rental
Balances Misc Charge
Charges: $52.00 | Deposits: $0.00 | Credits: $0.00 Misc test charge Balance: §52.00

mm
Misc

You must go to the Administration Explorer to view the Fee Descriptions policy table. All
organizations in a Polaris installation must agree on the fee descriptions. You can add
and change entries in the Fee Descriptions policy table, but you cannot delete them.
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You can create fee descriptions at the system and library levels, but the entries are
assigned to the system. You must be working at the system level to configure tax rates
and default fee amounts for fee descriptions. Tax rates and default fee amounts do not
appear in the library or branch level Fee Descriptions policy tables.

At the branch level, you can set which reasons are available to branch staff and
determine the order of the branch-level selections. Some libraries prefer alphabetical
order; others prefer to put the most commonly used selections first. You can also edit
the description display text, however the system applies these changes system-wide.

Note:

These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify fee
descriptions table: Allow.

See also:

» Add a fee description and tax rate entry

» Set fee descriptions for branch-level display

Add a fee description and tax rate entry

Fees are charges that are unrelated to overdue fines. Examples of fees include patron
registration charges or the price of a pair of headphones. Tax rates are for libraries that
charge a Goods and Services Tax (GST). For overview information, see Defining Fee
Descriptions and Tax Rates.

To add a fee description to the Fee Descriptions policy table:

Note:
Check existing descriptions before you add a new one. You cannot delete
duplicate descriptions.

1. Inthe Administration Explorer, open the Policy Tables folder for the organization,
and select Fee Descriptions. The Fee Descriptions table is displayed in the details
view.

Note:
In the Fee Descriptions table, ID numbers preceded by a minus sign are
supplied by the system and used in system processes.
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Click to display the Insert Fee Descriptions dialog box.

. Enter text describing the type of fee in the Fee Description box.

4. Enter a Default Amount.
Default amount starts as $0.00.

5. (Optional) Select a Tax Rate.

7. Click OK.

If this fee description includes a tax rate, select Yes. Otherwise, select No.

The Fee Descriptions policy table appears with the new fee description name. The
status bar indicates that the modification is pending.

8. Select File > Save to save your changes.

The status bar indicates that the record is saved.

Related Information

* Modify a table entry - Select the entry, click , and change the description.

Important:

» The system immediately applies any changes to an existing fee
description or tax rate to all records using the original fee.

» A changed tax rate might not appear in Leap unless you perform an
IISRESET, clear the browser's cache, and refresh the page.

» For accounting purposes, do not update fee descriptions that have
been used for charges on patron accounts. If you make changes to
fee descriptions, the system applies those changes to past charges

and new charges.

» Set branch-level display - See Set fee descriptions for branch-level display.

© 2023 Innovative (Part of Clarivate)

Page 279



Patron Services Administration Guide

» Replacement fees - You can set a default replacement fee amount and a pro-

cessing fee amount for items the library cannot recover. See Setting Replacement
Fee Defaults.

Set fee descriptions for branch-level display

Fee descriptions are displayed to staff for selection when the staff member adds a
charge to the patron account.

To set the fee descriptions that should display to staff at a specific branch, edit the fee
descriptions, and determine the order of entries in the fee reason list:

1.

In the Administration Explorer, open the Policy Tables folder for the branch, and
select Fee Descriptions. The Fee Descriptions table (branch-level version) is dis-
played in the details view. At the branch level, the table displays a Selected
column, indicating whether an entry is displayed for staff selection, and a
Sequence column, indicating the entry’s position on the list of reasons.

To change an entry’s display setting, select the entry and click or double-click
the entry. For example, if the branch does not use Borrow by Mail, you may want to
suppress Borrow by mail charge from display in the fee reasons list.

The Modify fee descriptions dialog box opens.

Modify : Fee Descriptions - -1

Fee Description: IReplacement Cost
Sequence 12
Selected Yes -

Select Yes or No in the Selected box to display or suppress the fee reason.

. To modify the description, type the new description in the Fee Description box.

Note:
The modified description is displayed only at the branch for which you
made the setting. It is not changed at the system level.

5. Click OK.

To move an entry up or down in the selection list, select the entry and click the up
or down arrow at the top of the table.
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File

Edit

Help
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Administration Explorer - System Fee Descriptions
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7. Select File > Save to save your changes.
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Setting Replacement Fee Defaults

When a patron must be charged to replace a lost, damaged, or long overdue item,
Polaris can use the original price of the item or a default cost set by library policy. If the
item’s original price is unknown (the Price box on the ltem Record workform is blank),
the default replacement cost is used. (If the item'’s price was $0.00, no replacement cost
is charged.) You may choose to use the default replacement cost for every item,
whether the original price is known or not. In addition, you can specify a processing fee
that is added to the replacement cost. You can set separate replacement costs and
processing fees for each material type.

The Patron Services parameter Replacement fee options controls default cost settings.
You can set the parameter at the system level, library, or branch level. When an item is
manually declared lost, or is automatically declared lost when it is billed, the
Replacement fee options settings for the item’s assigned branch are used. The settings
for the governing branch for fine calculations are used to calculate the overdue fine, if
any. See Defining Fines and Fees.

See also: Set the replacement charge defaults

Set the replacement charge defaults
To set the defaults for item replacement charges:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Replacement fee options to display the Replacement Fee Defaults
dialog box.
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(@) Use item record price field or default () Use defaults only

. Replacement
Material Type Cost

Audiobook £25.00 £0.00
Book £25.00 £0.00
Book and CD £20.00 £5.00
Children’s Video 5$25.00 50.00
eBook £20.00 £5.00
Equipment £25.00 20.00
Kelie R-Rated Realia £25.00 £0.00
Kellie Rental Manuscript £25.00 50.00
Kelie Rental Score £25.00 £0.00
Kit - Audiovisual £25.00 £0.00
Kit - Realia £25.00 £0.00
Map £25.00 £0.00
Museum Pass £20.00 £5.00
Music £25.00 £0.00
Mew / Popular Book £25.00 50.00
Perodical £25.00 £0.00
Picture, Photo £25.00 £0.00
really long material type for testing dis... | $20.00 5500

Processing Fee

0K Cancel

3. Choose how replacement charges should be calculated:

» To use the original purchase price (if specified in the item record), click Use item
record price field or default. If the original purchase price is not available for the
calculation, the value specified in the Replacement cost field for the material type
is used.

» To always use the replacement cost for the material type, and ignore actual pur-
chase prices, click Use defaults only.

Note:
If the original purchase price is specified in the item record as $0.00 (the
item was free), no replacement cost is charged.

4. For each material type, in the Replacement Cost field, type the standard replace-
ment value that is specified by library policy.

5. For each material type, in the Processing Fee box, type the amount to charge a pat-
ron for processing a replacement item.

6. Click OK on the dialog box.
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Overdue Fines on Lost Items

An item may be declared lost in the following situations:

» A patron notifies the library that a checked-out item is lost. Then a staff member
manually declares the item lost.

« Billed items may be declared lost automatically, a system-level decision. (If they
are not automatically declared lost, a staff member may manually declare a billed
item lost.)

The Patron Services parameter Lost item charge options determines how overdue fines
are handled at the time an item is billed and automatically set to lost, or when a staff
member declares the item lost.

Most options controlled by the Lost item charge options parameter are available at the
system, library, and branch levels. The governing library setting for fine calculation
determines which library’s settings rule lost item charges. For more information about
governing library settings, see Governing Library for Circulation Transactions.

Settings for Lost Item Charge Options
The Lost item charge options parameter offers the following settings:

» Overdues: billed items set to lost - System level only. Setting the item status to
Lost at the time the item is billed will ensure the most consistent results for lost
item recovery. However, leave this option unchecked if libraries in your system
prefer to declare the item lost manually.

» Charge overdue with bill - For best results, check this option if it is available (not
grayed out). When this option is selected, the overdue charge is included in the bill
regardless of whether the billed items are set to lost. If you prefer not to charge
overdues with the bill, select the option Charge overdue when returned. The
replacement fee and optional processing fee will still be billed. If your library has
set a system-wide limit for the maximum fine balance, it is recommended that you
do not select this option.

» Charge overdue when declared lost - Like Charge overdue with bill, this option is
available only if Charge overdue when returned is not set. For best results, check
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this option if it is available. If the library does not charge overdues when items go
to Lost as a matter of policy, the option Charge overdue when returned should be
checked instead.

» Charge overdue when returned - Select this option if the library policy is to charge
the overdue fine only if and when the lost item is returned. If you select this option
but do not set Overdues: billed items set to lost, the library charges the overdue
fine when a lost item is recovered but does not assume an item is lost until the pat-
ron comes in and says he cannot find it. In this situation, you will see the following
effects:

° No automatic lost item recovery options are possible because the item’s
status is not Lost.

° The patron is billed for the replacement cost and optional processing fee.
However, the overdue fine remains uncharged and unresolved.

° If the patron brings the item back, a staff member checks the item in and
waives the replacement and optional processing fees. The overdue fine is
calculated at that time and the staff member pays, waives, or charges the
overdue fine.

° If the patron says he cannot find the item, the staff member declares the
item lost on the Patron Status workform - Items out view, then pays, waives
or leaves the replacement and optional processing fees; the overdue is cal-
culated at that time. The item is now lost, so lost item recovery options may
apply (see Setting Lost Item Recovery Defaults). (If the staff member does
not declare the item lost, it stays out to the patron until checked in and the
overdue fine is calculated at that time.)

Policy Decisions for Lost Item Charge Options
Different combinations of settings reflect your library’s policy:
« If you want to include overdue fines with the bill, and billed items are automatically
set to lost, select the following options:
o Overdues: billed items set to lost (system level only)
o Charge overdue with bill
° Charge overdue when declared lost

« If you want to include overdue fines with the bill, and billed items are not auto-
matically set to lost, select the following options:
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o Charge overdue with bill - This option should not be selected if your library
specifies a maximum overdue fine balance amount.

° Charge overdue when declared lost

« If you want to charge overdue fines when an item is returned, and billed items are
not automatically set to lost, select Charge overdue when returned.

« If you want to charge overdue fines when an item is returned, and billed items are
automatically set to lost, select the following options:
o Overdues: billed items set to lost (system level only)
° Charge overdue when returned

See also: Set lost item charge options

Set lost item charge options

To set whether billed items are automatically set to Lost (system level only), and how to
handle overdue charges on billed and lost items:

1. Inthe Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view.

2. Double-click Lost item charge options to display the Lost item charge options dia-
log box.

Lost item charge options [Community Library (br)]

| Overdues: Billed items set to lost (System level only)
[ charge overdue with bill
["]charge overdue when dedared lost

[ charge overdue when returned

Tip:
See Policy Decisions for Lost ltem Charge Options for suggested
combinations of settings in this dialog box.

3. (System level only) Select Overdues: billed items set to lost to make the status of
billed items automatically set to Lost.
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Note:

Set this parameter to Yes if you use collection agency services. This
ensures that if a lost item is recovered, the system reports the recovery
correctly.

4. To charge overdue fines when an item’s status changes to lost, select one or both
of the following options:

» Charge overdue with bill - If Overdues: billed items set to lost is selected for the
system, when the billed item'’s status automatically changes to Lost the overdue
charge is placed on the patron account, along with other appropriate charges
related to lost items (see Setting Replacement Fee Defaults). If Overdues: billed
items set to lost is not selected for the system, the billed item’s status remains
Out. The overdue charge and any other charges related to billed items are placed
on the patron account.

» Charge overdue when declared lost - Select this option to charge overdue fines to
the patron account when an item is declared lost by a staff member.

Tip:

When Charge overdue when returned is selected, replacement costs are
charged immediately when the item'’s status changes to Lost, but not
overdue fines. If your library uses a collection agency, the patron would be
reported only for the total replacement costs. (However, any overdue fines
already owed would be included in the collection agency calculation.)

5. To charge overdue fines to the patron account when a lost item is recovered at cir-
culation, instead of when the item’s status changes to Lost, select Charge overdue
when returned.

Note:
If you select Charge overdue with bill, Charge overdue when declared
lost, or both, this option is unavailable.

Libraries that use this option typically charge any replacement and processing
fees to the patron when the item’s status changes to Lost, but not overdue
charges. If the item is recovered, replacement and processing fees are then
waived or credited (if already paid), the overdue fine is calculated up to the point
when the item was returned, up to the maximum fine amount, and the overdue
charge is placed on the patron account.
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Important:

If you select Charge overdue when returned, set the Lost item
recovery parameter for lost-and-paid items to Charge for overdues. See
Set the lost item recovery default actions.

6. Click OK.

Related Information

» Charge resolution when lost items are recovered - See Setting Lost Item Recovery
Defaults.

 Bills - See Overdue Notices, Bills, and Combined Notices.

» Overdue fines on lost items in estimated fines - See Set up estimate accrued fine
calculations and blocking.

Setting a Maximum Overdue Fine Balance Limit

You can use the System-level Patron Services parameter Overdues: maximum overdue
fine balance to define a maximum amount for overdue fine balances so that patron
accounts never exceed a certain dollar amount for overdue fines. By default, this
parameter is disabled (set at $0.00). To enable this parameter, the amount must be set
above $0.00. Once enabled, the maximum overdue fine balance is applied at the System
level—-to all patron accounts for all branches.

When a maximum overdue fine balance amount greater than zero is entered in the
parameter, the system checks the total current overdue fine balance in patrons'
accounts before adding overdue fines. As each overdue item is checked in or renewed,
the patron's account is charged the overdue fine until the total current balance reaches
the dollar amount limit defined in the parameter. Once the limit is reached, fines for
subsequent overdue items are not added to the patron's account.

If a dollar amount is entered in the parameter, the threshold is checked when overdue
fines are assessed during check-ins or renewals from: the Polaris staff client; self-check
units (Polaris ExpressCheck and SIP); Leap; PowerPAC (renewals); and the Polaris API.

Note:

When enabled, this parameter sets the maximum dollar amount for total
current overdue fines only. The limit is applied to a patron's account at
check in or renewal; it does not apply to manually-added charges,
replacement costs or other fees.
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To set a maximum overdue fine balance amount for all patron accounts in your library
system:

1. Inthe Administration Explorer tree view, open the Parameters folder for the Sys-
tem.

2. Click the Patron Services tab in the details view.

3. Double-click Overdues: Maximum overdue fine balance, and type a dollar amount.

File Edit Help

h-=-H EY

mAdministlaﬁon Explorer - System | 2 Parameters

n Administration Explorer - Sys ~ — = N - . . . "
_& System: QA-Polaris Acquisitions / Serials| Patron Services | Cataloging | PAC | Motification | SelfCheck Unit | Request| Credit Card Payment| NCIP
Parameters
Profiles 1 c'
Pemissions
Securty Parameter Value ~
: E‘g ankzzazzbll?:bles &Overdues: Add closed days/dates 1.:0 grace days Mo
. @{E] Notification Tables &O\rerdues: Block for long overdue items Yes
+G Server &O\rerdues: Charge fines for claimed items Mo
+E¢ Librany éO\rerdues: Clear fine if recovered at check-out Mo
+ Blanch &Overdues: Clear fine if recovered at renewal Mo
g Colction MUY - Overdues: Maximum overdue fine balance __Jsoo0
< > —

4. Select File > Save to save the setting.

Notes:

If your library specifies a maximum overdue fine balance amount, it is
recommended that charges for overdue fines are not included on bills for
lost items. This is because the overdue fine amount reflected on the bill
may not be accurate. See Settings for Lost ltem Charge Options.

In addition, when a maximum overdue fine balance is set, the overdue fine
amounts displayed in the Estimated Fines dialog box may not be the
same as the actual amounts calculated at check-in or renewal. See the
Patron Services PDF Guide, Estimate fines on currently checked out items
topic.
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Setting Lost Item Recovery Defaults

When a lost item is recovered at check out or check in, the charges associated with the
item must be resolved (charged, waived, credited, or left as is, as appropriate). With the
Patron Services parameter Lost item recovery, you can set the default actions so that
the charges are resolved automatically when lost items are recovered at circulation, and
staff members do not have to resolve each item manually. Charges for lost items may
include a replacement charge, a processing fee, and an overdue charge. You can set up
separate resolutions depending on whether the charges have been paid or remain
unpaid.

The governing library setting for lost item recovery (transacting library or lending library)
determines which library’s settings rule when a lost item is recovered at circulation. The
governing library for fines determines how the overdue charges are calculated. For more
information about governing library settings, see Set fine receipt options. The
replacement charge and processing fee are calculated according to the settings for the
item’s assigned branch. See Setting Replacement Fee Defaults.

You can set separate default actions for normal check in, bulk check in, and check out.
Your settings determine how lost items are resolved in the online staff client and in the
following situations:

 Offline circulation - Uses check-out and normal check-in settings.

» Polaris ExpressCheck - If you have set Polaris ExpressCheck to permit check out
of lost items, your settings for normal check out are used. For information about
Polaris ExpressCheck settings, see the Polaris ExpressCheck Administration Guide.

Note:
SIP/NCIP circulation does not support default settings, and returns error
messages for lost items.

See also: Set the lost item recovery default actions
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Set the lost item recovery default actions

To set the automatic actions for resolving the charges associated with lost items when
they are recovered at circulation:

1.

In the Administration Explorer tree view, open the Parameters folder for the organ-
ization, and select the Patron Services tabbed page in the details view. To see the
patron services parameters list, select the appropriate level - System, Library,
Branch.

Double-click Lost item recovery to display the Lost ltem Recovery Options dialog
box. The dialog box opens with the Lost Item Recovery tab selected.

a Lost ltem Recovery Options

Lost item recover ¥ | Lost-and-paid recovery

Default action if recovered in 1 < Years v

Auto waive/charge lost item fees Owerdue fine Processing fee Replacement cost
5 : : .
Checkn- Normal mode O v v v
Check-out ] v v W

0K Cancel Help

On the Lost Item Recovery tabbed page, set the processing defaults that should
apply when lost items are recovered at circulation, but the charges related to the
items have not been paid or waived:

In the Default action if recovered in fields, specify the maximum time period for
which automatic changes to the patron account should apply. For any specific
item, the period you specify is measured from the point when the item was
declared lost. The maximum numerical value is 999 (months or years).

Important:

This feature depends on the availability of patron ID information. If your
organization purges patron ID information from transactions after a set
period of time, be sure to coordinate the settings so that the patron ID is
available if the lost item is recovered within the time period you specify.
See Removing Patron ID Information from Transaction Files.

b. Select the checkbox for each circulation situation (normal check in, bulk check in,

and check out) where you want to charge or waive lost item fees automatically.

If a lost item is recovered in one of the circulation situations you selected
before the time specified in the Default action if recovered in fields, fees are
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charged or waived automatically according to your settings. If the item is
recovered after the specified time, the circulation transaction continues but
no changes are made to the patron account.

If you do not select a circulation situation, automatic processing is not
applied, and staff members must resolve the charges when a lost item is
recovered in that situation. See the Patron Services PDF Guide, Resolve a
lost-and-unpaid item at circulation.

c. For each circulation situation that you checked, select the automatic action to take
for each fee (Overdue fine, Processing fee, and Replacement cost):

» Charge - This option leaves the charge related to the lost item unchanged in the
patron account.

» Waive - This option waives the charge in the patron account. For overdues, the
charge is placed in the patron account and then automatically waived.

The patron’s Account Transaction Summary will be updated according to the
action you specify.

Note:
For more information about setting replacement costs and processing
fees, see Setting Replacement Fee Defaults.

4. Click the Lost-and-paid recovery tab, and set the processing defaults that should
apply when lost items are recovered at circulation, and the charges related to the
items have already been paid.

azl Lost ltem Recovery Options
T | Lostand paid recovery
Default action if recovered in 1 3 Years v
Auto credt lost item fees QOverdue fine Processing fee Replacement cost
C . - -
Check-n: Normal mode O Charge - ~ v
Check-out O v ~ ~

oK Cancel Help

a. Inthe Default action if recovered in fields, specify the maximum time period for
which automatic processing should apply. For any specific item, the period you
specify is measured from the point when the item was declared lost. The max-
imum numerical value is 999 (months or years).
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Important:

This feature depends on the availability of patron ID information. If your
organization purges patron ID information from transactions after a set
period of time, be sure to coordinate the settings so that the patron ID is
available if the lost item is recovered within the time period you specify.
See Removing Patron ID Information from Transaction Files.

b. Select the checkbox for each circulation situation (normal check-in, bulk check-in,
and check-out) where you want to credit lost item fees or leave them as is auto-
matically.

If a lost item is recovered before the time specified in the Default action if
recovered in fields, in one of the circulation situations you selected,
payments are credited or left as is automatically according to your settings.
If the item is recovered after the specified time, the circulation transaction
continues but no changes are made to the patron account.

If you do not select a circulation situation, automatic processing is not
applied, and staff members must resolve the account when a lost item is
recovered in that situation. See the Patron Services PDF Guide, Resolve a
lost-and-unpaid item at circulation.

c. For each circulation situation that you checked, select the automatic action to take
for each fee (Overdue fine, Processing fee, and Replacement cost):

» Charge - For overdue fines only. This option charges overdue fines to the patron’s
account calculated from when the item went overdue to the day it was recovered.
Libraries that set the Lost item: Charge overdue when returned parameter (see
Set lost item charge options) typically charge any replacement and processing
fees to the patron when the item’s status changes to Lost, but not overdue
charges. If the item is recovered, replacement and processing fees are then
waived or credited (if already paid), the overdue fine is calculated up to the point
when the item was returned, up to the maximum fine amount, and the overdue
charge is placed on the patron account.

» Credit - This option credits the patron’s account for the payment amount related to
the lost item. If an amount was partially paid, the paid amount is credited and the
unpaid balance is waived. For payments made by credit card:

o PayPal PayFlow Link - A “dummy” refund is created instead of a credit. The
refund will appear as a refund in the Polaris patron account and a refund
transaction created. This transaction is available for reporting in the Refunds
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to Credit Card Payments report . You can use the report to cross-check trans-
actions logged in Payflow Link. (Note that the refund must also be made
from Payflow Link.) Instead of automatically crediting the patron’s account,
you may want to set the lost-and-paid item recovery options to Leave as is.
With this setting, the payments remain in the Polaris patron account and the
refund or credit can be done from Payflow Link.

o PayPal Payflow Pro - Polaris issues a refund to the credit card account.

o Payments Gateway - A "dummy" refund is created instead of a credit. The
refund will appear as a refund in the Polaris patron account and a refund
transaction created. This transaction is available for reporting in the Refunds
to Credit Card Payments report. You can use the report to cross-check trans-
actions logged in the Virtual Terminal. (Note that the refund must also be
made from the Virtual Terminal.) Instead of automatically crediting the pat-
ron’s account, you may want to set the lost-and-paid item recovery options to
Leave as is. With this setting, the payments remain in the Polaris patron
account and the refund or credit can be done from Payments Gateway. Or
your library may choose to disable all automatic recovery actions, forcing
staff to create manual refunds when a lost-and-paid item is recovered.

o Comprise SmartPay - Automatic credits are not supported. The payment is
left as is.

° EnvisionWare (integrated) - Automatic credits are not supported. The pay-
ment is left as is.

» Leave as is - This option leaves the transactions related to the lost item
unchanged in the patron account.

The patron’s Account Transaction Summary will be updated according to the
action you specify.

Related Information

Separate settings control whether overdue fines are charged when an item is declared
lost, when an item'’s status is automatically changed to lost when it is billed, or when a
lost item is recovered at circulation. See Overdue Fines on Lost Items.
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Charging for Checkout and Renewal

You can charge patrons for checking out items of specified material types and
optionally charge for renewing them, or charge only for renewal. You can also choose to
waive the charge for certain patron codes. The charge policy is applied according to the
settings of item'’s assigned branch. Your renewal settings also apply to Polaris
PowerPAC, Mobile PAC and renewals made through inbound telephony. Separate
settings determine how the charge policy affects transactions at Polaris ExpressCheck
and SIP self-check workstations.

Staff Client Transactions

For staff client transactions, you can optionally display a prompt regarding charges
during checkout and renewal as appropriate. You might also consider placing physical
labels on your chargeable items so that patrons know there is a charge before they
reach the circulation desk.

When a chargeable item is scanned at check-out or selected for renewal, the system
first checks for item blocks, holds, and patron item limits. Then, if you have set the
system to display a prompt, a Patron check-out charge dialog box is displayed.

The staff member can choose to charge the patron’s account and continue the check-
out, pay the charge, waive the charge, or cancel the transaction. The appropriate
permissions are required to pay or waive the charge. If the staff member chooses to pay
the charge, a standard Pay dialog box is displayed. The Charge for Check-out dialog box
also appears during bulk check-out of Borrow by Mail or Outreach Services items. If you
have chosen not to display the prompt, the charge is automatically applied to the patron
account. Check-out charges are not listed on the check-out receipt. If the same item is
checked out again to the same patron before the library closes, the patron is not
charged again.

If the item's assigned branch has options set to charge for renewals and charge for
overdues, the Renew chargeable overdue item dialog box opens when you renew an
overdue item.
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Renew chargeable overdue item

Item barcode: 0001900034057
Title: The golden rope
Due date: 2/10/2015

Patron barcode: 1000400883086

Mame: Mrs. Eunice K Covey

Fine

Total: $6.00

Checkout: Overdue:

Charge: £1.00 £5.00

Actions: w W

Amount: §1.00 §5.00

When a chargeable item is checked out offline, the charge is applied to the patron
account and a message is written to the upload log file.

Note:
In systems that use floating collections, the chargeable settings for an
item change as the item’s assigned branch changes.

The Patron Status workform - Account view lists check-out charges. The organization
listed with the charge is the item’s assigned branch. The charges are also listed on the
PAC My Account - Fines & Fees page.

PAC Display

Item availability display - The PAC item availability display includes an icon
next to an item if the item’s assigned branch has defined the item’s material type
as chargeable.

» Courtesy message for hold requests - When a patron places a bibliographic-level
hold request in PAC, and at least one item eligible to fill the request would incur a
check-out charge, a courtesy message is displayed. Note that the request may
actually be filled by a non-chargeable item, depending on which items trap for the
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request. If after the request is placed new items become available from a branch
that does not charge for checkout, or holds policies change, the message may no
longer be accurate. It is a courtesy message only. You can edit the message in
Polaris Language Editor (WebAdmin):

o For PowerPAC, the default message is If your request is filled you may be
charged to check out the item according to the policy of the library owning
the item. Do you want to place this request? The Polaris Language Editor
string ID is PACML_CHARGECKOREQ.

o For Mobile PAC, the default message is If your request is filled you may be
charged to check out the item according to the policy of the library owning
the item. Do you want to place this request? The Polaris Language Editor
string ID is MP_MSG_HOLDS_CHARGE_WARNING.

Renewing Items From PAC

If renewing an item is chargeable according to the settings of the item’s assigned
branch, a message is displayed when the patron attempts to renew the item from the
patron account. The patron can choose whether to continue or cancel the renewal. The
default messages can be edited in Polaris Language Editor (WebAdmin).

PowerPAC String Default Message
ID
PACML_ There is a charge to renew this item.
CHARGE_RENEW
PACML_ There is a charge to renew the following
CHARGE_ items.
RENEW_
MULTIPLE
PACML_ If you renew these items your account will
RENEWITEMS_ be charged
1347
PACML_ To accept these charges and continue
RENEWITEMS_ with the renewal, press 'OK'.
1348
PACML_ Your account has been charged.
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RENEWITEMS_
1349

Mobile PAC Default Message

String ID

MP_MSG_ There is a charge of {0} to renew this item.
ITEMSOUT_ Your account will be charged. Do you
CHECKOUT_ want to accept this charge?

CHARGE_
WARNING

MP_MSG_ Your account has been charged.
ITEMSOUT_
CHECKOUT_
CHARGE

Phone Renewal

The Polaris Phone Attendant also supports charges for item renewals, according to the
policies of the item’s assigned branch. The patron is notified of any renewal charges
and prompted to accept them. If both overdue and renewal charges will be applied, the
notification is combined in a single message. If the patron chooses to renew all items at
once (option #6), a status message informs the patron that the “renew all” process is
underway, since the process may take a few seconds to gather information. In Polaris
Language Editor (WebAdmin), the following language strings define these messages:

String ID Default Message
PA_TEXT_PATREC_ Your account will be charged
RENEWITEMS_CHARGE | $%3.2f to renew these items.
PA_TEXT_PATREC_ Your account will be charged
RENEWITEM_CHARGE $%3.2f to renew this item.
PA_TEXT_PATREC_ Overdue and renewal charges will
RENEWITEM_ apply. Your account will be charged
OVDANDCHARGES $%3.2f.

PA_TEXT_PATREC_ Please wait while we process your
RENEW_WAIT renewals.
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See also: Set up charges for checkout and renewal

Set up charges for checkout and renewal

To set up charges for checkout and renewal:

1.

a.

Enable the fee description in Polaris Administration:
Open the Fee Descriptions policy table for the organization that is setting up
check-out or renewal charge policies.

Set the fee description Item charge for check-out/renewal to Yes. This setting dis-
plays the fee description on views and dialog boxes that list charges on the patron
account. The charge transactions are logged with the Fee Description code -11.
They are included in all Polaris toolbar reports of charge transactions and are avail-
able for reporting in Polaris SimplyReports.

Select File > Save.
For more information about working with this table, see Defining Fee
Descriptions.

Double-click the Patron Services parameter Check-out: Charge options to enable
the charge and specify the appropriate material types, charge amounts, and patron
codes.

The parameter is available at the system, library, and branch levels. To see the
patron services parameters list, click the appropriate level- System, Library,
Branch.

The Check Out: Charge options dialog box opens.
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Retrieved from: Comrmunity Library (br)

Enable
Material types and associated charges Patran codes to be charged

Material Type Charge ™ CPH Outreach
Art €0.00 CPH Resident

Audiobook £1.00 CPH Retired
Book $1.00 CPH 5taff { Board

(| Book and CD £0.00 Delinguent Borrower
[] children's Video £0.00 ILL Agency

[ ] eBook €0.00 Juvenile

[] Equipment £0.00 Juvenile with Restrictions
[ Kellie R-Rated Reslia &0.00 e

[ ] kelie Rental Manuscript £0,00 Mew Borrower
[ kellie Rental Score €0.00 ¥ Outreach v

Select Al £0.00 Apply IUnselect Al Select Al Unselect Al

() Check-outonly () Check-out and Renewal (®) Renewal only Prompt in Staff Client

Cancel Help

. Select Enable.
. Select a material type to which a check-out charge should be applied.
. Specify the amount to be charged for the selected material type and click Apply.

You can also click several material types or Select All, specify a single amount,
and click Apply.

Note:

It is possible to select a material type and leave the amount at $0.00, or to
set an amount for a selected material type and then uncheck that material
type. In either case, no charge will be applied.
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6. Select the patron codes that should be charged the specified check-out charges.
You can also click Select All.

7. Select one option for applying charges:

» Check-out only - Apply the charge only at check-out

» Check-out and Renewal - Apply the charge at check-out and again if the item is
renewed

* Renewal only - Apply the charge only when the item is renewed

8. If you want a message to appear when a staff member attempts to check out or
renew a chargeable item to a patron, select Prompt in Staff Client. For this option,
the system uses the setting of the transacting workstation’s log-on branch.

9. Click OK.

Related Information

» Polaris ExpressCheck transactions - Your charge policies also apply to checkout
and renewal from Polaris ExpressCheck. You can choose to allow the transactions
and have the patron’s account charged appropriately when the transactions occur,
or stop the transactions and display a message. The option is available in the
SelfCheck unit parameter Polaris ExpressCheck: Blocking conditions (Iltem Blocks
tabbed page). For more information, see the Polaris ExpressCheck Administration
Guide.

» SIP Self-Check transactions - Your charge policies also apply to checkout and
renewal from SIP self-check units. You can choose to allow checkout and have the
patron’s account charged appropriately when the transactions occur, allow
renewal and have the patron’s account charged, automatically charge when the
patron chooses to renew all items out, or stop the transactions and display a mes-
sage. For more information, see Setting Up SIP Self-Check Circulation.
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Managing Collection Agency Services

Your library may contract with a collection agency to encourage patrons to pay their
fines or return borrowed items. Delinquent accounts are reported to the collection
agency automatically, and the patron records automatically updated, according to
settings you make in Polaris Administration.

Note:

Innovative Interfaces charges a modest annual site license fee to use the
collection agency interface in Polaris. Contact your Site Manager at
Innovative Interfaces for additional information.

If your library uses a second collection agency to collect from patron accounts that were
not settled with the first agency, see the Patron Service PDF Guide, Profiles Reference,
Second Level Collection Agency Management.

See also:

e Using a Collection Agency

e Collection Processing Reports

Using a Collection Agency

Note:
For information about the setup in Polaris Administration, search Polaris
help for "Set up collection agency processing."

Collection agencies differ in notification practices and in how repayment is obtained.
Some collection agencies, such as Unique Management Services (UMS), manage all
collection communications with patrons who have delinquent accounts, but the patrons
make all payments directly to the library. For other collection agencies, the library may
send a fine notice warning the patron that the account will be turned over to collection.
Once the account is turned over, patrons may make payments to the collection agency
as well as to the library. Your library’s contract with the collection agency determines the
cost to the library for collection agency services. To recoup some of these costs, you
can set a collection fee on delinquent patron accounts.

Regardless of communication and payment methods, collection agency services rely on
the automatic reporting capabilities of Polaris. Polaris automatically transmits a
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Submission Report of delinquent patron information and an Update Report of patron
account activity to the collection agency, via e-mail, FTP, or both. You can have Polaris
send copies of the reports to a library staff member for verification and backup. In
addition, a Synchronization Report lists all currently reported patrons with their
balances. You can run this report manually, any time.

A patron’s account is considered delinquent and is included on the Submission Report
when all the following conditions exist:

» The patron owes an amount of money over a library-defined limit.

» The money has been owed longer than a library-specified period of time.

» The specific patron has not been excluded from collection reporting (the Exclude
from collection agency checkbox is not selected on the Patron Registration work-
form - General view).

» The patron code in the patron record has not been excluded from collection report-
ing.
The total amount reported may include charges of all types, replacement costs,

processing fees, and collection fees. Or, you can opt to report patron accounts based
only on lost item charges (see Reporting for Lost ltem Charges Only).

Accrued overdue fines that have not yet been charged are not included in the calculation
for reporting to a collection agency. See Calculating and Blocking for Estimated Accrued
Fines.

The following events occur during collection agency processing:

» After collection agency functions are started, the system identifies delinquent pat-
rons. The Submission Report is produced during overnight batch processing and is
sent to the collection agency by e-mail or FTP. The report includes all patron
accounts that match the criteria you set in Polaris Administration. See Collection
Processing Reports.

« A system-generated collection block and collection fee (if specified) is auto-
matically added to the patron record. Only staff members with the system-level Cir-
culation permission Override collection agency block: Allow can override the
block.

» The collection agency encourages the patron to settle with the library, or collects
money directly from patrons and transmits it to the library.

» The patron pays all participating libraries all the money that is owed, including
fines and collection fees incurred after being reported to the collection agency.
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When the patron no longer owes money to the reporting libraries, the patron’s
account is out of collection. (The patron may still owe money to non-participating
libraries.) The block is automatically removed from the patron’s account, and the
patron’s account is considered to be out of collection.

Note:

If the patron’s account is not paid down to $0.00 at all the participating
organizations, the patron’s account is still in collection. If the patron’s
account is paid down to $0.00 after submission to collection, but the
patron incurs a new fine before the Update Report is generated, the
patron’s account is still in collection.

» The Update Report is generated during overnight batch processing, and is sent to
the collection agency by e-mail or FTP. The report includes all patrons who have
been identified for collection and have had any activity (payment, wai